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1 What’s New in This Release
What’s New in Pricing Administration Guide, Version 7.8, Rev. B
Table 2 lists the changes described in this version of the documentation to support version 7.8, Rev 
A of the software. 

Table 1. New Product Features in Pricing Administration Guide, Version 7.8, Rev. B

Topic Description

“Order of Conditions and Processing 
Speed” on page 104

Corrected information about improving processing speed. 

Table 2. New Product Features in Pricing Administration Guide, Version 7.8, Rev. A

Topic Description

“Activating Workflows for Product 
Promotion” on page 84

Added this topic.

Creating Trade Promotions and 
Deals

Deleted this topic.

“Viewing the Reference Price” on 
page 133

Added this topic.

“Exposing the Starting Price At in 
the Product Catalog” on page 134

Added this topic.

“Basic Pricing Procedure Workflow” 
on page 156

Added this topic.

“Dynamic Pricing Procedure 
Workflow” on page 165

Changed the name of this topic from Pricing Procedure - 
Default Workflow to Dynamic Pricing Procedure Workflow to 
reflect the workflow name change and added text related to 
the name change.

“Switching from Basic to Dynamic 
Pricing Procedure” on page 169

Added this topic.

“Pricing Procedure - Aggregate 
Discounts Workflow” on page 174

Changed name of this topic from Pricing Procedure - Bundle 
Discounts Workflow to Pricing Procedure Aggregate Discounts 
Workflow to reflect the workflow name change and added text 
related to the name change.
Pricing Administration Guide Version 7.8, Rev. B 9



What’s New in This Release ■ 
 

Table 3. New Product Features in Pricing Administration Guide, Version 7.8

Topic Description

“About Setting Up Service Pricing” 
on page 23

Added this topic. 

“Giving a Product Multiple Prices 
with Different Effective Dates” on 
page 30

Added this topic.

“Enabling Price List-Specific and 
Line Item-Specific Pricing Logic” on 
page 34

Added this topic.

Chapter 7, “Creating Aggregate 
Discounts”

Added this chapter.

Chapter 8, “Creating Product 
Promotions”

Added this chapter

Chapter 9, “Creating Discount 
Matrices”

Added this chapter.

Chapter 10, “Creating Attribute 
Adjustments”

Modified this chapter to reflect new functionality for version 
7.8. Removed the sections about attribute pricing tables, 
which are no longer used in version. 7.8.

Chapter 13, “Pricing in the Run-
Time Application”

Added this chapter. 

Appendix A, “Siebel Pricer Technical 
Reference”

Added this chapter, which describes workflows and pricing 
procedures used in pricing and the business services they 
call.

Appendix B, “Siebel Pricer 
Deployment and Integration”

Revised this appendix so it covers new integration methods 
for version 7.8. 

Six chapters about pricing factors have been removed from 
the book. Pricing factors are no longer used in Siebel Pricer 
version 7.8, because you now create custom pricing rules by 
working directly with the pricing procedures that provide the 
pricing logic. 
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2 Overview of Pricing 
Administration
This chapter gives a general overview of pricing administration for Siebel applications, and it 
describes how you log on as Siebel Administrator. It also describes the processing order of price 
adjustments. 

This chapter covers the following topics: 

■ “About Pricing Administration” on page 11

■ “Activating Pricing Workflows” on page 12

■ “Siebel Pricer Version 7.8 and Earlier Versions” on page 12

■ “About the Processing Order of Price Adjustments” on page 13

■ “Clearing Pricing Data from the Cache” on page 14

■ “Which Type of Promotion Pricing to Use” on page 14

About Pricing Administration
Siebel Pricer allows you to work with the following: 

■ Price lists, rate lists, and cost lists. Create price lists, rate lists, and cost lists. For more 
information, see the following chapters:

■ Chapter 3, “Creating and Assigning Price Lists”

■ Chapter 4, “Creating and Assigning Rate Lists”

■ Chapter 5, “Creating and Using Cost Lists”

■ Volume discounts. Give customers a discount if they buy in volume. For example, if a customer 
buys more than one hundred units, the customer can get a 10 percent discount. For more 
information, see Chapter 6, “Creating Volume Discounts.” 

■ Three types of promotion pricing: 

■ Aggregate discounts. Give customers a discount if they buy a group of products. For more 
information, see Chapter 7, “Creating Aggregate Discounts.”

■ Product promotions. Create promotions that can be selected in quotes, orders, and 
catalogs, can be tracked as assets, can have commitments tied to them, and can have rules 
and penalties defined for future changes. For more information, see Chapter 8, “Creating 
Product Promotions.”

■ Discount matrices. Create a matrix of rules to define price adjustments. For more information, 
see Chapter 9, “Creating Discount Matrices.”
Pricing Administration Guide Version 7.8, Rev. B 11



Overview of Pricing Administration ■ Activating Pricing Workflows
■ Attribute adjustments. Create a matrix of rules to define attribute-based pricing. Attribute 
adjustment provides flexibility to map rules to attributes or fields in any business component. 
For more information, see Chapter 10, “Creating Attribute Adjustments.”

■ Products with components. Define pricing for products whose components customers can 
choose. For example, when a customer buys a computer, the customer can choose to add 
peripherals such as a CD-ROM drive. For more information, see Chapter 11, “Setting Up Pricing 
for Products with Components.”

■ Pricing reports. Create a variety of reports to track your pricing policies. For more information, 
see Chapter 12, “Creating Pricing Reports.” 

■ Customizing pricing logic. Pricing logic is based on pricing procedures, so it is fully 
configurable. For more information, see Appendix A, “Siebel Pricer Technical Reference.”

Activating Pricing Workflows
To make pricing functionality available to users, you must activate the pricing workflows. For a 
complete list of these workflows, see Appendix A, “Siebel Pricer Technical Reference.” 

For information about how to activate workflows, see Siebel Business Process Designer 
Administration Guide. 

Siebel Pricer Version 7.8 and Earlier 
Versions
The most important enhancements in Siebel Pricer 7.8 are summarized in this section. 

Pricing Is Based on Pricing Procedures
In version 7.8, pricing logic is defined using pricing procedures. These procedures are based on the 
Product Selection and Pricing (PSP) engine. The advantage of using the PSP engine is that pricing is 
fully configurable. For more information about the PSP engine, see Siebel Order Management 
Infrastructure Guide. For information about the procedures used for pricing, see Appendix A, “Siebel 
Pricer Technical Reference.”

Because you can use pricing procedures to define pricing logic, pricing models and pricing factors 
are no longer used in Siebel Pricer version 7.8. 

Effective Dates for Line Items
You can set the effective dates for the line items of price lists, cost lists, discount matrices, 
component product price adjustments, or service prices. For more information, see “Giving a Product 
Multiple Prices with Different Effective Dates” on page 30. 
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Overview of Pricing Administration ■ About the Processing Order of Price Adjustments
Discount Matrices
Version 7.8 allows matrix-based administration of price adjustments using discount matrices. For 
more information, see Chapter 9, “Creating Discount Matrices.”

Attribute Adjustments
In version 7.8, you use attribute adjustments view to specify pricing for products with attributes. For 
more information, see Chapter 10, “Creating Attribute Adjustments.”

Price Waterfalls
In version 7.8, call center agents and sales representatives can view a price waterfall that shows the 
calculations that were used to arrive at the net price that is displayed in a quote, order, or agreement. 
For more information, see “Pricing Waterfalls” on page 143.

Enhancements in Pricing for Component Products
Version 7.8 has the following pricing enhancements for component products: 

■ Product versioning allows you to create multiple future release versions for products.

■ Line item effective dates in a price list allow you to create multiple line items in a price list for a 
product, with different effective dates and different prices. 

■ Every component adjustment can have an effective start and end date.

For more information, see Chapter 11, “Setting Up Pricing for Products with Components.”

Volume Discount Enhancements
In version 7.8, volume discounts provide multiple types of price adjustments, such as percentage 
markup and markup amount. For more information, see Chapter 6, “Creating Volume Discounts.”

Enhancements Across the Application
In version 7.8, in addition to the features used to set up pricing, there are also many enhancements 
to pricing behavior in quotes and orders. For example, there is support for multiple price types and 
multiple currencies. For more information, see Chapter 13, “Pricing in the Run-Time Application.”

About the Processing Order of Price 
Adjustments 
The order in which price adjustments are processed can affect the final price. 

For example, a product costs $100 and you give a $10 promotional discount plus a 10 percent volume 
discount if the customer buys more than ten. If the customer qualifies for both discounts, you can 
calculate the final price in two ways:
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Overview of Pricing Administration ■ Clearing Pricing Data from the Cache
■ The unit cost would be $81 if the promotional discount is applied first ($100 - $10 = $90, and 
10 percent off $90 is $81).

■ The unit cost would be $80 if the volume discount is applied first (10 percent off $100 is $90, 
and $90 - $10 = $80).

The pricing procedure determines the processing order of discounts, but you can customize it. For 
information about the default processing order, see “Pricing Procedures and Workflow References” on 
page 155. 

Clearing Pricing Data from the Cache
After price list data is read from the database, it is cached in memory to improve performance. If a 
price list is modified, the cached pricing data may no longer be valid. 

When modified or newly developed pricing data is added to the database, the user clicks the Clear 
Cache button to remove cached data that may be obsolete. 

The Clear Cache button is available in the Price Lists view, Volume Discount view, and many other 
views. In any view, it clears only the selected price list, volume discount, or other pricing data from 
the cache. Other pricing data remains in the cache to improve performance. 

For information about setting up caching, see Siebel Order Management Infrastructure Guide. 

To clear pricing data from the cache

1 Navigate to the Administration - Pricing screen > Price Lists view, Volume Discount view, or other 
appropriate view.

2 Select one or more Price List records, Volume Discount records, or other pricing records whose 
cached data may be obsolete.

3 Click Clear Cache. 

Which Type of Promotion Pricing to Use 
Siebel Pricer version 7.8 provides three types of promotions: 

■ Aggregate discount promotions. These promotions allow you to give discounts to customers 
who buy a combination of products, as described in Chapter 7, “Creating Aggregate Discounts.” 
You use this type of promotion to maintain promotions that were defined using bundle pricing 
factors in earlier versions of Siebel Pricer. 

■ Product promotions. These promotions allow you to create many types of promotions, 
including bundle promotions, as described in Chapter 8, “Creating Product Promotions.” This type 
of promotion is new in version 7.8, and it has features such as the ability to display promotions 
in product catalogs and quote line items. It is recommended that you use product promotions for 
most new promotions.
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3 Creating and Assigning Price 
Lists
This chapter begins with an overview of price lists, and then describes the most common way of 
creating a new price list. It also instructs you on assigning price lists to users. 

This chapter covers the following topics: 

■ “About Price Lists” 

■ “Price List Prerequisites” on page 16

■ “Process of Creating a Price List” on page 17

■ “About Setting Up Service Pricing” on page 23

■ “About Effective Dates for Pricing Line Items” on page 27

■ “Giving a Product Multiple Prices with Different Effective Dates” on page 30

■ “Copying and Modifying a Price List” on page 32

■ “Copying and Transforming a Price List” on page 32

■ “Importing Price Lists Using Siebel EIM” on page 33

■ “Assigning Price Lists to Users” on page 33

■ “Enabling Price List-Specific and Line Item-Specific Pricing Logic” on page 34

About Price Lists
A price list is a set of standard prices for products or services. 

A product must exist in a price list so that it appears in a catalog. So, the price list is one of the 
requirements for a product’s visibility. 

A product price defined in a price list is commonly used as the starting price for other prices 
generated by Siebel Pricer. You should test the price list thoroughly before applying more advanced 
price adjustments. 

This chapter describes the four common ways of creating a price list:

■ Create a new price list

■ Copy and modify an existing price list

■ Copy and transform an existing price list

■ Import price lists from other applications using Siebel Enterprise Integration Manager (EIM)

After you create a price list, you must assign it to customers so that it controls the prices available 
to customers.

A product can appear in many different price lists. For example, you can create:
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Creating and Assigning Price Lists ■ About Sales Products and Service Products
■ One price list with the wholesale prices for all of your products.

■ One price list with the retail prices for all of your products.

The line item records of these two price lists will have different prices for the same products. You 
assign these price lists to the appropriate customers.

About Sales Products and Service 
Products
Price lists can include prices for two different types of products: 

■ Sales products. This is any product that is sold to a customer. 

■ Service products. This is a specialized type of sales product consisting of a service that covers 
another sales product—for example a warranty service. 

Price List Prerequisites 
Before you create any price list, you must create the products to which the prices will apply. You must 
define products.

For more information, see Product Administration Guide.

Optional Prerequisites 
The price list includes optional fields that let you associate it with other data in the Siebel application. 
You must define the other data before you can use these optional fields. 

For example, if you want a price list to use volume discounts, you must define volume discount 
information before you can associate it with line items in a price list.

You do not have to define this data before creating the price list. You can skip these optional fields 
when you create the price list, and go back to the price list to fill them in later, after defining the 
data that is needed. 

The types of data that can optionally be associated with price lists include:

■ Pricing procedure. You can create a custom pricing procedure with pricing logic specific to a 
price list or to line items. For more information, see “Enabling Price List-Specific and Line Item-
Specific Pricing Logic” on page 34. 

■ Rate lists. For more information, see Chapter 4, “Creating and Assigning Rate Lists.”

■ Cost lists. For more information, see Chapter 5, “Creating and Using Cost Lists.”

■ Volume discounts. For more information, see Chapter 6, “Creating Volume Discounts.” 

■ Aggregate discount sequences. For more information, see Chapter 7, “Creating Aggregate 
Discounts.”

■ Attribute adjustments. For more information, see Chapter 10, “Creating Attribute Adjustments.”
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Creating and Assigning Price Lists ■ Process of Creating a Price List
■ Component-based pricing adjustments. For more information, see Chapter 11, “Setting Up 
Pricing for Products with Components.” 

Process of Creating a Price List
A price list consists of one price list header record that is associated with multiple line item records. 
The header record contains general information about the price list as a whole. The line item records 
contain prices for specific products. 

There are two types of line items: 

■ Sales products. Enter line items for sales products in the Price List Line Items view. 

■ Service products. Enter line items for service products in the Service Pricing view. 

A single price list can contain one or both of these types of line items. For more information about 
sales and service products, see “About Sales Products and Service Products” on page 16. 

To create a new price list, perform the following tasks: 

1 “Creating a Price List Header” on page 17

2 “Creating Price List Line Items for Products” on page 19

3 “Creating Price List Line Items for Service Products” on page 22 

NOTE: Creating a price list line item for a product with components is more complex than creating 
a line item for a simple product. Consult with a Siebel Administrator before creating price lists for 
products with components. For more information about products with components, see Chapter 11, 
“Setting Up Pricing for Products with Components.” 

Creating a Price List Header
Each price list is defined by the data in its header, which includes its name, describes its purpose, 
and specifies the time period when it will be effective. 

The price list header does not hold the actual prices for products. Prices are in the associated price 
list line items. This task is a step in “Process of Creating a Price List” on page 17.

To define a price list

1 Navigate to the Administration - Pricing screen > Price Lists view.
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Creating and Assigning Price Lists ■ Process of Creating a Price List
2 In the Price Lists list, add a new record and complete the necessary fields. 

Some fields are described in the following table. 

Field Comments

Name Enter a meaningful name for this price list. Overwrite any system-
generated name. 

If many price lists appear in your system, use a consistent 
naming convention to name all your price lists.

Cost List Select the cost list you want to associate with this price list. 

Currency Enter the default currency for this price list.

Shipping Method Select one default shipping method you want to associate with 
this price list. This appears as the default Shipping Method when 
a run-time user creates a quote or order that specifies this price 
list. 

Payment Terms Select one default set of payment terms to be associated with this 
price list. This selection appears as the default data for Payment 
Terms when a run-time user creates a Quote or Order that 
specifies this price list. 

Organization Select all the organizations that may have prices controlled by 
this price list. For more information see, “Assigning Price Lists to 
Users” on page 33. 

Ship Method Enter the mode used for shipping. 

Shipping Terms Select one default shipping charge protocol that you want to 
associate with this price list. This appears as the default Shipping 
Terms data when a run-time user creates a quote or order that 
specifies this price list.

Effective From Enter the date and time when this price list will become effective. 
By default, Siebel Pricer assigns the current system date and time 
when you first create the Price List record.

Effective To Enter the date and time when this price list will become 
ineffective. After this time, Siebel applications will not be able to 
use this price list.

Updated By By default, Siebel Pricer assigns the user name used to log in to 
the current session in which this Price List record is created.

Last Updated By default, Siebel Pricer assigns the current system date and time 
when you most recently saved this Price List record.

Integration ID If this system-generated ID appears, you can use it as a unique 
identifier for this price list to assist with system integration tasks. 
The Integration ID field is used for system integration with 
external systems. This field is populated by Siebel EAI 
connectors.
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Creating and Assigning Price Lists ■ Process of Creating a Price List
Creating Price List Line Items for Products
A price list line item for a product includes the product name, the product price, and related 
information. Adding a line item is equivalent to adding a product to the price list. 

A line item for a product can appear in multiple price lists. For example, your United States price list 
might have a line item for the product’s retail price in the United States, your Canadian price list may 
have the product’s retail price in Canada, and so on. 

NOTE: Creating a price list line item for a product with components is more complex than creating 
a line item for a simple product, and it requires additional steps that are not included in this 
procedure. For more information about products with components, see Chapter 11, “Setting Up 
Pricing for Products with Components.” 

This task is a step in “Process of Creating a Price List” on page 17.

To add a new price list line item for a product

1 Navigate to the Administration - Pricing screen > Price Lists view.

2 In the Price List form, select the price list to which you want to add a line item. 

3 Click the Price List Line Items view tab. 

4 In the Price List Line Items list, click New.

The Add Products dialog box appears.

5 Use the Add Products dialog box to add the product to the price list. 

6 If the product is a product with components, see the instructions in Chapter 11, “Setting Up 
Pricing for Products with Components.” 

Pricing Procedure Select a custom pricing procedure. The pricing logic in this 
procedure will be applied to all the line items in the price list. 
Before this field is available, you must do the setup work 
described in “Enabling Price List-Specific and Line Item-Specific 
Pricing Logic” on page 34.

Aggregate Discount 
Sequence

Select an aggregate discount sequence in order to apply 
aggregate discounts to the price list. For more information, see 
Chapter 7, “Creating Aggregate Discounts.”

Field Comments
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7 Complete the fields in the Price List Item record, and the Price List Line Item Detail form, as 
described in the following table. 

Field Comments

Product Select a product name using the Add Products dialog box. 

Price Type This field displays the price type for this product. Options are 
One-Time, Recurring, and Usage. The value is based on the 
product definition. For more information about multiple price 
types, see “Multiple Price Types and Totals” on page 148. 

Customizable When this check box is selected, it means that the product has 
components. This value is based on the product definition and is 
read-only. 

List Price Enter a list price, the standard price used for most transactions 
and the most commonly used target price for price adjustments. 

If you enter a promotional price, it is used instead of this list 
price. 

The list price is not checked against the Minimum Price and 
Maximum Price fields when it is first entered, because these fields 
are usually entered after the list price. When the minimum and 
maximum prices are entered, the list price is validated against 
them. 

CAUTION: If the list price, promotional price, and price override 
are all omitted, the product may be offered with no price—the 
equivalent of a zero price.

Promotional Price If you enter a promotional price, it will be used instead of the list 
price in all functions that do not explicitly identify the list price as 
the target price. 

Volume Discount Select the volume discount that applies to this line item, if any. 
More than one volume discount may be available for a given 
product, and all the volume discounts that can apply to this 
product are displayed in the drop-down list. For more 
information, see Chapter 6, “Creating Volume Discounts.”

Attribute Adjustments This field specifies the attribute adjustments record that provides 
attribute-based pricing adjustments for this line item, if any.

For more information, see Chapter 10, “Creating Attribute 
Adjustments.”

Start Date and End Date If this line item has different effective dates from the price list, 
enter the start date when the pricing becomes effective and the 
end date when it is no longer effective. To enter values in these 
fields, use the method described in “Giving a Product Multiple 
Prices with Different Effective Dates” on page 30. 
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CAUTION: If you do not specify a price for a product in its price list line item, that product may 
appear in a quote or order without a price, effectively making it free to a run-time user who is buying 
it. If you depend on other pricing mechanisms to supply a missing price, be sure to test the results 
in the run-time environment.

Product Line This field displays the product line to which this line item product 
belongs. This value is taken from the product information. 

Part Number (Part #) This field displays the part number assigned to the line item 
product. This value is derived from the product information. 

Cost Enter the cost of the line item product. You can use this as the 
target price for some price adjustment calculations. 

MSRP Enter the manufacturer’s suggested retail price (MSRP) for 
reference purposes. In some cases, you can use this as the target 
price for price adjustment calculations. 

Purchase Price Enter the purchase price of the line item product. You can use this 
as the target price for some price adjustment calculations. 

Unit of Measure This field displays the unit of measure for the product item. This 
value comes from the product definition. 

Minimum Price If a minimum price value is provided, Siebel Pricer does not offer 
a lower price for this line item, unless a run-time user (such as 
an agent) manually overrides this price.

As a default, specify a minimum price of zero to prevent amount 
discounts from resulting in negative number prices.

The minimum price does not apply to components of products 
with components.

Maximum Price If a maximum price value is provided, Siebel Pricer does not offer 
a higher price for this line item, unless a run-time user (such as 
an agent) manually overrides this price.

If a maximum price is provided for a price list line item product 
and if that product appears as a component in a product with 
components, then this maximum price will apply to that 
component product as well.

% Margin Read-only. This is a calculated field that calculates the margin 
based on the following formula:

((List or promotional price) – cost)/List*100

Pricing Procedure Select a custom pricing procedure. The pricing logic in this 
procedure will be applied to this line item. Before this field is 
available, you must do the setup work described in “Enabling Price 
List-Specific and Line Item-Specific Pricing Logic” on page 34.

Field Comments
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Creating Price List Line Items for Service Products
A price list line item for a specific service product includes the product name, the product price, and 
related information, such as the time when the service price is effective. Adding a record to the 
Service Pricing view is equivalent to adding a service product to the price list. 

As a shortcut, if you are adding the same service product with different time intervals, you can click 
the New Effective Date button to add another record for the same service product, so you have to 
enter only the new start date, end date, and price. The time interval is the period when the service 
is delivered. 

You can also base service pricing on the covered asset, as described in “About Setting Up Service 
Pricing” on page 23. 

This task is a step in “Process of Creating a Price List” on page 17.

To add a new price list line item for a service product

1 Navigate to the Administration - Pricing screen > Price Lists view.

The Price Lists view appears, displaying the currently defined price lists. 

2 In the Price List form, select the price list to which you want to add a line item. 

3 Click the Service Pricing view tab. 

4 In the Service Pricing list, click New.

The Add Products dialog box appears.

5 Use the Add Products dialog box to add the product to the price list.

6 If the product is a product with components, see the instructions in Chapter 11, “Setting Up 
Pricing for Products with Components.” 

7 Complete the fields in the Service Pricing record and the Service Pricing Details form, as 
described in the following table. 

Field Comments

Product Select a product name using the Add Products dialog box. 

Customizable When this check box is selected, it means that the product has 
components. This value is based on the product definition and is 
read-only in this screen. 

Service Product This check box is selected if this is a service product. This 
information depends on the product definition. 

List Price Enter a list price, the standard price used for most transactions 
and the most commonly used target price for price adjustments. 

CAUTION: If the list price and price override are both omitted, 
the product may be offered with no price—the equivalent of a zero 
price.
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About Setting Up Service Pricing
You can set up service pricing in two ways:

■ Price the service as a percentage of the covered product. For example, a one-year warranty can 
be priced at 10% of the price of the computer system that it covers. For information about how 
to do this, see “Setting Up Service Pricing as a Percentage of a Covered Product” on page 23. 

■ Price the service with adjustments based on a primary covered product. The price of the service 
can be equal to the list price of the service with a price adjustment based on the product that is 
covered. For information about how to do this, see “Setting Up Service Pricing with Adjustments 
Based on a Covered Product” on page 25. 

In either case, the service pricing is triggered when the end user creates a quote or order and 
associates the service to the covered product.

Setting Up Service Pricing as a Percentage of a Covered 
Product
The price of the service is equal to the list price of the service plus a percentage of the price of the 
covered product. 

This method of pricing is available without configuration. 

To set up service pricing as a percentage of a covered product, perform the following tasks: 

■ “Pricing a Service as a Percentage of a Covered Product” on page 24

■ “Associating a Service with a Covered Product” on page 24

Start Date and End Date If this line item has different effective dates from the price list, 
enter the start date when the pricing becomes effective, and the 
end date when it is no longer effective. To enter values in these 
fields, use the method described in “Giving a Product Multiple 
Prices with Different Effective Dates” on page 30. 

Service Price Method Specify the basis used for calculating the price markup of the 
service product from the covered product. The options are the list 
price and net price of the covered product. The percentage 
entered in the Service Price % field is applied to the price you 
specify in this field, and the resulting amount is added to the list 
price of the service to calculate the price.

Service Price % Enter a percentage that is used to mark up the price of the service 
product. The price for this service product is the list price of the 
service product plus this percentage of the net or list price of the 
covered product, depending on whether you selected net price or 
list price in the Service Price Method field.

Field Comments
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Pricing a Service as a Percentage of a Covered Product
A service can be priced as a percentage of the covered product. Alternatively, there can be a list price 
for the service, and a percentage of the covered product is added to this list price.

To set up service pricing as a percentage of the covered product

1 Add the service price line item, as described in “Creating Price List Line Items for Service Products” 
on page 22. 

2 Complete the fields in the Service Pricing Details form described in the following table. 

Associating a Service with a Covered Product
When the end user creates a quote or order for a service whose price is based on a product, the end 
user must associate the service with the product. 

For more information about how an end user creates a quote or order, see Siebel Order Management 
Guide. 

To associate a service with a covered product

1 Create a quote or order as described in Siebel Order Management Guide.

2 Add the covered product as a line item. 

3 From the Line Items applet menu, choose Service. 

A dialog box appears that includes only service products. 

4 Select the appropriate service product from the dialog box, and click OK. 

The service product is added as a line item to the quote or order, and it is associated with the 
covered product. This association appears in the Covered Product field of the service product line 
item. 

NOTE: As an alternative to choosing Service from the menu, you can directly populate the 
Covered Product field of the service line item to create an association between the service and 
the covered product.

Field Comments

Service Pricing Method Select Net Price of List Price to determine whether the service 
price should be a percentage of the net of list price of the covered 
product. 

Service Price % Enter the percentage of the covered product’s price that should 
be used as the service price. 

List Price Enter a list price for the service product. 
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Setting Up Service Pricing with Adjustments Based on a 
Covered Product
The price of the service equals the list price of the service plus a price adjustment that depends on 
the primary product that it covers. 

NOTE: This method of pricing requires configuration of the pricing procedure.

To set up service pricing with adjustments based on a product, perform the following tasks: 

■ “Pricing a Service with Adjustments Based On a Primary Covered Product” on page 25

■ “Associating the Service Product with Covered Products” on page 26

Pricing a Service with Adjustments Based On a Primary Covered 
Product
Pricing administrators can set up service pricing with an adjustment based on the primary product 
that is covered. For example, there can be a list price for a one-year service agreement, with a 10 
percent discount if the agreement covers computer system A and a 15 percent discount if it covers 
computer system B. 

To price a service with adjustments based on a product

1 Add the service price line item, as described in “Creating Price List Line Items for Service Products” 
on page 22. 

2 Add a record to the Service Pricing Details list for each product that the service covers and 
complete the necessary fields, as described in the following table. 

Field Comments

Product Select the product to which this discount applies. 

Adjustment Type Select the type of the adjustment that the discount will apply. 
Options are Discount Amount, % Discount, Markup Amount, % 
Markup, and Price Override. 
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Associating the Service Product with Covered Products
When the end user creates a quote or order for products that are covered by this service, the end 
user must associate the service with one or more products. The price adjustment for the service 
depends on the primary product. 

For more information about how an end user creates a quote or order, see Siebel Order Management 
Guide. 

To associate a service with covered products

1 Create a quote or order as described in Siebel Order Management Guide.

2 Add the service product as a line item of the quote or order. 

3 Click the Assets view tab. 

4 In the Assets list, add records and in the Asset # field, select the products covered by this 
service. 

5 In the Asset record of the primary product covered by this service, select the Primary check box.

The price adjustment for the service depends on the primary product. 

Target Price Select the price to which the discount applies. 

Adjustment Value The value in the Adjustment Type field determines how the 
adjustment value is applied, as follows:

■ If the Adjustment Type is Discount Amount, the amount in the 
Adjustment Value field is subtracted from the price. 

■ If the Adjustment Type is % Discount, the amount in the 
Adjustment Value field is treated as a percentage and is 
subtracted from the price. For example, if the Adjustment 
Amount is 10, then 10 percent is subtracted from the price. 

■ If the Adjustment Type is Markup Amount, the amount in the 
Adjustment Value field is added to the price. 

■ If the Adjustment Type is %  Markup, the amount in the 
Adjustment Value field is treated as a percentage and added 
to the price. 

■ If the Adjustment Type is Price Override, the amount in the 
Adjustment Amount field is used instead of the price. 

Field Comments
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About Effective Dates for Pricing Line 
Items
You can create effective dates for individual line items in a price list, cost list, discount matrix, or 
component-product price adjustment. 

The application prevents you from entering overlapping effective dates for the same line item when 
you enter effective dates using the New Effective Date button, as described in “Giving a Product 
Multiple Prices with Different Effective Dates” on page 30. 

For example, if a price list has a line item for Product X with a price that is effective from January 
2005 through June 2005, you should not enter another line item for Product X with a price that is 
effective from March, 2005 through December 2005, because the product would have two different 
prices during several months. 

This section describes several scenarios that show how the application resolves overlapping dates. 

The New Time Interval Overlaps with One Existing Time Interval
This section describes several possible scenarios where a new time interval overlaps with an existing 
time interval. 

If the effective dates in the new record overlap with the existing record’s start date, as shown in 
Figure 1, or with the existing record’s end date, as shown in Figure 2, the application displays an error 
message and does not enter the new effective dates. 

Figure 1. New Time Interval Overlaps with an Existing Start Date

Figure 2. New Time Interval Overlaps with an Existing End Date
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However, if the new time interval is entirely within an existing time interval and does not overlap 
with the start or end date, as shown in Figure 3, then the application creates three time intervals, as 
shown in Figure 4. 

Likewise, if the new time interval is entirely within an existing time interval but its end date is the 
same as the end date of the existing interval, as shown in Figure 5, then the application creates two 
time intervals, as shown in Figure 6. 

Figure 3. New Time Interval Is Within an Existing Time Interval

Figure 4. The Application Creates Three Time Intervals

Figure 5. New Time Interval Is Within an Existing Time Interval and Has the Same End Date

Figure 6. The Application Creates Two Time Intervals

p

p

p

p
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However, if the new time interval is entirely within an existing time interval but its start date is the 
same as the start date of the existing interval, as shown in Figure 7, then the application displays an 
error message and does not create the new time interval. 

However, if the new time interval extends beyond the existing time interval, as shown in Figure 8, 
then the application displays an error message and does not create the new time interval. 

Figure 7. New Time Interval Is Within an Existing Time Interval and Has the Same End Date

Figure 8. New Time Interval Extends Beyond an Existing Time Interval 

p

p
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The New Time Interval Overlaps with Two Existing Time Interval
This section describes the possible scenarios where a new time interval overlaps with two existing 
time intervals. The effective dates in the new record may overlap with the effective dates in two 
existing records, as shown in Figure 9, Figure 10, Figure 11, or Figure 12. In all of these cases, the 
application displays an error message and does not enter the new effective dates. 

Giving a Product Multiple Prices with 
Different Effective Dates 
Price lists, cost lists, discount matrices, and component-product price adjustments have effective 
dates for the list or group as a whole. You can also enter effective dates for individual line items. 

Figure 9. New Time Interval Covers One Record and Overlaps with Another’s End Date

Figure 10. New Time Interval Covers One Record and Overlaps with Another’s Start Date

Figure 11. New Time Interval Covers Two Existing Records

Figure 12. New Time Interval Overlaps with One Record’s Start Date and One’s End Date

p

p
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Bundle
Effective dates for individual line items allow you to change prices rapidly and track changes to a 
product’s prices. For example, if you have different prices for certain products during different 
seasons, you can include prices for all the seasons in one price list, so prices change automatically 
when the season changes. 

As a best practice, you should not delete line items from a price list or directly modify the value of 
prices at a line level. In order to make price changes, you should create multiple line item records 
with different effective dates, as described below.

This section describes how to create effective dates for line items in price lists. Use the same 
methods for cost lists, discount matrices, or component-product price adjustments. 

When you use the method described here to add multiple line items for the same product with 
different effective dates, the application does not create line items with overlapping effective dates. 
For information about how the application resolves this issue, see “About Effective Dates for Pricing 
Line Items” on page 27.

To create multiple prices with different effective dates 

1 Create one pricing line item for the product as described in “Creating Price List Line Items for 
Products” on page 19. 

2 Select the pricing line item for the product, and then click New Effective Date. 

A new line item is created for the same product. 

3 In the new line item, enter the Start Date and End Date for the new time interval. 

4 If necessary, repeat Step 2 and Step 3 to continue adding more line items with different effective 
dates for the product. 

Creating a Price List Line Item for a 
Simple Product Bundle
A product bundle allows you to give customers a discount if they buy a combination of products. For 
example, you can give customers a price for a dining room table and four chairs that is less than the 
price they would pay if they bought the table and chairs individually. 

You do this by creating a product of type bundle. You assign a price to the bundle product in the same 
way that you assign a price to an individual product. For information about creating simple bundle 
products, see Product Administration Guide. Before performing the following procedure, follow the 
instructions in “Creating Price List Line Items for Products” on page 19. 

To define a price list line item for a simple product bundle

1 Create a new product line item, as described in “Creating Price List Line Items for Products” on 
page 19. 

2 In the Name field, select a product bundle that has been defined in the Product Administration 
screen. 
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Copying and Modifying a Price List
After building a price list, you can copy and modify it to create a new price list for different types of 
customers or markets. For example, you might use a price list named United States Price List as the 
basis for creating new price lists for different countries, locations, organizations, currencies, 
accounts, or demographics. 

To modify the data in more elaborate ways, you use the Transform functionality, described in the 
following section, instead of modifying the data manually. 

NOTE: Do not edit the Currency field when you copy and modify a price list. To modify this field, use 
the Transform function, described in “Copying and Transforming a Price List” on page 32. 

To copy and modify a price list

1 Navigate to the Administration - Pricing screen > Price Lists view.

2 In the Price Lists list, select the price list you want to copy. 

3 In the Price Lists list, click the menu button, and then click Copy Record. 

A new Price List record appears with all of the data from the original price list, except for the 
original price list name.

4 Modify the information in the fields of the price list header and the price list line items. 

Either edit the fields directly or click the menu button, click Change Records, and then use the 
Change Records dialog box to modify the record. 

Copying and Transforming a Price List
The Transform function allows you to transform a copy of an existing price list by making sweeping 
price changes to product prices. It lets you change every list price without modifying each individual 
line item separately. Using the Transform options, you can: 

■ Change all list prices by the percentage you specify. For example, you can increase all list prices 
to 130 percent of their previous value. 

■ Convert all list prices to a different currency. You specify the currency and the conversion date, 
and the prices are converted automatically. 

■ Apply a pricing procedure to a price list, changing some or all product prices depending on the 
design of the procedure. To do this, you must create the pricing procedure before you do the 
transformation. For more information on creating pricing procedures, see Siebel Order 
Management Infrastructure Guide. 

The Transform function transforms the list price as well as the promotional price fields.

To transform a price list

1 Select the price list you want to use as a basis for the new price list.
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2 From the Price List menu, select Transform.

The Transform Price List form appears.

3 Enter information in the Transform Price List form, as described in the following table, and then 
click Transform. 

NOTE: After clicking the Transform button to change the data, be sure to validate your results.

Importing Price Lists Using Siebel EIM
It is common to use Siebel Enterprise Integration Manager (EIM) to import price lists into the Siebel 
application to handle large numbers of price lists that were created in other applications. 

Price lists are defined by organization. By default, the column ENTERPRISE_FLG of a manually 
entered price list is set to N, which enables organizational visibility of price lists and associated price 
list items. 

If you use Siebel EIM to import price lists and price list items, set ENTERPRISE_FLG to N to retain 
organizational visibility. If ENTERPRISE_FLG is set to Y, then the price lists and associated price list 
items are become visible across the enterprise, and are routed to all users regardless of organization. 
For more information about using Siebel EIM, see Siebel Enterprise Integration Manager 
Administration Guide. 

Assigning Price Lists to Users 
The price list that controls a user’s prices depends on both organization and account: 

Field Comments

Source Price List Name Enter the name of the price list to be transformed. 

Destination Price List Enter the name of the price list resulting from transforming the 
Source Price List. 

Currency Code Select the currency you want to use for prices in the transformed 
price list. The default value is the currency of the copied price list; 
if you are not changing currencies, keep the default. 

Exchange Date If you are converting currencies, enter the date for the currency 
exchange rate. The system will use the exchange rate on that day 
to convert currency. 

Markup or Discount % Enter a percentage to be applied to the list price for each product 
in the price list. For example, to increase all list prices by 30 
percent, you would enter 130. To decrease all list prices by 20 
percent, you would enter 80. The default value is 100 percent; if 
you do not want to change prices, keep this default. 

Pricing Procedure If you are using a pricing procedure to transform the prices, 
select the Workflow that calls the pricing procedure. 
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■ Organization. This option limits visibility. The user cannot see a price list unless it was assigned 
to the user’s organization in the Organization field of the price list record. One price list can be 
assigned to many organizations, and many price lists can be assigned to a single organization. 

■ Account. This option controls which price list is active for the user. The active price list is the 
price list associated with the user’s account record. 

When you associate a price list with an account, that price list is automatically defaulted in the quote 
or order when the account is entered for the quote or order, and the price list’s currency is set as the 
header-level currency for the quote or order.

NOTE: If you use Siebel Sales to sell to the public through the Web, customers may not have 
accounts. The default price list is for customers without accounts. For information about setting a 
default price list, see the section about setup tasks in Siebel eSales Administration Guide. 

To assign a price list to a user

1 Navigate to the Administration - Pricing screen > Price Lists view.

2 In the Price Lists list, select the price list you want to assign to the user. 

3 In the price list’s Organization field, click the select icon. 

The Organization’s dialog box appears. 

4 If the user’s organization is not already listed in this dialog box, click New, add it, and then click 
OK.

5 Navigate to the Accounts screen > Accounts List view.

6 In the Accounts list, click the name of the user’s account. 

7 Click the More Info view tab. 

8 In the More Info view, go to the Price List field list and select the price list for this account. 

Enabling Price List-Specific and Line 
Item-Specific Pricing Logic
You can associate a custom pricing procedure with either an entire price list or an individual line item 
in a price list. To associate a custom pricing procedure with an entire price list, select it in the Pricing 
Procedure field of the Price List record, as described in “Creating a Price List Header” on page 17. 

To associate a custom pricing procedure with a line item, select it in the Pricing Procedure field of 
the Line Item record, as described in “Creating Price List Line Items for Products” on page 19. 

Before you select the custom pricing procedure in these fields, you must create the custom pricing 
procedure and integrate it with the default pricing procedure. For more information about creating 
pricing procedures, see Siebel Order Management Infrastructure Guide. 

To create price list-specific or line item-specific pricing logic, follow this general process: 

■ Create a custom pricing subprocedure with the pricing logic that you want to add to the price list 
or line item. 
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■ Add a dynamic subprocedure step to the default pricing procedure. 

■ Modify the default pricing procedure to retrieve this subprocedure during Price List Lookup.

■ Associate the custom subprocedure with the price list or line item as follows: 

■ To associate it with the price list, select it in the Pricing Procedure field of the Price List 
record. 

■ To associate it with a line item, select it in the Pricing Procedure field of the Line Item record. 
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4 Creating and Assigning Rate 
Lists
This chapter begins with an overview of rate lists, and then describes the most common ways of 
creating a new rate list. It also instructs you on assigning rate lists to users. 

This chapter covers the following topics: 

■ “About Rate Lists” 

■ “Process of Creating Rate Lists” on page 38

■ “Copying and Modifying a Rate List” on page 40

■ “Copying and Transforming a Rate List” on page 41

■ “Assigning a Rate List to a User” on page 42

About Rate Lists
A rate list is a set of standard rates for resources that bill by the hour. For example, if you run a 
temporary employment agency, you might charge your customers different standard hourly rates for 
employees who do word processing, who do data entry, who do secretarial work, and who answer 
the phone at a call center. These hourly rates for these different types of resources would be included 
on your rate list. 

After you have set up rate lists administratively, they are used by service orders and time sheets to 
calculate the cost of resources. 

If you assign a product price in a rate list, it can appear in catalogs. Rate lists control the visibility 
of products, just as price lists do. 

This chapter covers the general process of creating rate lists. More detailed processes for using rate 
lists with specific features of Siebel applications are covered in other books. Common uses of rate 
lists include: 

■ Project Management for Professional Services. Rate lists let you manage projects that use 
professional services to determine the billing rates for professional services for that project. For 
more information, see Siebel Professional Services Automation Guide.

■ Field Service. Rate lists determine the rates that customers pay for the time of field service 
representatives. For more information, see Siebel Field Service Guide.

■ Pricing Screen. After the pricing administrator sets up rate lists using the Administration - 
Pricing screen, employees can view rate lists using the Pricing screen. 

This chapter looks at three common ways of creating a rate list:

■ Create a new rate list

■ Copy and modify an existing rate list

■ Copy and transform an existing rate list
Pricing Administration Guide Version 7.8, Rev. B 37



Creating and Assigning Rate Lists ■ Process of Creating Rate Lists
After you create a rate list, you must assign it to users to make it control the rates they pay. For 
example, if you run a temporary help agency, you may charge different rates to customers who need 
help for short-term projects and long-term projects, or you may charge different rates to larger and 
smaller customers. You would create and assign different rate lists to these customers to make their 
rates visible to them. 

Process of Creating Rate Lists
A rate list consists of one rate list record and multiple rate list line item records. The rate list record 
contains general information about the rate list as a whole. The line item records contain rates for 
specific resources. 

To create a new rate list, you go through the following process: 

1 “Creating Resources as Products” on page 38

2 “Creating a Rate List Record” on page 38

3 “Creating Rate List Line Items” on page 39 

Creating Resources as Products
Before you create any rate list, you must create the resources that the rates apply to as products in 
the Product Administration screen. For example, if you run a temporary help agency, you might 
create products named word processing operator, data entry clerk, secretary, and so on. 

You must:

■ Create the products.

■ Associate each product with its product lines. 

NOTE: To use these products as resources in the rate list, you must select the Project Resource check 
box when you create the product in the Product Administration screen. 

For more information about creating products, see Product Administration Guide.

This task is a step in “Process of Creating Rate Lists” on page 38. 

Creating a Rate List Record
The Rate List record includes general information about the rate list as a whole, such as its name, 
description, and effective time period. 

This task is a step in “Process of Creating Rate Lists” on page 38. 

To create a rate list record

1 Navigate to the Administration - Pricing screen > Rate Lists view.
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2 In the Rate Lists list, add a new record and complete the necessary fields, as described in the 
following table. 

Creating Rate List Line Items
A rate list line item contains rate data for a specific resource. It includes the resource name and 
information about the rates charged for that resource.

A rate list may have multiple line items for a resource, with different start and end dates. Effective 
dates for rate lists work in the same way as price lists, as described in “Giving a Product Multiple Prices 
with Different Effective Dates” on page 30. 

If you have multiple rate lists, the same resource can have a line item in each rate list. For example, 
your United States rate list might have a line item for the rate charged for a resource in the United 
States. The Canadian rate list may have the rate charged for the resource in Canada, and so on. 

This task is a step in “Process of Creating Rate Lists” on page 38. 

NOTE: Alternatively, you can add a resource to multiple rate lists using the Administration - Product 
screen > Rate List view. 

To create a rate list line item

1 Navigate to the Administration - Pricing screen > Rate Lists view.

2 In the Rate List, select the rate list for which you want to add a line item. 

Field Comments

Name Enter a unique, meaningful name for this rate list. 

Description Enter a description of the rate list for your own use. 

Cost List Select the cost list you want to associate with this rate list. 

Currency Select the currency for this rate list. 

Effective From Enter the date and time when this rate list will become effective. 
By default, the application assigns the current system date and 
time when you first create the Rate List record.

Effective To Enter the date and time when this rate list will become ineffective. 
After this time, Siebel applications will not use this rate list. If no 
value is entered here, the rate list remains in effect indefinitely. 

Updated By By default, the application assigns the user name used to log in 
to the current session in which this Rate List record is created.

Last Updated By default, the application assigns the current system date and 
time when you most recently saved this Rate List record.

Organization Select all the organization that may have rates controlled by this 
rate list. For more information see, “Assigning a Rate List to a 
User” on page 42. 
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3 Click the Rate List Line Items view tab. 

4 In the Rate List Line Items list, click New.

The Add Position Types dialog box appears.

5 Use the Add Position Types dialog box to add the type of resource to the rate list. 

6 Complete the fields of the Rate List Item record, as described in the following table. 

Copying and Modifying a Rate List
After creating a rate list, you can copy and modify it to create a new rate list for different types of 
customers or markets. For example, you might use a rate list named United States Rate List as the 
starting basis for creating new rate lists for different countries. 

First, copy the rate list. This retains the original rate list and creates a new rate list with the same 
data. Then, modify the data in the copy as necessary. 

To modify the data in more elaborate ways, use the transform feature described in the following 
section, instead of modifying the data manually. For example, you can use the transform feature to 
convert all the currencies in a rate list to a different currency. 

NOTE: Do not edit the Currency field when you copy and modify a rate list. To modify this field, use 
the Transform function described in “Copying and Transforming a Rate List” on page 41. 

To copy and modify a rate list

1 Navigate to the Administration - Pricing screen > Rate Lists view.

2 In the Rate Lists list, select the rate list you want to copy. 

Field Comments

Resource This field displays the type of resource that you selected from the 
Add Position Types dialog box. A rate list line item uses this 
product name as its unique ID.

Rate Per Hour Enter the standard hourly rate you charge for this resource. 

Overtime Rate Per Hour Enter the hourly overtime rate you charge for this resource. 

Extended Overtime Rate 
Per Hour

Enter the hourly extended overtime rate you charge for this 
employee, if applicable. 

Material Mark-Up Enter the percentage of markup charged for materials used by 
this resource. 

Expense Mark-Up Enter the percentage mark-up charged for expenses incurred by 
this resource. 

Description Enter a description of this resource for your own use. 
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3 In the Rate Lists list, click the menu button, and then click Copy Record. 

A new Rate List record appears, with all of the data from the original rate list, except for the 
original rate list name.

4 Modify the information in the fields of the rate list record and the rate list line items. 

Either edit the fields directly or click the menu button, and then click Change Records, using the 
Change Records dialog box to modify the record. 

NOTE: Do not edit the Currency field directly. To modify this field, use the Transform function, 
described in the following section. 

Copying and Transforming a Rate List
The Transform function allows you to transform a copy of an existing rate list by making sweeping 
changes to rates. It lets you change every rate without modifying each individual line item 
separately. Using the Transform options, you can: 

■ Change all list prices by the percentage you specify. For example, you can increase all list prices 
to 130 percent of their previous value. 

■ Convert all list prices to a different currency. You specify the currency and the conversion date, 
and the prices are converted automatically. 

■ Apply a pricing procedure to a rate list, changing some or all rates depending on the design of 
the procedure. To do this, you must create the pricing procedure and the workflow that calls it 
before you do the following procedure. For more information, see Siebel Order Management 
Infrastructure Guide.

To transform a rate list

1 Select the rate list you want to transform.

2 From the Rate Lists list menu, select Transform. 

The Transform Rate List form appears.

3 Enter information in the Transform Rate List form, as described in the following table, and then 
click Transform. 

Field Comments

Transformed Rate List 
Name

Enter the name of the rate list to be transformed. 

Destination Rate List Enter the name of the rate list resulting from the transformation. 

Currency Code Select the currency you want to use for prices in the transformed 
rate list. The default value is the currency of the copied rate list; 
if you are not changing currencies, keep the default. 
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Assigning a Rate List to a User
The rate list that an employee sees depends on that employee’s organization. The employee cannot 
see a rate list unless it was assigned to the user’s organization in the Organization field of the rate 
list record. 

One rate list can be assigned to many organizations. Each organization can have multiple rate lists. 

You can configure your application using Siebel Tools to make multiple rate lists available to one 
organization. For more information about Siebel Tools, see Using Siebel Tools. 

To assign a rate list to a user

1 Navigate to the Administration - Pricing screen > Rate Lists view.

2 In the Rate Lists list, select the rate list you want to assign to the user. 

3 In the rate list’s Organization field, click the select icon. 

The Organizations dialog box appears. 

4 If the user’s organization is not already listed in this dialog box, click New, add it, and then click 
OK.

Exchange Date Enter the date for the currency exchange rate. The system will 
use the exchange rate on that day to convert currency. You must 
enter the date if you are converting currencies. 

Markup or Discount % Enter a percentage to be applied to the list price for each product 
in the rate list. For example, to increase all list prices by 30 
percent, you would enter 130. To decrease all list prices by 20 
percent, you would enter 80. The default value is 100 percent; if 
you do not want to change prices, keep this default. 

Pricing Procedure If you are using a pricing procedure to transform the prices, 
select the workflow that calls the pricing procedure. 

Field Comments
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This chapter describes how to create and use cost lists, and covers the following topics: 

■ “About Cost Lists” on page 43

■ “Process of Creating Cost Lists” on page 44

■ “Creating the Price List or Rate List the Cost List Will Reference” on page 44

■ “Creating the Cost List Record” on page 44

■ “Creating the Cost List Line Item Records” on page 45

■ “Entering the Indirect Costs” on page 46

■ “Associating the Cost List with a Price List or Rate List” on page 47

■ “Updating a Price List’s Costs” on page 47

■ “Viewing the Product Cost and Margin” on page 48

■ “Using Asset Mapping to Value Assets” on page 48

About Cost Lists
A cost list is a set of costs for products or services. You can attach a cost list to either a rate list or 
a price list to determine the profit margin. 

There are four cost methods that you can use to determine the cost of a product or service: 

■ Standard Cost. This is a predetermined operating cost that is compared with the actual cost to 
measure the performance of a given department or operation. 

■ Last Cost. This is a cost metric used in the LIFO (Last-In, First Out) costing method. LIFO 
calculates cost by assuming the last goods purchased are the first goods sold, so the ending 
inventory consists of the earliest goods purchased.

■ Next Cost. This is a costing method that allows the user to maintain the cost manually.

■ Average Cost. This is a costing method that calculates product cost as the average (arithmetic 
mean) of all the purchase costs of an inventoried product.

You can enter all four of these costs for each product or service that is a line item in the cost list. 
You use the Cost List record to choose which of these cost methods is used for all the line items in 
the list. 

You can attach the same cost list to multiple price lists. For example, you may have two price lists 
with different prices for the same products—one with the prices for customers and the other with the 
prices for resellers. Although the products may have the same cost, regardless of the price you 
charge for them, you can attach the same cost list to both of these price lists. 
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Process of Creating Cost Lists
To create costs lists, perform the following steps: 

1 “Creating the Price List or Rate List the Cost List Will Reference” on page 44

2 “Creating the Cost List Record” on page 44

3 “Creating the Cost List Line Item Records” on page 45

4 “Entering the Indirect Costs” on page 46

5 “Associating the Cost List with a Price List or Rate List” on page 47

6 “Updating a Price List’s Costs” on page 47 

7 “Viewing the Product Cost and Margin” on page 48

Creating the Price List or Rate List the Cost List Will 
Reference
As a prerequisite for creating a cost list, you should create the price list or the rate list with which 
the cost list will be associated. The cost list will include the cost of products included in the price list 
or the hourly cost of the services included in the rate list. For more information about creating price 
lists, see Chapter 3, “Creating and Assigning Price Lists.” For more information about creating rate 
lists, see Chapter 4, “Creating and Assigning Rate Lists.”

Creating the Cost List Record 
The cost list record includes general information about the cost list as a whole, such as its name, the 
organizations that can use it, and its cost method. 

To create the Cost List record

1 Navigate to the Administration - Pricing screen > Cost Lists view.

2 In the Cost Lists list, add a new record and complete the necessary fields, as described in the 
following table. 

Field Comments

Cost List Enter a unique name for this cost list. If you have many cost lists, 
it is important to use meaningful names and a consistent naming 
convention for them all.

Description Enter a description of this cost list for your own use. 

Effective From Enter the date and time when this cost list will become effective. 
By default, the application assigns the current system date and 
time when you first create the Cost List record.
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Creating the Cost List Line Item Records 
You must add a line item to the cost list for each product or service in the cost list. The cost list line 
item has specific information about the cost of that product or service. 

You can enter four costs for each product, using the four cost methods described in “About Cost Lists” 
on page 43. The cost method used depends on the cost method you choose in the Cost List record. 

This record is used only for the direct cost you pay for the product. Indirect costs associated with 
the product are entered later. 

NOTE: Alternatively, you can add a product to multiple cost lists using the Administration - Product 
screen > Cost List view.

To create a cost list line item 

1 Navigate to the Administration - Pricing screen > Cost Lists view.

2 In the Cost Lists list, select the cost list to which you want to add a line item. 

3 Click the Cost List Line Items view tab. 

4 In the Cost List Line Items list, click New.

The Add Internal Products dialog box appears.

5 In the Add Internal Products dialog box, select the product you want to add to the price list, and 
click Add.

Effective To Enter the date and time when this cost list will become 
ineffective. After this time, Siebel applications will not use this 
cost list.

Cost Method Select one of the four cost methods: Standard, Average, Next, or 
Last. These cost methods are described in “About Cost Lists” on 
page 43. 

Created By This field displays the user name of the person creating this 
record. 

Created This field displays the date and time when the record was created. 

Organization Select the organizations that will use this cost list. 

Updated By This field displays the user name of the last person who updated 
this record. 

Updated This field displays the date and time when the record was last 
updated. 

Field Comments
Pricing Administration Guide Version 7.8, Rev. B 45



Creating and Using Cost Lists ■ Process of Creating Cost Lists
6 Complete the fields in the Cost List Line Item record, as described in the following table. 

Entering the Indirect Costs
After entering the direct cost of the product, you can also enter indirect costs associated with the 
product, such as your cost of ordering products, receiving products, and shipping products to 
customers. These indirect costs apply to all the products in the cost list. Enter an average cost per 
unit for all your products. 

To enter indirect costs

1 Navigate to the Administration - Pricing screen > Cost Lists view.

2 In the Cost Lists list, select the cost list to which you want to add indirect costs. 

3 Click the Cost List Indirect Costs view tab. 

4 In the Cost List Indirect Costs Items list, click New.

Field Comments

Product The name of the product or service that you selected from the 
Add Products dialog box is entered here. 

Part # The part number of the product or service that you selected from 
the Add Products dialog box is entered here. This number 
uniquely identifies the product or service. 

Standard Cost Enter the standard cost, as described in “About Cost Lists” on 
page 43. 

Last Cost Enter the last cost, as described in “About Cost Lists” on page 43. 

Next Cost Enter the next cost, as described in “About Cost Lists” on page 43. 

Average Cost Enter the average cost, as described in “About Cost Lists” on 
page 43. 

Start Date and End Date If the line item has different effective dates from the cost list, 
enter the start date when the costing becomes effective and the 
end date when it is no longer effective. These fields work in the 
same way as the start and end date fields of price list line items, 
as described in “Giving a Product Multiple Prices with Different 
Effective Dates” on page 30. 
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5 Complete the fields in the Cost List Indirect Costs record, as described in the following table, and 
continue to add these records until you have entered all indirect costs. 

Associating the Cost List with a Price List or Rate List
After creating the cost list, you can associate it with either a price list or a rate list. You can associate 
the same cost list with more than one price list or rate list. 

To associate a cost list with a price list

1 Navigate to the Administration - Pricing screen > Price Lists view.

2 In the Price Lists list, select the price list with which you want to associate the cost list. 

3 In the More Info form, go to the Cost List field and select the cost list. 

To associate a cost list with a rate list

1 Navigate to the Administration - Pricing screen > Rate Lists view.

2 In the Rate Lists list, select the rate list with which you want to associate the cost list. 

3 In the More Info form, go to the Cost List field and select the cost list. 

Updating a Price List’s Costs
If the cost list is associated with a price list, you must update the cost for that price list to make the 
new cost list take effect. 

This is not necessary if the cost list is associated with a rate list. 

To update a price list’s costs

1 Navigate to Administration - Pricing screen > Price Lists view.

2 In the Price Lists list, select the price list whose cost you want to update. 

3 In the Price Lists list, from the applet level menu, select Update Cost from the menu. 

Field Comments

Expense Object Select the type of indirect cost, such as shipment, receipt, or 
demonstration. 

Cost Per Unit Enter the cost per unit of this indirect cost, spreading the total 
indirect cost across all the products or services in the cost list. 

Comments Enter a comment for your own use. 
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Viewing the Product Cost and Margin
Now that cost lists have been set up and associated with a price list or rate list, any user can view 
the cost and the profit margin of products on that price list. The margin is displayed as a percentage.

NOTE: Before viewing the cost and margin for a rate list, you must configure the product using 
Siebel Tools to expose those fields. For more information about using Siebel Tools, see Using Siebel 
Tools. 

To view a product cost and margin in a price list

1 Navigate to the Administration - Pricing screen > Price Lists view.

2 In the Price Lists list, select the price list for the product whose cost you want to view. 

3 Click the Price List Line Items view tab. 

4 In the Price List Line Items list, select the product whose cost you want to view. 

5 Scroll down to view the Price List Line Item Detail form. 

6 If necessary, click the Show More button in the Price List Line Item Detail form. 

The product cost is in the Cost field and the profit margin is in the % Margin field of the Price 
List Line Item Detail form. 

To view a product cost and margin in a rate list

1 Navigate to the Administration - Pricing screen > Rate Lists view.

2 In the Rate Lists list, select the rate list for the product whose cost you want to view. 

3 Click the Rate List Line Items view tab. 

4 In the Rate List Line Items list, select the product whose cost you want to view. 

Using Asset Mapping to Value Assets
When you use asset mapping, an asset is valued as a percentage of its value on the cost list. 
The percentage can be based on the current condition of the asset. For example, a new asset in 
excellent condition would be 100% of the cost list value, while a used asset in average condition 
would be 40% of the cost list value. 

Adjustments depend on the Condition, Value Basis, Cost List, and Cost Method fields for each asset. 
These factors are used to calculate the Asset Values and the Replacement Costs on the Assets screen 
> Value view. 

If there are no asset mapping records and a cost list is specified, the Assets screen > Value view 
uses the asset cost from the Cost List Line Items view. 

For more information about assets, see Siebel Field Service Guide. 

NOTE: Asset mapping applies to product lines and to all assets that belong to the same product line 
and cost list.
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To map the cost of assets for specific product lines

1 Navigate to the Administration - Pricing screen > Cost List screen.

2 In the Cost Lists list, select a cost list. 

3 Click the Asset Mapping view tab.

4 In the Asset Mapping form, add a new record and complete the necessary fields. Some fields are 
described in the following table. 

Field Comments

Cost Field Select the value that is used as the basis of the cost calculation. 
Options are: 

■ Asset Value. This calculation is based on the original cost of 
the product. 

■ Replacement. This calculation is based on the cost list value 
of the product.

Condition Select the condition of the asset. 

Value Basis Select the value basis of the asset. The value of the asset is 
adjusted based on your selection. Options are: 

■ Scrap. This is the value of the asset as scrap. In many cases, 
this involves depreciating to zero. 

■ Original. This is the original basis for the value of the asset.

■ Adjusted. This is an adjustment based on a one-time event. 
For example, you could use this if you drop the asset and the 
damage reduces its value. 

■ New. This is an adjustment for a new product. For example, 
a new car drops in value as soon as you drive it off the car lot.

■ Refurbished. This is the value of the asset when it is 
refurbished.

■ Used. This is the value of the asset when it is sold as used.

Cost Method This is the same cost method used in the Cost List Line Items 
view. 

Factor You can leave the Condition and Value Basis fields blank and 
instead enter a value in the Factor field, which specifies the 
percentage of its cost at which this asset is valued. 

If Condition or Value Basis are entered, they override the Factor 
field. 
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6 Creating Volume Discounts
This chapter describes the two different types of volume discounts and the process of setting up a 
volume discount. It also covers special features of volume discounts for products with components. 

This chapter covers the following topics: 

■ “About Volume Discounts” on page 51

■ “Process of Setting Up a Volume Discount” on page 52

■ “Volume Discounts and Products with Components” on page 55

■ “Volume Discounts Across Line Items” on page 55

About Volume Discounts
A volume discount is an adjustment to the price of a product based on the quantity of that product 
in the quote line or order line item. 

When you define a volume discount, you select one of two discount methods: 

■ Simple. This method applies the same discount to every line item. The discount for all items 
depends on the total quantity of that item purchased. 

■ Tiered. This method applies the discount defined by each Volume Discount Line Item record to 
the quantity of items defined in that Volume Discount Line Item record. 

For example, you create a volume discount with line items that: 

■ Apply a 10 percent discount when the quantity is five to 10 items 

■ Apply a 20 percent discount when the quantity is 11 to 20 items 

■ Apply a 30 percent discount when the quantity is 21 items or more 

If this is a simple volume discount, and if the customer buys 23 items, the customer gets a discount 
of 30 percent on all 23 items. 

If this is a tiered volume discount, and if the customer buys 23 items, the customer gets no discount 
on items one to four, a 10 percent discount on items five to 10, a 20 percent discount on items 11 
to 20, and a 30 percent discount on items 21 to 23. 

Volume discounts apply to the quantity in the quote line or order line, not the total quantity in the 
entire quote or in an entire order. If a user splits an order for a product into two or more lines on a 
quote, the volume discount calculation for that product is not based on the total of the two lines. 
However, you can configure the application to base volume discounts on multiple line items, as 
described in “Volume Discounts Across Line Items” on page 55. 
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The volume discount applies to the start price after attribute pricing and customizable product pricing 
adjustments have been applied. 

NOTE: If you use volume discounts with other types of price adjustments, the final price depends 
on the order in which Siebel Pricer applies the pricing adjustments. For more information, see “About 
the Processing Order of Price Adjustments” on page 13. 

Process of Setting Up a Volume Discount
To set up a volume discount, perform the following tasks:

1 “Creating a Volume Discount Record” on page 52

2 “Creating Volume Discount Line Items” on page 53

3 “Linking the Volume Discount to a Price List or Discount Matrix” on page 54

Creating a Volume Discount Record
A volume discount record provides the top-level information about a volume discount, including its 
name, whether it is a simple or tiered volume discount, its start and end dates, and its currency. 

CAUTION: If you delete a volume discount record, all references to this discount become invalid. 
Any price list line items that used this discount will no longer have a volume discount.

To create a volume discount record

1 Navigate to the Administration - Pricing screen > Volume Discount view.

2 Add a new record to the Volume Discounts list and complete the necessary fields. Some fields 
are described in the following table. 

Field Comments

Name Enter a name for this volume discount. 

Discount Method Select a method from the picklist. The options are Simple and 
Tiered, as described in “About Volume Discounts” on page 51. 

Start Date Enter the date when this volume discount becomes effective. 

End Date Enter the date when this volume discount becomes ineffective. If 
the volume discount will not expire, leave this field blank. 

Currency Enter the currency in which the volume discount is applied. 

Exchange Date If you are converting currencies, enter the date for the currency 
exchange rate. The system will use the exchange rate on that day 
to convert currency. 
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Creating Volume Discount Line Items
Volume discount line items include information about quantity range and the corresponding price 
adjustments. 

Add a volume discount line item for each quantity range in the volume discount. For example, if you 
want to apply a 10 percent discount when the quantity is between five and ten, and a 20 percent 
discount when the quantity is 11 or more, then you must add two volume discount line items. 

When you add volume discount line items, be careful not to create gaps or overlapping quantities, 
which result in the following errors: 

■ If you leave a gap in a simple discount, quantities that fall within the range of the gap receive 
no discount at all.

■ If you leave a gap in a tiered discount, quantities that fall within the range of the gap default to 
the lower tier.

■ If you create overlapping discount items and quantity ranges, the discounting behavior is not 
predictable.

How the discounts in the line items are applied depends on whether this is a simple or tiered volume 
discount, as described in the section “About Volume Discounts” on page 51.

To create a volume discount line item

1 Navigate to the Administration - Pricing screen > Volume Discount view.

2 Select the volume discount for which you want to create line items.

3 Click the Volume Discounts Line Items view tab. 

4 In the Volume Discounts Line Items list, add a new record and complete the necessary fields. 
Some fields are described in the following table. 

Field Comments

Name Enter a name for this volume discount line item. This name 
appears in the quotes that your sales representatives create for 
customers, so you should use a name that describes the discount, 
such as “10 percent Discount for Buying 5 to 10.” The value in this 
field is also used to create an upsell message about the additional 
quantity to purchase in order to get a bigger discount.

Min Qty Enter the minimum quantity that must be purchased to get this 
discount rate. 

Max Qty Enter the maximum quantity that gets this discount rate. If this 
field is blank, this discount rate applies to all quantities above the 
minimum quantity. 
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Linking the Volume Discount to a Price List or Discount 
Matrix
To apply the volume discount, you have to link it to a price list line item or a discount matrix line item.

To link a volume discount to a product in a price list

1 Navigate to the Administration - Pricing screen > Price Lists view.

2 In the Price Lists list, select the price list to which you want the volume discount to apply. 

3 Click the Price List Line Items view tab. 

4 Select the line item you want. 

5 In the Price List Line Items Detail form, in the Volume Discount field, select the volume discount 
you want to apply to that line item.

To link an volume discount to a line item in a discount matrix

1 Navigate to the Administration - Pricing screen > Discount Matrices > Discount Details view. 

2 In the Discount Details form, in the Volume Discount field, select the volume discount. 

Adjustment Type Select the type of the adjustment that the discount will apply. 
Options are Discount Amount, % Discount, Markup Amount, % 
Markup, Price Override. 

Adjustment Amount The value in the Adjustment Type field determines how the 
adjustment amount is applied, as follows:

■ If the Adjustment Type is Discount Amount, the value in the 
Adjustment Amount field is subtracted from the price. 

■ If the Adjustment Type is % Discount, the value in the 
Adjustment Amount field is treated as a percentage and is 
subtracted from the price. For example, if the Adjustment 
Amount is 10, then 10 percent is subtracted from the price. 

■ If the Adjustment Type is Markup Amount, the value in the 
Adjustment Amount field is added to the price. 

■ If the Adjustment Type is % Markup, the value in the 
Adjustment Amount field is treated as a percentage, and is 
added to the price. 

■ If the Adjustment Type is Price Override, the value in the 
Adjustment Amount field is used instead of the price. 

Field Comments
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About Reusing Volume Discounts for 
Multiple Currencies
You can use the same volume discount schedule for price lists in different currencies. 

You can create the volume discount schedule in one currency. When the salesperson creates a quote, 
the salesperson uses this volume discount schedule but specifies other currencies for the line items. 
While calculating the volume discounts, the pricing procedure automatically converts the currency of 
price adjustments in the volume discount to the currency of the quote or order line item.

Volume Discounts and Products with 
Components 
Products with component are discussed in Chapter 11, “Setting Up Pricing for Products with 
Components.” This section explains how volume discounts apply to component products.

The pricing procedure completes the pricing for the product with components before applying any 
volume discounts. For more information, see “About the Processing Order of Price Adjustments” on 
page 13.

Volume discounts can apply to the components of a customizable product. For example, if disk drives 
are one component of a computer, you can give volume discounts based on the number of disk drives 
within a single instance of a disk drive in the customizable product. The volume discount applies to 
an individual line item within a customizable product, and takes into account the existence of multiple 
instances of the disk drive within the customizable product or quote. However, you can configure the 
product so it applies discounts based on the quantity in multiple line items of an order, as described 
in “Volume Discounts Across Line Items” on page 55. 

Volume Discounts Across Line Items 
You can modify the pricing procedure to create volume discounts that work across line items.

The pricing procedure is a PSP procedure. For more information about PSP procedures and about the 
Aggregate Transform, see Siebel Order Management Infrastructure Guide. 
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7 Creating Aggregate Discounts
This chapter covers aggregate discounts and includes the following topics: 

■ “About Aggregate Discounts” on page 57

■ “Buy and Receive Products for Aggregate Discounts” on page 58

■ “Process of Creating Aggregate Discounts” on page 58

■ “Aggregate Discounts for “Buy One, Get One Free” Discounts” on page 62

■ “Aggregate Discounts for Products with Components” on page 63

NOTE: As an alternative to the methods described in this chapter, you can create aggregate 
discounts using a discount matrix, as described in Chapter 9, “Creating Discount Matrices.”

About Aggregate Discounts
When you define aggregate discounts, you specify a bundle of items and the discount that applies to 
specific items if the user buys the entire bundle. 

For example, you might specify that customers who buy a dining room table and four chairs would 
get 10 percent off on the price of the chairs. 

In addition to the method described in this chapter, there are two other ways to create aggregate 
discounts: 

■ Simple Product Bundles. In simple cases, you can create a simple product bundle with all the 
products in the promotion and create a special price for the bundle. For example, create a 
product bundle with a dining room table and four chairs, and set a price for this bundle that is 
less than the total of the individual prices of these items. For more information about simple 
bundle pricing, see “Creating a Price List Line Item for a Simple Product Bundle” on page 31. 

■ Product Promotions. Product promotions allow you to create bundled promotions, to show 
these promotions in quotes, orders, and catalogs, and to recommend these promotions to 
customers who buy products in the bundle. This is usually the preferred method of creating 
bundle discounts. For more information, see Chapter 8, “Creating Product Promotions.”

NOTE: If you use an aggregate discount with other types of price adjustments, the final price 
depends on the order in which Siebel Pricer applies the pricing adjustments. For more information, 
see “About the Processing Order of Price Adjustments” on page 13. 
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Buy and Receive Products for Aggregate 
Discounts
When you add the components to an aggregate discount, you specify whether items are buy or 
receive products:

■ Buy products. To qualify for the aggregate discount, the customer must buy at least the 
specified quantity of all the Buy products in the list. The Buy products themselves may be 
discounted if the customer qualifies for the aggregate discount. 

■ Receive products. The Receive products are discounted if the customer qualifies for an 
aggregate discount. There is no requirement to buy a specific number of Receive products.

Some examples of Buy and Receive products in aggregate discounts are as follows:

■ If you buy a certain model of desk, you get 50 percent off on a certain model of ergonomic chair. 
(The desk is a Buy product with a quantity of 1 and no price adjustment. The chair is a Receive 
product with a quantity of 1 and a price adjustment of 50 percent discount.)

■ If you buy 10 desks, you get 10 percent off on the desks and 50 percent off on the ergonomic 
chairs for them. (The desk is a Buy product with a quantity of 10 and a price adjustment of 10 
percent discount. The chair is a Receive product with a quantity of 10 and a price adjustment of 
50 percent discount.) 

■ If you buy 10 desks, you get 10 percent off on the desks and 50 percent off on any model of desk 
chair for them. (The desk is a Buy product with a quantity of 10 and a price adjustment of 10 
percent discount. Each model of desk chair is a Receive product with a quantity of 10 and a price 
adjustment of 50 percent discount.) 

■ If you buy 10 desks, you get 10 percent off on the desks. (The desk is a Buy product with a 
quantity of 10 and a price adjustment of 10 percent discount. There is no Receive product.) 

NOTE: The Buy product quantity is a minimum and the Receive product quantity is a maximum. For 
example, the bundling discount says that if you buy 10 desks, you get 50 percent off on 10 ergonomic 
chairs for them. You must then buy a minimum of 10 desks to get the discount, and you can get a 
discount on a maximum of 10 chairs. This prevents a customer from buying 10 desks in order to get 
a discount on thousands of chairs. 

Process of Creating Aggregate Discounts
To create aggregate discounts, perform the following tasks: 

■ “Adding an Aggregate Discount Record” on page 59

■ “Defining Aggregate Discount Sequence” on page 60

■ “Attaching an Aggregate Discount Sequence to a Price List” on page 62
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Adding an Aggregate Discount Record
To define an aggregate discount, you enter general information about the group of products in the 
Aggregate Discount record and add all the products in the group to the Discount Details list. 

To define an aggregate discount

1 Navigate to the Administration - Pricing screen > Aggregate Discounts view. 

2 Add a record to the Aggregate Discounts list, and complete the necessary fields in the record and 
the More Info form. 

Some fields are described in the following table. 

3 Click the Discount Details view tab. 

4 For each product in the bundle, add a record to the Discount Details list and complete the 
necessary fields. Some fields are described in the following table. 

Field Comments

Name Enter a name for the aggregate discount.

Currency Select the currency for the aggregate discount. 

Exchange Date If multiple currencies are used for the products in the bundle, 
enter the date of the exchange rate that will be used for currency 
conversion. 

Effective From Enter the start date when this discount becomes active. 

Effective To Enter the end date when this discount is no longer active. 

Active Select this check box to activate the aggregate discount. 

The discount is active only if the date of an order is between the 
Effective From and Effective To dates, and you have selected this 
check box so the aggregate discount is active. 

Field Comments

Product Name Select the product. 

Buy If it is a Buy product, select this check box. For more information, 
see “Buy and Receive Products for Aggregate Discounts” on 
page 58. 

Receive If it is a Receive product, select this check box. 

NOTE: You cannot select both the Buy and Receive check box in 
a single record. If you want to make a product both a Buy and a 
Receive product, add two records for that product, and select Buy 
in one and Receive in the other. 
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Defining Aggregate Discount Sequence 
Aggregate discount sequences are used to define the stacking logic for aggregate discounts. This 
logic can define: 

■ The order in which aggregate discounts are applied.

■ Which aggregate discounts are mutually exclusive. 

■ Which aggregate discounts can be “stacked,” or applied in conjunction with one another. 

You can use aggregate discounts within a quote or an order only if they are part of an aggregate 
discount sequence. Therefore, you must define an aggregate discount sequence even if you have 
only one aggregate discount. An aggregate discount can be a part of many aggregate discount 
sequences. 

Aggregate discount sequences are linked with price list and discount matrix line items (like volume 
discounts and attribute adjustments). At run time, the pricing procedure picks the aggregate 
discount sequence to be used and evaluates the aggregate discounts to be applied. 

Qty Enter the quantity of the product. For Buy products, this is the 
minimum quantity that you must buy to receive the aggregate 
discount. For Receive products, this is the maximum quantity that 
can receive a discount. For more information, see “Buy and 
Receive Products for Aggregate Discounts” on page 58.

Adjustment Type Select the type of price adjustment applied to this product. 
Options are Discount Amount, % Discount, Markup Amount, % 
Markup, and Price Override.

Adjustment Amount Enter the amount of the Adjustment. How this value is used 
depends on the selection in the Adjustment Type field: 

■ Discount Amount. The adjustment amount is subtracted 
from the product price. 

■ % Discount. The adjustment amount is treated as a 
percentage of the product price, which is subtracted from the 
product price. 

■ Markup Amount. The adjustment amount is added to the 
product price. 

■ % Markup. The adjustment amount is treated as a 
percentage of the product price, which is added to the product 
price. 

■ Price Override. The adjustment amount is used as the 
product price, overriding the original price. 

Field Comments
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The order in which aggregate discounts are applied within an aggregate discount sequence can affect 
the resulting price. For example, if aggregate discount (a) gives a discount of $100, and aggregate 
discount (b) gives you 10% off the price of the product, the resulting price would be lower if 
aggregate discount (b) is applied before aggregate discount (a).

To apply all the aggregate discounts in a sequence, you attach the sequence to either a price list or 
a product with component line items. A sequence should include all the aggregate discounts that 
apply to one price list or to one product with components in a price list. 

To define the aggregate discount sequence 

1 Navigate to the Administration - Pricing screen > Aggregate Discount Sequences view. 

2 Add a record to the Aggregate Discount Sequence list and complete the necessary fields. 

Some fields are described in the following table. 

3 Click the Aggregate Discounts view tab. 

4 Add records to the Aggregate Discounts list for every aggregate discount that you want in this 
sequence and complete the necessary fields, described in the following table. 

Field Comments

Name Enter a name for the aggregate discount sequence.

Effective From Enter the date when the aggregate discount sequence becomes 
effective. 

Effective To Enter the date when the aggregate discount sequence is no longer 
effective. 

Active Select this check box to activate the aggregate discount 
sequence. 

Field Comments

Sequence Enter the sequence in which this aggregate discount is applied. 

Name Select the aggregate discount.

Next Discount if Used Select the next aggregate discount in the sequence to be used if 
this discount is applied. 

Next Discount if not Used Select the next aggregate discount in the sequence to be used if 
this discount is not applied. 
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Discounts
Attaching an Aggregate Discount Sequence to a Price 
List
You can attach the aggregate discount sequence to a price list and, with some restrictions, also to 
price list line items. In the case of price list line items, you can attach an aggregate discount 
sequence to a product with components. 

For example, with a computer system, you might want to attach the aggregate discount sequence 
to a product with components to give discounts to customers who buy a specific CD-ROM drive, 
monitor, and keyboard.

To attach an aggregate discount sequence to a price list

1 Navigate to the Administration - Pricing screen > Price Lists view.

2 In the Price Lists list, select the price list to which you will attach the sequence. 

3 In the More Info form, in the Aggregate Discount Sequence field, select the sequence to attach 
to this price list. 

The aggregate discounts in this sequence apply to all prices in this price list. 

To attach an aggregate discount sequence to a price list line item

1 Navigate to the Administration - Pricing screen > Price Lists view.

2 Click the Price List Line Item view tab. 

3 In the Price List Item Detail form, in the Aggregate Discount Sequence field, select the aggregate 
discount sequence. 

You can modify this field only if the product is a product with components. 

Aggregate Discounts for “Buy One, Get 
One Free” Discounts
Aggregate discounts are generally used to reduce the price of one product when it is sold with one 
or more different products. For example, a customer could buy a dining room table at full price and 
receive a discount on dining room chairs. 

Aggregate discounts can also be used where you buy a product and receive a discount on the same 
product. This is commonly called a Buy One, Get One Free discount. 

To set up this sort of discount, combine them in one aggregate discount with a Buy quantity equal 
to the total number of products a customer must buy, and the discount set to give the appropriate 
result. 

For example, if customers can buy one dining room chair and get one chair for free: 

■ Set the Buy quantity to two. 
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■ Set the price Adjustment Type to % Discount and the Adjustment Amount to 50 to create a 
Receive rule that gives 50 percent off the List price for each product. 

Similarly, if customers can buy three dining room chairs and get one chair for free: 

■ Set the Buy Quantity to four.

■ Set the price Adjustment Type to % Discount and Adjustment Amount to 25 to create a receive 
rule that gives 25 percent off the List price for each product. 

Aggregate Discounts for Products with 
Components
Aggregate discounts can be associated with component-based products. For example, for customers 
buying personal computers, you might create an aggregate discount so that if they buy both a CD-
ROM drive and a floppy disk drive, they get a 10 percent discount on both drives. 

Aggregate discounts for product components work in the same general way as other aggregate 
discounts, but there are several additional constraints: 

■ Aggregate discounts for product components must include only components of the product. Do 
not create an aggregate discount that mixes components of one component-based product with 
components of other component-based products.

■ The aggregate discount is applied once the product with component has the required quantity of 
the Buy and the Receive products. 

■ If you are defining the required quantities for a component-based product component in a 
bundling discount, be aware of the constraints defined for the product, especially the Max 
Cardinality limit. Do not define aggregate discounts that require the user to buy more products 
than the cardinality limits; if the pricing rule exceeds cardinality, it will not be applied. 

NOTE: If the same product appears multiple times as a component, then the different instances of 
the product may have different prices after all adjustments. In this case, the aggregate discount uses 
as its target price the instance of the product with the highest net price. For example, if a specific 
memory chip appears multiple places within a customizable computer system product, the highest 
calculated price for that memory chip will be used as the target price for all bundling discounts on 
that chip.
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8 Creating Product Promotions
This chapter covers product promotions and includes the following sections: 

■ “About Product Promotions” on page 65

■ “Process of Creating Product Promotions” on page 66

■ “Creating Product Promotions That Upgrade Existing Promotions” on page 79

■ “Viewing a Summary of a Product Promotion” on page 80

■ “Managing Versions of Product Promotions” on page 81

■ “Viewing the Schedules of All Product Promotions” on page 81

■ “About Product Promotions for Customizable Products” on page 82

■ “Activating Workflows for Product Promotion” on page 84

About Product Promotions
Product promotions are created in the Administration - Product screen. They represent the marketing 
definition of a product. Product promotions are time-sensitive, and they state discounted prices and 
contractual terms. 

Product promotions may be broadly classified to belong to either of these two types:

■ Coupons. This promotion includes a single product or service. This sort of promotion is used 
primarily for retail sales and is also called a retail promotion. 

■ Bundled promotions. This promotion includes a group of products or services. 

End users can select product promotions in two ways: 

■ Top-down selection. If the customer receives an offer or sees an advertisement for the 
promotion, the customer can order the promotion. The customer or sales representative adds 
the promotion to the order, and all of the products in the promotion are added as line items to 
the quote or order. This selection method usually applies to bundled promotions.

■ Bottom-up selection. If the customer adds products to a quote or order that have product 
promotions available, the sales representative or the application can recommend the promotion. 
When a customer is purchasing some products in a bundle promotion, the application can 
automatically recommend the bundle promotion. There can be an auto-recommendation if the 
customer has these products in a quote or order as new items, and if they are not already 
covered by another promotion. 

For more information about how end users work with product promotions, see Siebel Order 
Management Guide.
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Process of Creating Product Promotions
To create a product promotion, perform the following tasks: 

1 “Setting Up Image Files for Product Promotions” on page 66

2 “Creating the Product Promotion Record” on page 67

3 “Specifying Products for Product Promotions” on page 69

4 “Specifying Pricing for Product Promotions” on page 71

5 “Defining Eligibility Rules for Product Promotions” on page 73

6 “Defining Compatibility Rules for Product Promotions” on page 74

7 “Customizing Recommendation Messages for Product Promotions” on page 74

8 “Creating Translations of Recommendation Messages for Product Promotions” on page 74

9 “Specifying Terms and Conditions of Product Promotions” on page 75

10 “Releasing the Product Promotion” on page 78

11 “Activating Workflows for Product Promotion” on page 84

NOTE: When you create the new Product Promotion record, a version named Work Space is 
automatically created and the Locked check box is automatically selected in Product Promotions 
screen > Versions view. This check box must be selected to change the Effective Dates of the 
promotion. You do not have to lock the version to change any other information about a promotion, 
but to see the changes at run time, the user must select Refresh Cache from an applet-level menu 
item of the promotion header form. For more information, see “Managing Versions of Product 
Promotions” on page 81. 

Setting Up Image Files for Product Promotions
When you create a product promotion, you can associate an image file with it. This image will be 
displayed next to the promotion in catalogs. If you want to show the image in catalogs, you must 
create the image and import it into the Siebel application in the Administration - Document screen. 
This makes it available to associate with the product promotion record. 

This task is a step in “Process of Creating Product Promotions” on page 66. 

To set up image files for product promotions

1 Create the images in either JPG or GIF format. 

2 Navigate to the Administration - Document screen > Literature view. 

3 In the Literature list, click New File. 

4 In the Choose File dialog box, select the image file. 
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Creating the Product Promotion Record
Create the Product Promotion record, which contains general information about the entire product 
promotion. 

This task is a step in “Process of Creating Product Promotions” on page 66. 

NOTE: When you create a Product Promotion record, you specify the effective dates for the 
promotion. Before you do this, it can be useful to view a schedule of all your product promotions. 
For more information, see “Viewing the Schedules of All Product Promotions” on page 81.

To create a product promotion record

1 Navigate to the Administration - Product screen > Product Promotions view. 

2 Add a new record to the promotions list and complete the necessary fields. Some fields are 
described in the following table. 

Field Comments

Name Enter a name for the promotion.

Type Select the type of the promotion. Options are coupon and bundled 
promotion. For more information about these types, see “About 
Product Promotions” on page 65. 

Instances Select a value that specifies how many times a customer is 
allowed to use this promotion. Options are One Per Customer, 
One Per Order, and No Limit. 

Effective Dates This field displays the start date and end date of the period when 
this promotion is effective. Users can edit these dates in the 
Versions view. 

Track as Asset Select this check box to track the promotion as an asset. This is 
necessary if you provide ongoing service to the buyer of the 
promotion, or have some other reason to keep a record of which 
buyers have purchased the promotion. For more information, see 
the section about asset-based ordering in Siebel Order 
Management Guide. 

NOTE: This check box applies only to the promotion, not to the 
products in it. To track products within the promotion as assets, 
you must select the Track as Asset check box for these products 
in the Administration - Products screen > Products view. 
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Show in Catalog Select this check box to display the promotion in the product 
catalogs, so the end user can choose it in quotes and orders the 
same way the end user chooses a product. 

If you select the check box for bundle promotions, end users can 
select the bundle promotion in a catalog to add all the products 
in the promotion to a quote or order. 

You generally should not select this check box for coupon 
promotions. For coupon promotions, end users generally add the 
product, and then select a coupon promotion that is available for 
that product. 

Promotion ID This field displays a unique, system-generated ID for the 
promotion. 

Image Select an image file that will display if this promotion is shown in 
a catalog. Before you can select this, you must set up the image, 
as described in “Setting Up Image Files for Product Promotions” on 
page 66. 

Organization Select one or more organizations to give them visibility to this 
promotion. Users who are not in these organizations cannot see 
this promotion in the Siebel application. For more information 
about organizations, see Security Guide for Siebel Business 
Applications. 

Campaign If the promotion is part of a marketing campaign, select the 
campaign. For more information about campaigns, see Siebel 
Marketing Installation and Administration Guide. 

Score Enter the ranking that determines where on the list of product 
promotion recommendations this promotion will appear when the 
end user displays recommendations. Promotions with higher 
scores appear higher on the list. For more information, see the 
section about recommendations in Siebel Order Management 
Guide. 

Message Enter a message for the promotion. 

Track as Agreement Select this check box to track the promotion as an agreement. 
This is necessary if the agreement involves some ongoing 
commitment to the customer that you must refer to in the future. 
For more information about agreements, see Siebel Professional 
Services Automation Guide. 

Field Comments
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Specifying Products for Product Promotions
Every promotion applies to specific products. The promotion may apply to one product, such as a 
particular model of table and chair, or it may apply to many products, such as all of your dining room 
tables. 

If you are creating a bundle product promotion, list all the products in the bundle in the Products 
list. The customer must buy all these products to get a discount. 

If you are creating a coupon product promotion, you do not have to list the product here. Add the 
product and the price discount for it in the Product Promotion > Pricing view. 

You can add the products covered by a promotion using the Product Promotions > Products > 
Components view. For example, if you give customers a discount if they buy a specific model of table 
and four chairs, add that table to the Products view with a minimum quantity of 1, and add the chair 
with a minimum quantity of 4. 

You can also add product lines or product classes to a promotion using the Product Promotions > 
Products > Aggregate view. For example, if you have a product line named Dining Room Tables, you 
can add it to the promotion so that the promotion applies to all dining room tables. You specify the 
default dining room table that is included in the promotion, but the customer can select any product 
in the Dining Room Table product line to get the bundle discount. 

This task is a step in “Process of Creating Product Promotions” on page 66. 

To specify individual products for a product promotion

1 Navigate to the Administration - Product screen > Product Promotions view. 

2 In the Product Promotions list, select the promotion for which you are specifying products. 

3 Click the Products view tab. 

If necessary, in the link bar of the Products view, click Components. 

4 For each product that is covered by the promotion, add a new record to the Product Components 
list and complete the necessary fields. Some fields are described in the following table. 

Field Comments

Product Name Select a product that is covered by the promotion. Products are 
available in the dialog box if they are released and have a 
currently active version. If this is a product with components, you 
can click the product name to display the explorer view used to 
define products with components. 

Description Enter a description of the product. 

Min Enter the minimum number of this product that the customer 
must buy to qualify for this promotion, if there is a minimum 
requirement. 
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5 To enter translations of descriptions of the product to be shown in catalogs that are not in the 
default language, add a new record to the Translations list for each language you support and 
complete the necessary fields, described in the following table. 

NOTE: The catalog in the default language shows the description that you entered in the 
Description field of the Product Component record, as described in Step 4. 

Max Enter the maximum number of this product that the customer 
may buy to get the discount for this promotion, if there is a 
maximum limit. 

Default Enter the default quantity of this product that is included in the 
promotion, if you want to display a default quantity. If the 
customer selects this promotion in a quote or order, the default 
quantity of all products in the promotion will be added as line 
items to the quote or order. 

This field is optional. If you do not enter a value here, the 
application uses the value entered in the Min field as the default 
value. 

Customizable This check box is selected if the product selected in the Product 
Name field is customizable. 

The promotion can also be used to constrain the selections for the 
customizable product. For more information, see “About Product 
Promotions for Customizable Products” on page 82.

Recommendable Select this check box to allow the system to recommend this 
product promotion to end users when the product exists in a 
quote or order and is not associated with any other product 
promotion.

Commitment Select this check box if the product involves a commitment. For 
more information, see “Specifying Terms and Conditions of Product 
Promotions” on page 75.

Field Comments

Language Name This field displays the name of the language after you select the 
language code. 

Language Code Select the language code—for example, select ENU for American 
English. 

Description Enter the description of the promotion to be shown in catalogs 
and promotion recommendations using this language. 

Field Comments
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To specify product lines or product classes for a product promotion

1 Navigate to the Administration - Product screen > Product Promotions view. 

2 In the Product Promotions list, select the promotion for which you are specifying products. 

3 Click the Products view tab, and in the link bar, click Aggregate.

4 For each product that is covered by the promotion, add a new record to the Product Aggregate 
list and complete the necessary fields. Some fields are described in the following table. 

Complete the other fields in the same way as in the Components view. 

5 In the Default Product view, click the Default check box for each product that is a default product 
for the promotion and enter the default quantity for each. 

6 To enter descriptions of the promotion to be displayed in Edit Promotion view, add a new record 
to the Translations list for each language you support and complete the necessary fields in the 
same way as in the Components view. 

Specifying Pricing for Product Promotions
All promotions involve giving customers price adjustments on some or all products. For example, a 
promotion may offer a discount on a table if the customer buys a set that includes the table and four 
chairs. 

Use the Pricing view to define the price adjustments for this promotion. You can define two types of 
price adjustments: 

■ Component. Define price adjustments for individual products. 

■ Aggregate. Define price adjustments for multiple products. There are two types of aggregate 
rules: 

■ Aggregate Conditional Rules. Define rules for all the products in a product class or product 
line. For example, you could give a 10 percent discount on all digital cameras and a 15 
percent discount on all film cameras, if these are two product lines with products that have 
been included in the promotion. 

■ Aggregate Default Rules. Define rules that are applied by default if the line item product 
does not match any individual product pricing rule or any conditional aggregate pricing rule.

This task is a step in “Process of Creating Product Promotions” on page 66. 

To specify price adjustments for individual products in a product promotion

1 Navigate to the Administration - Product screen > Product Promotions view. 

Field Comments

Product Line Select a product line that is covered by the promotion. Select 
either a product line or a product class, but not both. 

Product Class Select a product class that is covered by the promotion. 
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2 In the Product Promotions list, select the promotion for which you are specifying pricing. 

3 In the Versions view, select the Check Eligibility and Compatibility check box. 

4 Click the Pricing view tab. 

5 Click Components on the link bar in Pricing view. 

6 In the Pricing Components list, add a record for each product whose price will be changed by the 
promotion and complete the necessary fields. Some fields are described in the following table. 

To specify price adjustments applied to a product class or product line in a product 
promotion

1 Navigate to the Administration - Product screen > Product Promotions view. 

2 In the Product Promotions list, select the promotion for which you are specifying the pricing. 

3 Click the Pricing view tab. 

4 Click Aggregate on the link bar in the Pricing view. 

Field Comments

Product Name Select a product. 

Adjustment Type Select the type of price adjustment applied to this product. 
Options are Discount Amount, %  Discount, Markup Amount, % 
Markup, and Price Override. 

Adjustment Value Enter the value of the Adjustment. How this value is used 
depends on the selection in the Adjustment Type field: 

■ Discount Amount. The adjustment value is subtracted from 
the product price. 

■ % Discount. The adjustment value is a percentage of the 
product price, which is then subtracted from the product 
price. 

■ Markup Amount. The adjustment value is added to the 
product price. 

■ % Markup. The adjustment value is a percentage of the 
product price, which is then added to the product price. 

■ Price Override. The adjustment value is used as the product 
price, overriding the original price. 
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5 In the Pricing Aggregate list, add a new record and complete the necessary fields. Some fields 
are described in the following table. 

6 If you selected Aggregate - Conditional as the type, you can add more records to define 
adjustments for additional product lines and classes. 

Defining Eligibility Rules for Product Promotions
Promotions may be restricted to only some of your customers. For example, a promotion may be 
offered only to customers in certain states. You can define rules that specify which customers are 
eligible for the promotion. For more information, see the section about eligibility rules in Siebel Order 
Management Guide. 

NOTE: In the 7.8.2 version, the Check Eligibility flag and Inclusive Eligibility flag have been moved 
to the promotion header from the Versions view.

To define eligibility rules for a product promotion

1 Navigate to the Administration - Product screen > Product Promotions view. 

2 In the Product Promotions list, select the promotion for which you are defining the eligibility 
rules. 

3 In the Rules Display view, select the Check Eligibility and Compatibility check box. 

4 Click the Eligibility and Compatibility view tab and in the Rules link bar, click Eligibility.

5 Add new records to the Rules list and complete the necessary fields, as described in Siebel Order 
Management Guide.

Field Comments

Type Select the type of aggregate adjustment. Options are: 

■ Aggregate – Default. This is a default pricing rule. If the line 
item product does not match any individual product pricing 
rule or any conditional aggregate pricing rule, the line item 
price is adjusted using this default rule. 

■ Aggregate – Conditional. The adjustment is applied to 
product classes or product lines. When this value is selected 
a user must define the Group Field and Group Value fields.

Product Line If you selected Aggregate - Conditional as the type, you can 
select a product line to which the adjustment applies.

Class If you selected Aggregate - Conditional as the type, you can 
select a class to which the adjustment applies.

Adjustment Type and 
Adjustment Value

Enter the price adjustment. These fields are used in the same way 
as in the Pricing Components view, which was described in the 
previous procedure.
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Defining Compatibility Rules for Product Promotions
You might have policies that keep customers from using more than one product promotion at the 
same time. For example, you might say that a coupon for a product may not be used with other 
coupons for the same product, but that the coupon may be used with bundle promotions for the same 
product. 

You can define compatibility rules for a product promotion to specify the other product promotions 
with which it may and may not be used. For more information, see the section about compatibility 
rules in Siebel Order Management Guide. 

To define compatibility rules for a product promotion

1 Navigate to the Administration - Product screen > Product Promotions view. 

2 In the Product Promotions list, select the promotion for which you are defining compatibility 
rules.

3 Click the Eligibility and Compatibility Rules view tab and then in the link bar, click Compatibility. 

4 Add new records to the Rules list and complete the necessary fields, as described in the section 
about compatibility in Siebel Order Management Guide.

Customizing Recommendation Messages for Product 
Promotions
By default, if the application recommends a promotion, it displays a message in the following form: 

Recommend promotion ‘[Prod Prom Name]’: [Promotion Description].

You can customize the form of this message. 

To customize the recommendation message for product promotions

1 Navigate to the Administration - Application screen and in the link bar, click Message Types. 

2 In the All Message Types list, query to find the record with the name Promotion - Bottomup 
Recommendation.

3 In the Message Type view, enter the desired message in the Full Text field. 

Creating Translations of Recommendation Messages for 
Product Promotions 
You can translate the recommendation message in multiple languages. The language that is 
displayed depends on the language of the user’s application.

This task is a step in “Process of Creating Product Promotions” on page 66. 
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To specify recommendation messages for a product promotion

1 Navigate to the Administration - Product screen > Product Promotions view. 

2 In the Product Promotions list, select the promotion. 

3 Click the Messaging view tab. 

4 For each language in which the message will be displayed, add a record to the Messaging list and 
complete the necessary fields. Some fields are described in the following table. 

Specifying Terms and Conditions of Product Promotions
Some promotions require customers to accept certain terms and conditions. In some industries, 
these are called commitments. If your promotion includes terms and conditions, you must specify 
them. This task is a step in “Process of Creating Product Promotions” on page 66. 

For example, if a customer accepts a promotion offering a free cell phone to sign up for a certain 
wireless plan, the customer may have to keep that wireless service for at least a year. If the customer 
cancels the service before the year has ended, there may be a penalty. 

When a customer disconnects an asset, the Siebel application checks to see if the customer is 
breaking the terms and conditions of a promotion; if so, it displays a warning message telling the 
customer how much the penalty is. You can set up the product recommendation engine to 
recommend changes that will avoid the penalty, as described in the section on recommendations in 
Siebel Order Management Guide. If there is a penalty, the application calculates the amount; the 
Siebel application should be integrated with the billing system, so the penalty is automatically 
applied. 

You may want to prorate the penalty. For example, if customers get a free satellite dish when they 
sign up for twelve months of service, they may have to pay the full penalty if they cancel before one 
month has elapsed, but pay only one-half of the penalty if they cancel after six months. 

A commitment may include recurring credit and cancellation charges. The cancellation charge and 
credits may need to be prorated for partial periods. 

The penalty may be a nonrecurring charge paid once, or it may be a recurring charge paid 
periodically during a specified time period. 

You can use the Commitments view to give customers ongoing benefits that they receive with a 
promotion, in addition to using it for penalties. For example, if the promotion gives the customer a 
credit every month for a year, which reduces the customer’s monthly bill, the Commitments view can 
record this credit. 

Field Comments

Language Name This field displays the name of the language after you select the 
language code.

Language Code Select the language code—for example, select ENU for American 
English or ENG for British English. 

Description Enter the text of the recommendation message in the appropriate 
language. 
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Entering the Customer’s Commitment
In the Charge Plan view of the Commitment applet, enter the charges for customers’ ongoing 
commitment. Enter negative amounts if it is a credit. To do this, you must first create schedules and 
plans for any recurring, nonrecurring, and usage charges that the customer must pay. For more 
information, see the section about contracts and agreements in Siebel Field Service Guide.

After you have created the necessary recurring and nonrecurring charge plans, you can enter the 
amounts that customers are committed to pay. 

To enter the customer’s commitment

1 In the Product Promotions > Commitment view, click Charge Plan in the link bar. 

2 In the Charge Plan form, complete the necessary fields. 

Some fields are described in the following table. 

Field Comments

NRC Schedule Select a schedule for the nonrecurring charge. For example, a 
schedule may specify that the customer pays the recurring charge 
by the fifteenth of each month.

Nonrecurring Enter the total amount of the nonrecurring charge.

NRC Plan Select a nonrecurring charge plan. For example, the plan may 
allow the customer to pay off the nonrecurring charge in three 
monthly payments. 

NRC Quantity If the user does not select a value in the NRC Plan field, the user 
can enter a specific number of payments. The charge calculation 
engine then divides the charge into equal payments of the 
quantity specified. 

If the user does select a value in the NRC Plan field, this field 
displays the number of payments in the plan and is read-only. 

RC Schedule Select a schedule for the recurring charge. For example, a 
schedule may specify that the customer pays the recurring charge 
by the fifteenth of each month. 

Recurring Enter the amount of the recurring charges.

RC Adjust Specify an adjustment for a recurring charge if the usage period 
is less than the entire billing period. 

For example, if the customer starts cable TV service on June 16, 
the customer should be charged for only 15 days in the month of 
June. In this case, enter the per day charge in the RC Adjust field, 
and select Per Day in the RC Adjust U/M field. The application 
calculates the adjustment for the 15 days in June. 

RC Adjust U/M Enter the time period to which the RC adjustment applies. 
Options are Per Day and Per Week. 
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Entering Penalties for Canceling the Commitment
In the Charges and Credits view of the Commitment applet, enter the penalties that the customer 
must pay for canceling this commitment. You can also use this view to enter credits that the customer 
receives. 

Before you enter penalties, you may have to create a plan used to prorate the penalty charge, if the 
penalty depends on the amount of time that the customer used the service before canceling. Create 
the prorate plan as a nonrecurring charge plan, described in the section about contracts and 
agreements in Siebel Field Service Guide.

To enter the penalty that customers pay for canceling the commitment

1 In the Product Promotions > Commitment view, click Charges and Credits in the link bar. 

Adjust Charge Enter a special adjustment to the amount the customer is 
charged. For example, if a customer calls to complain that cell 
phone service has not been working well for the last few days, the 
company can agree to give the customer a one-time adjustment. 
The company enters the adjustment in this field. 

Adjust Reason Enter the reason for the special adjustment. 

Commit Select this check box when you are done making changes to the 
record. 

Charge Basis Specify when the charge for a period is generated. Options are:

■ Schedule. Charges are generated after the usage period. For 
example, June charges are generated on July 1. 

■ Advance. Charges are generated in advance of the usage 
period. For example, June charges are generated on June 1. 

Use Plan Select the usage payment plan for this promotion. For example, 
there may be different usage payment plans for regular, gold, and 
platinum customers. 

Usage Schedule Select a schedule for the usage charge. For example, a schedule 
may specify that the customer pays the usage charge by the 
fifteenth of each month. 

Field Comments
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2 In the Charges/Credits list, add a record for each penalty that the customer must pay, and 
complete the necessary fields. 

Some fields are described in the following table. 

Entering Terms Displayed to the Customer
In the Terms view of the Commitment applet, enter the list of terms that will be displayed and 
included in the contract that the customer accepts. 

The user can select a term template instead of entering terms manually, if you first define term 
templates using the Administration - Contract screen > Term Templates view. For more information 
about defining term templates, see Siebel Life Sciences Guide. 

To enter terms displayed to the customer

1 In the Product Promotions > Commitment view, click Terms in the link bar. 

2 For each term that will be displayed to the customer, do the following:

■ To select a term template, click Pick from Template. 

■ To enter terms manually, add a record to the Terms list and complete the necessary fields. 

Some fields are described in the following table. 

Releasing the Product Promotion
When you created the new Product Promotion record, a version of it named Work Space was 
automatically created and the Locked check box was automatically selected in Product Promotions > 
Versions view. 

Field Comments

Type Select the penalty. 

Amount Enter the amount of the penalty. If you enter a negative amount, 
the customer will receive a credit instead of paying a penalty. 

Plan Select the nonrecurring charge plan used to prorate the penalty. 

Field Comments

Number Enter a number to control what order this text will be displayed 
in within the list of terms. 

Type Select the Type of the Term. Options are Standard, Non-Standard, 
and Special. When you design screens and reports, you may 
decide to display only terms of certain types. 

Section Enter the text that will be displayed to the customer. 
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When you have finished the entire process of defining the product promotion, you must release this 
version and refresh the cache to make the new version available to users. 

Promotion versioning works differently from product versioning. Promotion versions only impact the 
Start Date, End Date, Active, and Check Eligibility and Compatibility (although this field is not 
versioned in the 7.8.2 release) fields of the promotion. Every other aspect of product promotions is 
uniform across all active versions of the promotion. The user must refresh the cache after making 
any changes to the promotion definition. 

This task is a step in “Process of Creating Product Promotions” on page 66. 

To release the product promotion

1 In the Product Promotions > Versions view, in the Work Space record, complete the necessary 
fields, as described in the following table. 

2 Click Release New Version. 

3 From the Versions form menu, select Refresh Cache. 

Creating Product Promotions That 
Upgrade Existing Promotions
You can design promotions that offer an upgrade to customers who have existing commitments 
because they have accepted earlier promotions. 

For example, if customers have already signed up for a promotion to subscribe to a wireless 
telephone plan and have commitments to pay $29.95 a month for the next year, you can create a 
promotion that offers them a wireless plan with no roaming charges for $39.95 a month. This 
involves breaking their existing commitment, but they do not have to pay the usual cancellation 
charge. 

You can also offer the new promotion to customers who have accepted any one of many earlier 
promotions. 

To create a promotion that is an upgrade to earlier promotions, define the new promotion as usual, 
and also use the Upgrade view to enter information about the existing promotions that customers 
can break without penalty. 

To specify that customers who accept a promotion can break earlier commitments

1 Navigate to the Administration - Product screen > Product Promotions view. 

2 In the Product Promotions list, select the promotion. 

Field Comments

Required Start Date Enter the date when the promotion becomes available. 

Active Select this check box to make the promotion available. 
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3 Click the Upgrade view tab. 

4 Add a record for each earlier promotion that can be broken without penalty and complete the 
necessary fields, as described in the following table. 

Viewing a Summary of a Product 
Promotion
At any time, you can view a summary of the most important features of a product promotion in a 
single screen. 

This is a read-only view. You use it to look at a summary of the product promotion while you are 
creating it, and also to provide summary information about the promotion to sales representatives. 

To view a summary of a product promotion

1 Navigate to the Administration - Product screen > Product Promotions view. 

2 In the Product Promotions list, select the promotion. 

3 Click the Summary view tab. 

Field Comments

Original Promotion Select the earlier promotion that customers can break without 
penalty. 

Commitment Start Specify when the commitment starts for the new promotion. 
Options are:

■ Original Start. The commitment starts at the same time the 
commitment for the earlier promotion started. 

■ Now. The commitment starts when the customer accepts the 
new promotion. 

■ Original End. The commitment starts when the commitment 
for the earlier promotion ends. 

Duration Specify the duration of the new promotion. Options are: 

■ Original Duration. The duration of the new promotion is the 
same as the duration of the original promotion. 

■ New Duration. The duration of the new promotion is 
different from the duration of the original promotion. If you 
select this, you must enter the new duration in the 
Commitments view. 

Penalty Enter the penalty for upgrading from the old to the new 
promotion, if any. 

Prorate Plan If there is a penalty for upgrading from the old to the new 
promotion, select the prorate plan used to prorate this penalty. 
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Managing Versions of Product 
Promotions
You manage versions of product promotions using the Product Promotions > Versions view. 

Managing versions of product promotions is not the same as managing versions of customizable 
products and product classes. 

Versions are mainly used to schedule product promotions with different effective dates. 

NOTE: Apart from the effective date fields, changes to the header of the product promotion, the 
More Info view, and the other views are not versioned. These changes take effect when the user 
selects Refresh Cache from the menu of the Promotion Header form, or when the user logs out and 
logs in again. 

Creating Product Promotion Versions with Different Effective Dates
If you are running a product promotion now and you want to run the same promotion a second time 
later in the year, you can do this by creating promotion versions with different effective dates. For 
example, if you are running a promotion during the month of April, 2005, and you want to run the 
same promotion again during the month of June, 2005, perform the following tasks: 

■ Create the promotion with April 1, 2005 in the Required Start Date field and the Active check box 
selected. Release this version of the promotion. 

■ Create a new version of the promotion with May 1, 2005 in the Required Start Date field and the 
Active check box deselected. Release this version of the promotion. Because Active is deselected, 
this version will not be visible to customers. 

■ Create a new version of the promotion with June 1, 2005 in the Required Start Date field, and 
the Active check box selected to make the promotion visible to customers beginning June 1. 

■ Create a new version of the promotion with July 1, 2005 in the Required Start Date field and the 
Active check box deselected, so the promotion is not visible to customers beginning July 1.

Viewing the Schedules of All Product 
Promotions
When you are planning new promotions, you can view a schedule of all existing product promotions 
to help you decide on the best effective dates for the new promotion. The Product Promotions 
Schedule view shows you a schedule of the effective dates for all product promotions. 

To view the schedules of all product promotions

1 Navigate to the Administration - Product screen > Product Promotions Schedule view. 

2 Click 1, 7, or 30 to view the schedules for a day, week, or month. 
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3 From the Date drop-down, select the start date of the schedules you want to view, and click Go. 

Red bars are displayed to show the dates that the promotions are active. 

NOTE: If end users cannot view color indicators, see Accessibility Guide for Siebel Business 
Applications.

About Product Promotions for 
Customizable Products
If the end user selects a promotion with a special configuration, and then displays Siebel Configurator 
to configure the product, the rules defined for a promotion are enforced within the Configurator 
session. 

For example, a specific model of computer may have hundreds of possible configurations, but a 
promotional offer may allow only a few of these configurations. The promotion may require you to 
get a specific processor and either a 20 GB or 30 GB hard drive, even though many other possible 
hard drives are allowed by the configuration rules. 

In this example, the user must display Configurator to choose the amount of RAM, the computer 
monitor, and other features besides the processor and hard drive. Configurator allows you to choose 
any one of the features that the configuration rules allow. However, Configurator lets you choose only 
the processor required by the promotion, and it lets you choose between only the 20 GB and 30 GB 
hard drive that the promotion allows, even though other processors and other hard drives may be 
allowed by the general configuration rules. 

When you create a promotion for customizable products, you can define additional constraints 
beyond the constraints defined in Configurator. You can create additional constraints in the following 
ways:

■ “Changing the Cardinality of Components of Product Promotions” on page 82

■ “Constraining the Products Available for a Component of a Product Promotion” on page 83

■ “Constraining the Attributes Available for a Product in a Product Promotion” on page 83

Changing the Cardinality of Components of Product 
Promotions
You can change the cardinality of a component of a customizable product used in product promotions. 
For example, the product promotion can allow the user to select a smaller number of one component 
than the configurator constraints allow. 

To change the cardinality of a component of a product promotion

1 Navigate to the Administration - Product screen > Product Promotions view. 

2 In the Product Promotions list, select the desired promotion. 

3 Click the Products view tab.
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4 In the Products link bar, click Components.

5 In the Components list, in Min or Max field for the component, enter the new cardinality 
constraints. 

The new Min and Max values have to fall within the cardinality constraints defined in the 
Customizable product definition, which are displayed in the Lower Limit and Upper Limit fields.

Constraining the Products Available for a Component of 
a Product Promotion
By default, a component of a customizable product in a product promotion has the products available 
that are defined in Configurator. However, you can modify the products that are available for the 
component so that the promotion offers only a subset of the products defined in Configurator. 

For example, as defined in Configurator, a computer may be available with five different monitors. 
For the promotion, you may want to offer only two of those monitors. 

To change the products available as a component of a product promotion

1 Navigate to the Administration - Product screen > Product Promotions view. 

2 In the Product Promotions list, select the desired promotion. 

3 Click the Products view tab.

4 In the Products list, click the Product Name field of the customizable product. 

The structure of that product is displayed. 

5 In the Relationships list, select the Component you want to change. 

6 In the Relationship Domain list, click Modify.

All the products in the Relationship Domain list are deleted. 

7 In the Relationship Domain list, click Add Item, and in the Domain Product field, select a product. 

8 Repeat Step 7 until you have added all the products that should be available for that component 
in the promotion. 

Constraining the Attributes Available for a Product in a 
Product Promotion
If a product promotion includes a product with attributes, you can constrain the domain of values 
allowed for an attribute. For example, if a shirt comes in ten different colors, the promotion can be 
available for all the colors except red and blue. 

You can create an exclude rule and list the attributes you do not want to make available, or you can 
create an include rule and list the attributes you do want to make available. 
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To constrain the attribute domain for a product promotion

1 Navigate to the Administration - Product screen > Product Promotions view. 

2 In the Product Promotions list, select the desired promotion. 

3 Click the Products view tab.

4 In the Products list, click the Product Name field of the customizable product. 

The structure of that product is displayed. 

5 Click the Attributes view tab. 

6 In the Attributes list, go to the Condition field for the attribute whose domain you want to 
constrain, and select Exclude to create an exclude rule or select Include to create an include rule.

7 In the Values list:

a To create an exclude rule, add records for all the values of the attribute that you do not want to 
make available within the promotion. 

b To create an include, add records for all the values of the attribute that you do want to make 
available within the promotion. 

Activating Workflows for Product Promotion
Product promotions are based on Siebel Workflows. You must activate these workflows before using 
the product. For information about activating workflows, see Siebel Business Process Designer 
Administration Guide. 

The following is a list of the workflows you need to activate:

■ ISS Promotion Agreement Covered Assets Subprocess

■ ISS Promotion Agreement Management Subprocess 

■ ISS Promotion Commitment Compliance Check Subprocess

■ ISS Promotion Create Agreement Details 

■ ISS Promotion Disconnect Integration Subprocess 

■ ISS Promotion Disconnect Process 

■ ISS Promotion Disconnect Process - for Verify 

■ ISS Promotion Edit Integration Subprocess 

■ ISS Promotion Recommendation Subprocess 

■ ISS Promotion Upgrade Process 

■ ISS Promotion Verify Subprocess 
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9 Creating Discount Matrices
This chapter covers discount matrices and includes the following sections: 

■ “About Discount Matrices” on page 85

■ “About Discount Matrix Dimensions” on page 86

■ “About Discount Matrix Types” on page 87

■ “Defining Discount Matrices” on page 90

■ “Entering Discount Matrix Details” on page 91

■ “About Configuring Discount Matrices” on page 92

About Discount Matrices
In many industries, prices and price adjustments often depend on both the product that is being sold 
and other information relevant to the sale. Often, customer and market conditions affect the price 
for which a product is sold.

Discount matrices allow you to tailor prices and adjustments to specific customer and market 
segments. They allow you to create and manage prices and adjustments for products in conjunction 
with other customer and market factors. The discount matrix administrative framework allows pricing 
administrators to logically group factors that result in a price or adjustment, working in the Siebel 
client without changing the Siebel repository.

For example, a company that sells laptop computers can create a discount matrix that allows it to 
charge a different price for laptops based on customer account type and sales region. In this 
example, customer account type, product, and sales region are the criteria for the price or discount. 
Therefore, the columns of the matrix would be Product, Account Type, Sales Region, Adjustment 
Type, Adjustment Amount, and a few additional columns that will be covered later in this chapter. 
Each row of the matrix defines the price or discount that will be applied when a given product is sold 
to a given account type in a given sales region, as shown in Table 4.

Table 4. An Example of a Matrix Defining Discounts

Product
Account 
Type Sales Region

Adjustment 
Type

Adjustment 
Amount

Laptop 2000 Platinum Europe % Discount 10

Laptop 2000 Gold Europe % Discount 5

Laptop 2000 Platinum Asia % Discount 11

Laptop 2000 Gold Asia % Discount 6
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Discount matrices allow you to maintain all of this critical pricing information in a single matrix, 
instead of dispersing it across numerous Siebel views.

Discount matrices are recommended in cases where: 

■ There is a high volume of prices and adjustments. 

■ The criteria for prices and adjustments are known ahead of time and do not change frequently.

Because prices and adjustments are frequently stored in disparate systems, discount matrices:

■ Support integration with SAP condition tables. 

■ Can be loaded using Enterprise Integration Manager (EIM) or Enterprise Application Integration 
(EAI) integration objects. 

■ Can be integrated with legacy systems using the Siebel Universal Application Network (UAN) and 
other XML-based integration technologies.

About Discount Matrix Dimensions
A discount matrix is a logical grouping of prices or adjustments that apply when specific combinations 
of criteria for prices or adjustments are met. For example, a discount matrix might contain all the 
adjustments for products when sold to specific account types, or all the adjustments for products 
when sold in specific regions.

Before you create discount matrices, you must determine the criteria for the prices or adjustments, 
based on your company's business model. After identifying criteria, you may begin creating the 
discount matrix. The criteria for the prices or adjustments will be the unique dimensions (or columns) 
of the discount matrix.

Along with the criteria dimensions, your discount matrix will include other dimensions. To continue 
the example, assume your company provides different discounts for each product based on the 
account type it is sold to and the region where it is sold. It would use the following dimensions:

■ Criteria Dimensions. These are the fields that uniquely identify the adjustment. In the 
example, these dimensions would be Product, Account Type, and Region. For each record, all of 
the criteria dimensions must be populated.

■ Calculation Dimensions. These fields allow administrators to enter various adjustments for the 
unique combinations of the discount criteria across various effective dates. These fields include 
Adjustment Type, Adjustment Amount, Currency Code, Effective Start Date, and Effective End 
Date.

■ Result Dimensions. These fields allow administrators to associate other information to the 
adjustment record that may be needed in the quote, order, or agreement later in the pricing 
procedure, or by back-end systems. These fields include Volume Discount Schedule, Attribute 
Adjustment Matrix, Pricing Procedure, Aggregate Discount, and Accounting Code.

The discount details list will include the criteria dimensions that were selected when you created the 
discount matrix, as well as the default calculation and result dimensions. Each set of dimensions is 
configurable and extensible.
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About Discount Matrix Types
The following sections describes the three types of discount matrices, and the criteria, calculation, 
and result dimensions that are available for each type:

■ “Product-Based Adjustment Discount Matrices” on page 87

■ “Entitlement-Based Adjustment Discount Matrices” on page 88

■ “Training-Based Adjustment Discount Matrices” on page 89

The fields that are available by default are the fields that are most commonly used with each type 
of adjustment. If your business model demands different criteria dimensions, each set is configurable 
and extensible, as described in “About Configuring Discount Matrices” on page 92.

Product-Based Adjustment Discount Matrices
Product-Based Adjustment Discount Matrices allow administrators to define adjustments based on 
product, customer, and market information. 

By default, the administrator can choose from the following dimensions:

■ Criteria dimensions to identify product:

■ Product

■ Parent Product

■ Root Product

■ Product Line

■ Product Class

■ Price Type

■ Criteria dimensions to identify customer:

■ Account

■ Account Type

■ Criteria dimensions to identify market:

■ Region

■ Sales Organization

■ Division Code

■ Distribution Channel

■ Dimensions to identify transaction:

■ Action

■ Approval Status

■ Calculation dimensions:
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■ Adjustment Type

■ Adjustment Amount

■ Currency Code

■ Effective Start Date

■ Effective End Date

■ Result dimensions:

■ Volume discount

■ Attribute Adjustment

■ Pricing Procedure

■ Aggregate Discount Sequence

■ Accounting Code

Entitlement-Based Adjustment Discount Matrices
Entitlement-Based Adjustment Discount Matrices allow administrators to define adjustments based 
on product, entitlement, and transactional information. 

By default, the administrator can choose from the following criteria dimensions:

■ Criteria dimensions to identify product:

■ Product

■ Parent Product

■ Root Product

■ Product Line

■ Price Type

■ Criteria dimensions to identify transaction:

■ Entitlement

■ Action

■ Qty from

■ Qty to

■ Reason Code

■ Calculation dimensions:

■ Adjustment Type

■ Adjustment Amount

■ Currency Code

■ Effective Start Date
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■ Effective End Date

■ Result dimensions:

■ Volume discount

■ Attribute Adjustment

■ Pricing Procedure

■ Aggregate Discount Sequence

■ Accounting Code

Training-Based Adjustment Discount Matrices
Training-Based Adjustment Discount Matrices allow administrators to define adjustments based on 
account, transaction, and training event information.

By default, the administrator can choose from the following dimensions:

■ Criteria dimensions to identify training:

■ Training Course

■ Event

■ Event Type

■ Event Location

■ Price Type

■ Criteria dimensions to identify customer:

■ Account

■ Contact

■ Criteria dimensions to identify transaction:

■ Action

■ Reason Code

■ Approval Status

■ Calculation dimensions:

■ Adjustment Type

■ Adjustment Amount

■ Currency Code

■ Effective Start Date

■ Effective End Date

■ Result dimensions:

■ Volume discount
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■ Attribute Adjustment

■ Pricing Procedure

■ Aggregate Discount Sequence

■ Accounting Code

Defining Discount Matrices
When you create a discount matrix, you specify what type of discount matrix it is, and which criteria 
dimensions will be shown in the Discount Details list applet. 

To define a discount matrix

1 Navigate to the Administration - Pricing screen > Discount Matrices View. 

2 Add a new record to the Discount Matrices list and complete the necessary fields, as described 
in the following table. 

3 In the Discount Criteria list, add records for all the criteria dimensions that you want exposed in 
the discount matrix. 

The criteria dimensions that you can add depend on the value selected in the Discount Matrix 
Type field in Step 2.

4 After all the necessary criteria dimensions are added, click Complete Definition in the Discount 
Matrix list applet. 

Clicking this button freezes the definition of the discount matrix. After this step, you cannot 
change the discount matrix type or the criteria dimensions.

Field Comments

Name Enter a name for the discount matrix. 

Status This field displays the status of the discount matrix. When you 
click the Complete Definition button, the value changes from In 
Progress to Active. You cannot enter any discount details until the 
status is Active.

Discount Matrix Type Select one of the discount matrix types. The options are: 

■ Product-Based Adjustment. For more information, see 
“Product-Based Adjustment Discount Matrices” on page 87. 

■ Entitlement-Based Adjustment. For more information, see 
“Entitlement-Based Adjustment Discount Matrices” on page 88. 

■ Training-Based Adjustment. For more information, see 
“Training-Based Adjustment Discount Matrices” on page 89. 
Pricing Administration Guide Version 7.8, Rev. B90 



Creating Discount Matrices ■ Entering Discount Matrix Details
5 In the Discount Matrix list, click the name of the new discount matrix. 

The Discount Details list appears. It includes the criteria dimensions that you selected in Step 3 
and the default calculation and result dimensions. 

Entering Discount Matrix Details
After a discount matrix has been defined, you enter details of each price adjustment in the matrix. 

You must make entries in all the criteria dimension columns that have been defined. 

Enter effective dates in the same way as price lists, as described in “Giving a Product Multiple Prices 
with Different Effective Dates” on page 30. If you create records with overlapping effective dates, the 
product resolves the issues in the same way as price lists, as described in “About Effective Dates for 
Pricing Line Items” on page 27. 

When you enter Discount Detail records, you should enter a value in the Currency Code field if the 
Adjustment Type is Price Override, Discount Amount, or Markup Amount. By default, the Currency 
Code field value is the system currency.

To enter details in a discount matrix

1 Navigate to the Administration - Pricing screen > Discount Matrices View. 

2 In the Discount Matrices list, click the name of the matrix to which you want to add details. 

The dimensions in the Discount Details list applet are as follows:

■ The criteria dimensions specified on the discount matrix

■ The default calculation dimensions

■ The default result dimensions

3 In the Discount Details list, add a new record for each combination of criteria dimension values 
for which you want to define a price adjustment. 

In each record, you must enter values for all the criteria dimensions. 

Discount Matrix Integration
You can populate discount matrices with data from other systems, load them using EIM, and 
systematically update them using EAI or UAN. They are designed for integration with SAP condition 
tables. 

Loading and Updating Data from Other Applications
Siebel Enterprise Integration Manager (EIM) tables are available for each discount matrix table. 

To initially load data from another application, use EIM. For more information, see Siebel Enterprise 
Integration Manager Administration Guide. 
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Integration objects are available for each discount matrix table to enable integration using EAI and 
Universal Application Network (UAN). 

For systematic incremental updates, use EAI. For more information, see Overview: Siebel Enterprise 
Application Integration. 

For real-time data integration, the best practice is to use UAN. For more information, see the 
documentation provided with the Universal Application Network product that your organization 
purchased. 

Integration with SAP Condition Tables
The following SAP-specific dimensions columns are available for the product-based and entitlement-
based discount matrix types: 

■ Sales Organization Code

■ Division Code

■ Distribution Channel Code

The following SAP-specific fields are available in the Discount Matrix table (S_ADJ_GROUP): 

■ SAP Condition Type: SAP_COND_NAME

■ SAP Condition Table: SAP_TABLE_NAME

About Configuring Discount Matrices
The criteria, calculation, and result dimensions that are available for each discount matrix type are 
the ones that are most commonly used for that type of adjustment. However, your business model 
may require you to use additional dimensions that are not available by default.

To make these additional dimensions available, you can configure the application with Siebel Tools. 
For more information about Siebel Tools, see Using Siebel Tools.

To make additional dimensions available, you must understand the tables used to store the discount 
matrix data, which are shown in Figure 13. 

Discount matrix fields are stored in the following tables:

Figure 13. Discount Matrix Data Tables
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■ The Discount Matrix Name, Status, and Type are stored in the S_ADJ_GROUP table.

■ The criteria dimensions that the administrator has selected for the discount matrix are stored in 
the S_ADJ_GRP_COL table.

■ The discount details are stored in the following tables:

■ S_STDPROD_PMTRX (if the discount matrix type is Product-Based Adjustment)

■ S_STDENTL_PMTRX (if the discount matrix type is Entitlement-Based Adjustment)

■ S_STDTRNG_PMTRX (if the discount matrix type is Training-Based Adjustment)

To extend the available criteria, calculation, or result dimensions, you may add columns to any or all 
of these tables.

The following topics include instructions for configuring discount matrices: 

■ “Adding New Dimensions to Existing Discount Matrix Types” on page 93

■ “Creating New Discount Matrix Types for Custom Tables” on page 94

Adding New Dimensions to Existing Discount Matrix 
Types
NOTE: This section includes instructions that assume you are familiar with Siebel Tools. For more 
information, see Using Siebel Tools. These instructions also assume that you have made the 
appropriate data model extensions to the appropriate discount details table.

To add new dimensions to existing discount matrix types, use Siebel Tools as follows: 

■ In the Object Explorer, select the Business Component object.

■ Query to find the appropriate discount matrix Business Component (Product-Based Adjustment, 
Entitlement-Based Adjustment, or Training-Based Adjustment).

■ Add a new Business Component field based on the newly created extension column.

■ In the Object Explorer, select the Business Component User Prop object under the Business 
Component object. 

■ Add the new field name to the appropriate user property. 

NOTE: If the field will be used as a criteria dimension, add it to the Dimension Columns user 
property. If the field will be used as a calculation or result dimension, add it to the Default 
Columns user property. The appropriate syntax for the user properties is as follows: 
#FieldName#FieldName#FieldName#

■ Compile the business component changes to the SRF.

■ In the Object Explorer, select the Applet object. 

■ Query to find the appropriate discount details applet (Product-Based Adjustment list applet, 
Entitlement-Based Adjustment list applet, or Training-Based Adjustment list applet).

■ Create a new list column for the new field.
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■ Bind the list column to the Edit List Web template. 

■ Compile the applet changes to the SRF.

If the new field was added as a criteria dimension, it should now appear as a selection in the discount 
criteria pick applet for the appropriate discount matrix type. If the new field was added as a 
calculation or result dimension, it should now appear in the Discount Details applet when the user 
drills down on a discount matrix with the appropriate discount matrix type.

Creating New Discount Matrix Types for Custom Tables
NOTE: This section includes instructions that assume you are familiar with Siebel Tools. For more 
information, see Using Siebel Tools. 

To create a new discount matrix based on a custom table, do the following in Siebel Tools: 

■ Create a Business Component on top of the custom table:

■ Create the Default Columns user property:

❏ Name: Default Columns

❏ Value: <buscomp field names separated by # sign>

This user property controls which columns always display in the Discount Matrix Details List 
applet for the new Discount Matrix Type.

■ Create the Dimension Columns user property:

■ Name: Dimension Columns

■ Value: <buscomp field names separated by # sign>

This user property controls which criteria dimensions will appear in the discount criteria pick 
applet for the new Discount Matrix Type.

■ Add the new matrix type to the Discount Matrix Type LOV:

■ Type: ADJ_GROUP_TYPE

■ Display Value: <the new matrix type>

■ LIC: <the new matrix type>

■ Modify the Discount Matrix Business Component as follows:

■ Add the following Business Component User Property

■ Name: <Display Value of New Matrix Type from LOV>

■ Value: Adjustment Group#New Matrix BC Name#

This user property inserts the Business Object and Business Component values into the 
appropriate fields on the discount matrix header when the discount matrix type is selected.

■ Create a new Discount Matrix Details list applet for the new Business Component:

■ Name: <any name>
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■ Business Component: <new matrix buscomp>

■ Class: CSSSWEFrameListPSPAdjRule

■ List Columns: <all fields from the new matrix Business Component that could possibly appear 
as criteria or default dimensions>

NOTE: Specialized applet class will only show dimensions defined and default columns from the 
Business Component user property.

■ Create a new Discount Matrix Details view as follows:

■ Name: <any name>

■ Business Object: Adjustment Group

■ View Web Template Items:

❏ Adjustment Group form applet

❏ New Applet from Above

■ Modify the Adjustment Group list applet as follows:

■ Create a New Drilldown Object:

❏ Name: <new matrix type>

❏ Hyperlink Field: Name

❏ Destination View: <name of new details view>

■ Create a Dynamic Drilldown Destination for the new Drilldown Object:

❏ Name: <new matrix type>

❏ Field: Type - LIC

❏ Value: <new matrix type LIC value from LOV>

❏ Destination Drilldown Object: <name of drilldown object created in previous step>

■ Add the new view to the Administration - Pricing screen:

■ Name: <name of the new view>

■ View: <name of the new view>

■ Type: Details view

■ Parent Category: Adjustment Group Details
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10 Creating Attribute Adjustments
This chapter describes how to create attribute pricing adjustments and includes the following 
sections: 

■ “About Attribute Pricing” on page 97

■ “About the Attribute Adjustments View” on page 98

■ “Attribute Adjustments Design” on page 98

■ “Single and Multiple Type Attribute Adjustments” on page 103

■ “Using Variable Maps in Attribute Adjustments” on page 100

■ “How Attribute Adjustments Apply Rules” on page 101

■ “Process of Creating an Attribute Adjustment” on page 108

■ “Example of Creating an Attribute Adjustment Based on Product Attributes” on page 114

■ “Example of Creating an Attribute Adjustment with Nonproduct Attributes” on page 118

■ “Best Practices for Creating Attribute Adjustments” on page 125

■ “How the Pricing Procedure Uses Attribute Adjustments” on page 126

■ “Upgrade Considerations for Attribute Adjustments” on page 126

About Attribute Pricing
Users may customize products by selecting attributes of the product, such as size and color. 
Attribute-based pricing adjusts the price based on the attributes chosen, and displays the adjusted 
price in the quote or order. 

For example, a sales agent might create a quote for a car and select the leather upholstery attribute. 
After selecting the leather upholstery attribute, the agent sees the net price increase by $1000, the 
cost of this attribute. A home shopper using a Web site might select the same car model, but select 
the plush interior attribute. This shopper sees the net price increase by $500, the cost of this 
attribute. These two different users might be using different price lists, so their attribute adjustments 
might be different. 

In earlier versions, you used attribute-based pricing only to define pricing based on attributes of a 
product. In version 7.8, the Attribute Adjustments view extends and generalizes the earlier attribute-
based pricing feature, so it can also be used for defining price adjustments based on other criteria 
(such as Status of an Account, Age of an Asset, and so on) in addition to product attributes.

To create attribute adjustments, first you define a list of attributes that affect and the adjustments 
needed for each. Then, you associate the attribute adjustments with the product in a price list. 
Because the product can be in multiple price lists, you can create multiple attribute adjustments for 
the product that are used in different price lists. 
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This chapter assumes that you have general background knowledge about attribute-based products, 
classes, and attribute values. For more information, see Product Administration Guide. This chapter 
also assumes that you have general background knowledge about how the PSP engine works. For 
more information, see Siebel Order Management Infrastructure Guide. 

NOTE: If you use attribute-based pricing with other types of price adjustments, the final price 
depends on the order in which Siebel Pricer applies the pricing adjustments. For more information, 
see “About the Processing Order of Price Adjustments” on page 13. 

Attribute Adjustments Design
To plan attribute adjustments, begin by identifying the products, the product attributes that affect 
prices, and any other attributes (such as Status of an Account) for which you need to define price 
adjustments.

Determine which attributes you want to use for pricing. Be aware that you can use nonproduct 
attributes, such as Status of an Account, to set up price adjustments. Some product attributes that 
are necessary for customization have no effect on pricing. For example, some products may have a 
color attribute, because the user can select the color, but the color does not affect the price. You 
would not use the color attribute in the attribute adjustments table.

About the Attribute Adjustments View
You use the Attribute Adjustments view to create a list of attribute adjustments, which can be based 
on both product attributes and nonproduct attributes. 

For example, Table 5 shows a simple list of attribute adjustments that adjust shirt prices based on 
size and color of the shirt. Any shirt ordered that is XL size and not colored red is marked up by 10%. 
Any shirt that is L size and not colored white is marked up by 8%. Any shirt that is M size and not 
colored blue is marked up by 10%. 

Table 5. An Example of Attribute Adjustments

Size Color
Adjustment 
Type

Adjustment 
Amount

= XL <> Red % Markup 10

= L <> White % Markup 8

= M <> Blue % Markup 5
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Table 6 shows a simple example that adjusts shirt prices based on the size of the shirt and the status 
of the account. If the shirt ordered is XL size and the customer is a Gold account, there is a 10% 
discount. If the shirt ordered is L size and the customer is a Silver account, there is a 5% discount. 
If the shirt ordered is M size and the customer is a Bronze account, there is a 3% discount. 

Dimensions in Attribute Adjustments 
The columns of these tables are called the dimensions of the attribute adjustment. The examples 
show that attribute adjustments have two types of dimensions: 

■ Conditions. These dimensions affect the price of the product and determine whether the rule is 
applied. In the example, the condition dimensions are the columns Size, Color, and Status. 
Conditions can be based on any text, number, or date field in any Siebel business object, but if 
a rule uses a comparison operator such as < or >, its condition must be a number or date field 
(failing which the results will be unpredictable). 

■ Results. These dimensions determine the result when the rule is applied. In the example, the 
results dimensions are the Adjustment Type and Adjustment Amount columns. 

You use the Attribute Adjustments > Dimensions view to specify these dimensions. 

Variable Maps in Attribute Adjustments
Variable maps are used to map the dimensions of attribute adjustments to fields in Siebel business 
objects. Every condition dimension of an attribute adjustment table has to be mapped to a variable 
map. Variable maps are provided for use with attribute adjustments. You can modify these variable 
maps or set up new variable maps. For information about working with variable maps, see Siebel 
Order Management Infrastructure Guide.

The variable maps are transparent to the pricing administrator who defines the price adjustments 
based on attributes. The order management administrator sets up all the appropriate variable maps 
for use in pricing.

Without configuration, the view to associate the variable maps with an attribute adjustment table is 
hidden. You can display the variable maps associated to an attribute adjustment table only by using 
the site map to navigate to the Administration - Pricing > Attribute Adjustments > Variable Maps 
view. For more information on how to use variable maps in attribute adjustments, see “Using Variable 
Maps in Attribute Adjustments” on page 100. 

Table 6. An Example of Attribute Adjustments

Size
Customer 
Status

Adjustment 
Type

Adjustment 
Amount

= XL = Gold % Discount 10

= L = Silver % Discount 5

= M = Bronze % Discount 3
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Rules in Attribute Adjustments
The Rules view contains a list of conditions and results similar to the samples shown in Table 5 and 
Table 6. 

You can enter rules in this view in two ways: 

■ Enter rules manually. Add a new record and enter the information for each rule manually. 

■ Generate rules. Click the Generate Rules button. The rules list is populated with records for 
every possible combination of condition dimensions and domains entered in the Dimensions view. 
You enter the results dimensions for each record. If you do not need all the combinations that 
are generated, you can edit or delete some of the generated records. 

You enter the list of rules in Attribute Adjustments > Rules view. 

Using Variable Maps in Attribute 
Adjustments
You use variable maps to map the dimensions of attribute adjustments to fields in Siebel business 
objects. For information about variable maps, see Siebel Order Management Infrastructure Guide. 

There are three types of variable maps: 

■ Context. This type maps the variable to header-level information—for example, to fields in the 
Order Header applet such as Account, Order Status, and so on. 

■ Row set. This type maps the variable to line item-level information—for example, to fields in the 
line items of an order such as Quantity, Product Line, Price Type, and so on. 

■ XA. This type maps the variable to the attribute names and values of a line item. 

For attribute pricing, you need only the standard variable maps that are provided with the product. 

The Siebel application provides standard variable maps for all of these variable map types. The 
variable maps that attribute adjustments use are declared in the Systems Preferences view as shown 
in Table 7. 

Table 7. Variable Maps for Attribute Pricing

System Preference Variable Value

PSP Pricing Var Map - Context Default Pricing Variable Map - Context

PSP Pricing Var Map - Row Set Default Pricing Variable Map - Row Set

PSP Pricing Var Map - XA Default Pricing Variable Map - XA
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While setting up an Attribute Adjustment table, the pricing administrators can associate the variable 
maps shown in Table 7 by clicking the Create Result Dimensions button. The three variable maps are 
created for the attribute adjustment in the Attribute Adjustments > Variable Maps view along with 
the two pricing results dimensions, Adjustment Type and Adjustment Amount. The system 
preferences, as shown in Table 7, are read and a record is inserted for each variable map type in the 
System Preferences view.

CAUTION: If the system preference value is either empty, nonexistent, or invalid, then that variable 
map record is not created. No error message appears. If a user has already created the variable map 
records, then the application does not overwrite them.

The use of variable maps for attribute adjustments is transparent to the pricing administrator. The 
Variable Maps view tab does not appear in the user interface, but you can still access it using the 
Site Map to navigate to Administration - Pricing > Attribute Adjustments > Variable Map.

You can set up variable maps in either of two ways. 

To set up variable maps for pricing adjustments by modifying system preferences

1 Navigate to the Administration - Application screen > System Preferences view. 

2 In the System Preferences list, query for:

PSP Pricing Var Map*

Three records appear, as detailed in Table 7. 

3 Set the appropriate variable map names in the System Preference Value field. 

4 Restart the server. 

New attribute adjustments created after the server is restarted use the new variable maps 
declared in system preferences. 

To set up variable maps for pricing adjustments by overwriting the variable maps in 
the Variable Map view

1 Navigate to the Administration - Pricing screen > Attribute Adjustments > Variable Map view. 

2 Modify variable maps by selecting different variable maps in the picklists. 

The first approach is a global level change, and any new attribute adjustment table created after the 
server is restarted uses the new variable maps. The second approach is a local level change, and 
only the attribute adjustment that is modified uses the new variable maps.

How Attribute Adjustments Apply Rules
When you set up attribute adjustments, a search specification template is dynamically generated 
based on the definition of the condition dimensions of the attribute adjustment.

The following properties of a condition dimension are important for generating the search 
specification template:
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■ Operator. This property specifies the type of comparison performed against the column during 
run time.

■ Sort Order. This property specifies the sorting priority of the columns in the search specification.

■ Sort Method. This property specifies ascending or descending ordering of the search 
specification. 

At run time, this search specification template, along with run-time contextual values, executes a 
lookup against the rules of the attribute adjustments, as defined in the Conditions view.

For example, shirts have two attributes that affect their price, color and size. You enter the condition 
dimensions shown in Table 8. 

Based on these dimensions, at run time, the application generates and caches the search 
specification:

[Matrix.Color] = {Row.Color} AND [Matrix.Collar] < {Row.Length}, Order by [Matrix.Color] Ascending, 
[Matrix.Collar] Descending

The notation [Matrix.<Column>] refers to a condition dimension of an attribute adjustment. 
{Row.<Var Name>} is a contextual value, generated at run time.

You also enter the rules shown in Table 9. 

In run time, when there are incoming transactions, the application uses the search specification 
template with the contextual values from the specific transaction to see which rule applies. For 
example: 

Table 8. Sample Condition Dimensions

Name Operator
Variable 
Map Data Type

Sort 
Order

Sort 
Method

Size < XA Number 2 Descending

Color = XA Text 1 Ascending

Table 9. Sample Rules

Sequence Color Size
Adjustment 
Type

Adjustment 
Amount

1 Red 15 % Discount 15

2 Blue 15 % Discount 15

3 Green 15 % Discount 15

4 Red 10 % Discount 25

5 Blue 10 % Discount 25

6 Green 10 % Discount 25
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■ If the transaction has Color =Red and Size = 11, the application generates the search 
specification [Matrix.Color] = “Red” AND [Matrix.Size] < 11. This search specification 
matches the rule for Color = Red and Size = 10, so the discount of 25% is applied to the 
transaction. 

■ If the transaction has Color =Red and Size = 16, the application generates the search 
specification [Matrix.Color] = “Red” AND [Matrix.Size] < 16. This search specification 
matches the rule for Color = Red and Size = 15, so the discount of 15% is applied to the 
transaction. 

■ If the transaction has Color =Red and Size = 8, the application generates the search specification 
[Matrix.Color] = “Red” AND [Matrix.Size] < 8. This search specification does not match any 
rule, so no discount is applied to the transaction. 

Single and Multiple Type Attribute 
Adjustments
After determining which attributes affect pricing, you must decide whether you need a single-
attribute or multiple-attribute pricing adjustment table. 

When you create an Attribute Adjustment record, you use the Type field to specify that it is a single-
condition or a multiple-condition adjustment as follows: 

■ Single condition. Use this type if the price adjustments are based on condition dimensions that 
apply in isolation from each other. For example, a product with the attributes Size and Color could 
have a price adjustment for each of these individual attributes and not for a combination of both. 
In this case, you should set up a single type attribute adjustment table. 

■ Multiple condition. Use this type if the combination of condition dimensions affect pricing—for 
example, if the product size and its color together determine the price adjustment. 

Single-condition attribute adjustments used for attribute pricing are relatively simple to create if you 
need them. For information, see “Process of Creating an Attribute Adjustment” on page 108. 

Before you begin creating multiple-condition attribute adjustments, you should decide on the 
following fields: 

■ Sort order. You must use this field to specify the order in which attributes (condition 
dimensions) are processed, because the order affects the adjusted price. For more information, 
see “Order of Conditions in Multiple-Condition Pricing Tables” on page 104. 

■ Allow any. You must decide whether to use this field to allow you to insert null value wildcards 
into the pricing table, so one record represents many values of an attribute (condition 
dimension). For more information, see “Using Wildcards in Attribute Adjustments” on page 105. 

■ Display error. You must decide whether to use this field to prevent the user from choosing an 
invalid combination of condition dimensions. For more information, see “Preventing Users from 
Selecting Invalid Combinations of Attributes” on page 106. 
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Order of Conditions in Multiple-Condition Pricing Tables
If you set up a multiple type Attribute Adjustment record, then you must consider the processing 
order of the attributes (condition dimensions). 

You can use the Sort Order and Sort Method fields of the Dimensions record to specify the order in 
which attributes (condition dimensions) are processed. The system assigns the dimension with the 
least numerical sort order value the highest processing priority while performing a lookup against 
the rules (the Conditions view). The sort method determines whether the values in the dimension 
are processed in ascending or descending order. 

Processing order is important because:

■ The order of attributes (condition dimensions) affects the lookup of the price adjustment.

■ If there are multiple matches of rules (Conditions view), the order of the attributes (condition 
dimensions) determines which rule is applied.

■ The order of attributes (condition dimensions) affects processing speed. 

Order of Conditions and Pricing Calculations
In a single-type attribute adjustment, each attribute (condition dimension) contributes to the price 
adjustment in isolation from the rest of the other attributes (condition dimensions). This means that 
the sort order of the attributes does not impact the price in any way.

Assume you are using a single-type attribute adjustment for attribute pricing. A product has a list 
price of $100 with a 50 percent markup on the large size and a $10 markup for the color gold. The 
system calculates the price of the product by considering the each attribute adjustment in isolation, 
so the price of the product is $100 + (50% of $100 for the size large) + $10 (markup for gold color) 
= $160. The system does not consider the sequence in which the adjustments need to be applied.

Order of Conditions and Precedence
In addition, the selection order also determines the relative importance of attributes in case of ties.

If two or more rules in an attribute adjustment are both valid, the rule with the more explicitly 
defined attribute values (not blanks) in the left-most columns takes precedence. For example, if 
there are four fields for each record, and the first two fields of both records match what has been 
selected, the engine returns the record that matches the first condition going from left to right; the 
dimension with least numerical sort order value is processed first. 

Order of Conditions and Processing Speed
The left-most condition in each rule has the greatest impact on processing speed. If it does not make 
a difference in the final price, to speed processing, follow these general rules: 

■ Give the lowest sort orders to conditions with the most enumerated values. 

■ Do not give a condition a low sort order if it is flagged as Allow Any. 
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■ Do not give conditions a low sort order if you allow wildcards in the condition.

CAUTION: Pricing administrators are responsible for correctly setting up the sort orders of the 
dimensions. Any duplicate or blank sort order values for condition dimensions with the Allow Any flag 
turned on can give unpredictable results.

Using Wildcards in Attribute Adjustments 
Selecting the Allow Any check box in a Dimension record lets you enter a blank instead of entering 
every different domain value for that dimension. This blank is called a null value wildcard. It 
represents all possible values in the given attribute’s domain. 

For example, you sell T-shirts that come in the colors white, gray, and red, and also come in the sizes 
small, medium, large, and extra-large, with the pricing shown in Table 10. 

There is no markup for any color except red. The red T-shirts are marked up $2, except for the extra-
large size, which is marked up $5. Instead of the long list shown in Table 10, you can represent this 
with the short list shown in Table 11. 

In Table 11, the first row represents all the colors except red, and the second row represents all the 
sizes of red except extra-large. 

The null value wildcard can reduce the work of creating a large attribute pricing table, but be careful 
to avoid the problems that it can create:

■ If you are using the attribute adjustment for attribute pricing, you may mistakenly enter 
wildcards that allow the user to choose invalid combinations of products. 

Table 10. Attribute Pricing for Each Combination of Attributes

Color Size
Adjustment 
Type

Adjustment 
Amount

Red Small Markup Amount $2.00

Red Medium Markup Amount $2.00

Red Large Markup Amount $2.00

Red Extra-Large Markup Amount $5.00

Table 11. Attribute Pricing Using a Null Wildcard

Color Size
Adjustment 
Type

Adjustment 
Amount

Red Markup Amount $2.00

Red Extra Large Markup Amount $5.00
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■ You may also mistakenly create several rules that represent the same combination of condition 
dimensions. Make sure that every combination of condition tables is unique.

If you do create several rules that represent the same combination of condition dimensions, the 
application uses the rule with the most exact matches (not blanks) in the condition dimensions as 
the highest priority for processing. Priority is specified using the Sort Order field of the dimension. 

Avoid using null value wildcards in the columns with the highest priority for processing. This 
increases the processing task for Siebel Pricer and causes the processing to take longer. 

NOTE: If you use wildcards, it is especially important to test your results after creating the attribute 
pricing table. 

Preventing Users from Selecting Invalid Combinations 
of Attributes
You can select the Display Error check box in the Attribute Adjustment record to prevent users from 
selecting combinations of attributes that are not valid. Use this field judiciously, and not as a 
mechanism to enforce product configuration or other business rules. Attribute adjustments are 
primarily meant for pricing.

For example, if a product's large version comes in every color except green, you could use this option 
to display an error message if the user chooses both large and green.

If you select this option, you must create a Rule record in the attribute adjustment representing 
every valid combination of attributes, even if the combination has zero effect on pricing. The 
application displays an error message if the user selects a combination of attributes that is not 
represented by a rule. For example, even if gold is the only color that requires a price markup, you 
will have to add Rule records for all the colors that the user can select. If there are 100 combinations 
of other attributes, and 10 possible colors, you may have to create 1000 Rule records, even if only 
one color affects pricing (though you may be able to reduce the number using wildcards). 

NOTE: If your deployment does not use the Display Error option, you can remove the steps in the 
Dynamic Pricing Procedure that enforce the validity of the attribute combinations. These are the 
Invalid Combination Decision step and the Display Invalid Combination Error step. Removing these 
steps reduces processing time for the pricing. For more information about this pricing procedure, see 
“Pricing Procedures and Workflow References” on page 155. 

To decide whether to use this option, you should weigh its benefits against its costs. There is a benefit 
to preventing users from choosing invalid combinations of attributes. However, the added 
administrative cost is high because there are many combinations of attributes that do not affect 
pricing. 

If you select the Display Error option, you must create a pricing adjustment item representing every 
valid combination of attribute values, but you must not create a pricing adjustment item for any 
invalid combination of attribute values. To create the correct pricing adjustment items, use one of 
the following two features of Siebel Pricer: 
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■ Wildcards. If you select the Allow Any check box, you can create adjustment items with null 
value wildcards that accommodate many dimension domain combinations, so you can use fewer 
adjustment items to represent all valid combinations. Wildcards may allow you to create rules 
representing every valid combination of attributes without entering a separate rule for each 
combination of attributes. For more information, see “Using Wildcards in Attribute Adjustments” 
on page 105. 

■ Generate Rules button in the Conditions view. Use this button to automatically generate a 
full set of records for all possible combinations of values of attributes that affect pricing. You can 
delete the records that do not impact pricing and those that represent an invalid combination of 
attributes. After Rule records are generated, you must enter the adjustments. If any 
combinations of attributes are invalid, you must delete those rules. For more information, see 
“Adding Attribute Adjustment Conditions” on page 113.

NOTE: If you select the Display Error option, make sure that the default attributes for the product 
are a valid attribute pricing combination. If it is not a valid combination, your Siebel application will 
not add the product when users click the Add Item button to add this product to a quote. Users will 
think that the Add Item button is not working. 

It may be easier to use the Adjustment Item Generator to generate all possible attribute value 
combinations, each in its own adjustment item, than to use null value wildcards. To help make the 
decision, consider the following: 

■ If you use the Adjustment Item Generator, you must do the extra administrative work of entering 
adjustment types and adjustment values in each record. This could involve much more work than 
using null value wildcards, if many combinations of attributes have the same price adjustment. 

■ If you use null value wildcards, you may have a difficult conceptual task of analyzing the 
combinations of attributes to decide where you can use wildcards. 

■ If you choose the Display Error option, then you cannot use a null value wildcard for an attribute 
if that attribute is not always available. For example, if the extra-large size is available in all 
colors except gray, then you cannot create an adjustment item with the null value wildcard for 
both color and size (as in the previous example). If you create this adjustment value, an error 
message is not generated when the user chooses extra-large and gray. 

Zero-Effect Adjustment Items
If you choose the Display Error option, you must create Rule records representing every valid 
combination of attributes, even if they have no effect on pricing. Even if you do not choose this 
option, you may want to create zero-effect rule records for the following reasons: 

■ To make the attribute adjustments easier to maintain. If a pricing attribute is not represented in 
the Rules list, it can be difficult or impossible to add it later and integrate it with the rules already 
in the list. 

■ To create a comprehensive, well-structured set of rules. If a Rules list has a structured place for 
everything, it can be easier to work with, even if it has items with zero effect. 
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Process of Creating an Attribute 
Adjustment
To create attribute adjustments, perform the following tasks: 

1 “Adding an Attribute Adjustment Record” on page 108

2 “Specifying Attribute Adjustment Dimensions and Domains” on page 109

3 “Adding Attribute Adjustment Conditions” on page 113

4 “Associating Attribute Adjustments with Price List Line Items” on page 113

NOTE: Before you can perform this process, you must set up the appropriate variable maps, as 
described in “Using Variable Maps in Attribute Adjustments” on page 100.

Adding an Attribute Adjustment Record
The Attribute Adjustment record holds general information about the attribute adjustment. This task 
is a step in “Process of Creating an Attribute Adjustment” on page 108. 

To create an attribute adjustment record

1 Navigate to the Administration - Pricing screen > Attribute Adjustments view. 

2 In the Attribute Adjustments list, add a new record and complete the necessary fields. 

Some fields are described in the following table. 

Field Comments

Name Enter a name for the attribute adjustment. 

Class If product attributes affect the price, select the class where these 
attributes are defined. 

NOTE: If you are setting up attribute adjustments based on 
nonproduct attributes such as Account Type, Region, and so on, 
leave this field blank. 

Type Select the type of the adjustment. Options are: 

■ Single. Each attribute (condition dimension) affects the price 
in isolation from the others. 

■ Multiple. The price adjustment depends on a combination of 
attributes (condition dimensions). 

For more information, see “Single and Multiple Type Attribute 
Adjustments” on page 103. 
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Specifying Attribute Adjustment Dimensions and 
Domains
You must enter the dimensions of the attribute adjustment, which are used as the columns of the 
rules tables. There are two types of dimensions: 

■ Condition dimensions. These are the dimensions that affect the price of a product. They 
determine the conditions under which the adjustment is applied. Create one condition dimension 
for each attribute that impacts the price of a product. 

■ Result dimensions. These are the outputs of the attribute adjustment tables. When you click 
the Create Result Dimensions button, the application automatically creates the two result 
dimensions, Adjustment Type and Adjustment Amount. 

This task is a step in “Process of Creating an Attribute Adjustment” on page 108. 

Optionally, if you want to automatically generate rule records, you can enter the domain of each 
dimension, which is all the possible values of that dimension. 

Dimension domains can have multiple sources: 

■ List of values (LOV). Enter the LOV Name.

■ Business component field values. Enter the Business Object, Business Component, Field, and 
Search Specification.

■ User defined. Manually enter all the values in the domain. 

■ Attribute values. Enter the name of the attribute. 

When you define domains, you also specify whether values other than those included in the domain 
can be added to the rules list. 

Display Error Select this check box if you want the application to display an 
error message when a user selects an invalid combination of 
attributes for the attribute pricing. The combination is considered 
invalid if it is not included in the list of rules. 

For more information about how to use this field, see “Preventing 
Users from Selecting Invalid Combinations of Attributes” on 
page 106. 

NOTE: This field is used only for attribute pricing. Do not select 
it if you are using attribute adjustment for some advanced use 
instead of for attribute pricing. 

Effective From and 
Effective To

Enter the start date and end date of the time period when this 
attribute adjustment is active. 

Field Comments
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To enter dimensions and their domains

1 Navigate to the Administration - Pricing screen > Attribute Adjustments view. 

2 In the Attribute Adjustments list, select the attribute adjustment whose dimensions you are 
specifying. 

3 In the More Info view, click Create Result Dimensions. 

4 Click the Dimensions view tab. 

5 Add a record for each dimension that affects the price and complete the necessary fields, as 
described in the following table. 

NOTE: The Adjustment Amount and Adjustment Type dimensions were added automatically 
when you clicked Create Result Dimensions. 

Field Comments

Dimension Type Select the type of the dimension. The options are Condition and 
Result, as described in “Dimensions in Attribute Adjustments” on 
page 99.

Name Enter the name of the dimension to specify the column name in 
the Rules list. 

NOTE: The name of the dimension can be different from the field 
name it maps to. For example, the dimension Product Color can 
map to the product attribute Color.

Operator If this is a condition dimension, select the operator that you want 
to use to compare it with a value. 

For example, if you want to create the rule Size = XL, and if this 
record is the Size dimension, you must select the equal operator 
(=). 

For more information, see “How Attribute Adjustments Apply 
Rules” on page 101. 

Variable Map Type Use this field for condition dimensions only. Select the type of the 
variable map, which determines the hierarchical level (header, 
line item or XA) of the contextual variable: 

■ To map a dimension based on a field from Order Header, such 
as Order Status, use Context as the type. 

■ To map a dimension based on a Line Item such as Product 
Line, use Row as the type. 

■ To map dimensions based on product attributes, use XA as the 
type. 

For more information, see “Using Variable Maps in Attribute 
Adjustments” on page 100. 
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Variable Name For dimensions with Row or Context variable map type, select the 
name of the variable from the variable map to map the dimension 
to it. 

Do not use for dimensions that are mapped to product attributes 
(variable map type - XA). 

For more information, see “Using Variable Maps in Attribute 
Adjustments” on page 100. 

Data Type Select the data type of this dimension. 

Domain Type Select the source of the domain for a dimension. The options are: 

■ Attribute. These are the values of an attribute that you want 
to use as the dimension domain. Any dimension that is 
associated with an XA variable map type automatically has 
Attribute as its domain type.

■ Business component. These are the values in a business 
component field that you want to use as the dimension 
domain. 

■ LOV. These are the values in a list of values that you want to 
use as the dimension domain. 

■ User defined. You will determine the dimension domain 
manually by adding new records to the Domain list. 

Bounded Select this check box to restrict the values used for this dimension 
in the rules. If you select this check box, only the values listed in 
the domain of this dimension can be used in rules. If you do not 
select the check box, any values can be used in rules. 

Allow Any Select this check box to allow any values to be entered for this 
dimension in rules. 

Business Object, Business 
Component, Field, Search 
Spec

This field applies only if you selected Business Component in the 
Domain Type field. To create the domain for the dimension, 
specify the business component field you must use along with the 
Business Object, Business Component, and a Search Spec. The 
Business Component has the field whose values are used for the 
domain. The Search Spec is used to limit which values from the 
field you want to use as the domain. After you enter values in 
these fields, click the Create Domain button to enter the values 
from the field in the Domain list.

NOTE: To avoid poor performance, be sure to enter a Search 
Spec or the system may take a long time to generate all the 
domain records. 

Field Comments
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6 If you selected User Defined in the Domain Type field, you must enter the domain for this 
dimension manually: 

a In the Dimensions list, select the record. 

b In the Domain list, add records and enter all possible values for the selected dimension. 

7 If you selected Attribute, Business Component or LOV in the Domain Type field, to generate 
values for domains, click Create Domain. 

CAUTION: If you change the source of the dimension by modifying the variable map type, the 
Domain Type field, or making modifications in some other way, you must click the Create Domain 
button to regenerate the domain, and you must modify the rules (Conditions view) that have been 
set up so that the old domain values for a dimension are no longer used.

Attribute If you want to base the domain on the values of an attribute, 
select the attribute. After you enter an attribute here, you can 
click the Create Domain button to enter all the values of this 
attribute in the Domain list. 

LOV If you want to base the domain on the values in a list of values 
(LOV), select the LOV. After you select an LOV here, you can click 
the Create Domain button to enter all the values of this LOV in 
the Domain list. 

Sort Order Enter the number specifying where this dimension appears in the 
rules list. For example, if you want this to be the first column in 
the rules list, enter 1. 

This field determines the priority of this rule when the application 
performs a lookup against the rules table. For more information, 
see “How Attribute Adjustments Apply Rules” on page 101. 

Sort Method Select Ascending to display the dimensions in the order specified 
in the Sort Order field, or select Descending to display the 
dimensions in the reverse order. For more information, see “How 
Attribute Adjustments Apply Rules” on page 101. 

Translate This boolean flag is used for multi-lingual deployments. Out of the 
box, this flag is hidden in the Dimensions list and needs to be 
exposed if it is required for usage. This flag should be used only 
for dimensions of the data type String that are based on domains 
Attribute and LOV.

When checked, the system stores internally the Language 
Independent Code of the domain value.

CAUTION: Use the Translate flag only in multi-lingual 
deployments. Do not use for deployments that are not multi-
lingual.

Field Comments
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Adding Attribute Adjustment Conditions
After you have set up the dimensions of the attribute adjustment, you can add conditions, which are 
the rules that state the result of the adjustment for each combination of condition dimensions. This 
task is a step in “Process of Creating an Attribute Adjustment” on page 108. 

To add attribute adjustment rules

1 Navigate to the Administration - Pricing screen > Attribute Adjustments view. 

2 In the Attribute Adjustments list, select the attribute adjustment whose rules you are specifying. 

3 Click the Conditions view tab. 

The conditions list appears, with a Name column for the name of each condition.

4 If all domain values of each dimension impact price, you can generate rules as follows: 

a In the Attribute Adjustment form, click Generate Rules.

Records are added to the Rules list with every possible combination of domain values of the 
condition dimensions domains. 

b Enter the Adjustment Type and Adjustment Value for each record in the Rules list. 

5 If you are entering rules manually: 

a In the Attribute Adjustment form, click New. 

b In the new record, enter one possible value of the condition dimensions, and enter values in 
the Adjustment Type and Adjustment Amount columns to specify the result for that 
combination of conditions. 

c Continue to add new records until you have entered all the necessary rules. 

Associating Attribute Adjustments with Price List Line 
Items
To apply these adjustments to a product, you associate the attribute adjustment with the product in 
a price list line item. The attribute adjustments apply to all customers who use this price list.

This task is a step in “Process of Creating an Attribute Adjustment” on page 108. 

Associating attribute adjustments with price list line items

1 Navigate to the Administration - Pricing screen > Price Lists view.

2 In the Price Lists list, select the appropriate price list. 

3 Click the Price List Line Items view tab. 

4 In the Price List Line Items list, find the record for the appropriate price list and in the Attribute 
Adjustments field, select the attribute adjustment. 
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Example of Creating an Attribute 
Adjustment Based on Product Attributes
This topic gives one example of how to create attribute-based pricing based on product attributes. 
You may use this feature differently, depending on your business model. 

In this example, adjustments are applied to the price of automobiles based on two attributes: 

■ Interior color has the possible values red, green, and blue. 

■ Transmission has the possible values automatic and manual. 

Because of current market and inventory conditions, you want to create the three price adjustments 
shown in Table 12. These price adjustments will apply only to vans sold to retail customers. 

This example assumes that you have already created the class Horizon Autos, the product Van, and 
the price list Retail. For information about creating classes and products, see Product Administration 
Guide. For information about creating price lists, see Chapter 3, “Creating and Assigning Price Lists.” 
This example also assumes that you have set up variable maps, as described in “Using Variable Maps 
in Attribute Adjustments” on page 100. 

Creating the Attribute Adjustment Record
First, create the Attribute Adjustment record. The type must be multiple, because the price 
adjustments depend on more than one attribute. It must be associated with the class Horizon Autos, 
which includes these attributes. 

To create the attribute adjustment record

1 Navigate to the Administration - Pricing screen > Attribute Adjustments view. 

2 In the Attribute Adjustments list, add a new record and complete the necessary fields. 

Some fields are described in the following table. 

Table 12. Attribute-Based Price Adjustments in the Example

Interior Color Transmission Adjustment Type
Adjustment 
Amount

Green Automatic % Discount $10

Red Manual % Markup $10

Blue Manual Price Override $22,000

Field Value

Name Horizon Autos Retail Van Adjustments
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Specifying Dimensions and Domains
Next, set up the dimensions that you want to use in the attribute adjustments. You must add two 
condition dimensions for the attributes that are the basis of price adjustments (Interior Color and 
Transmission). 

You must also add two result dimensions that determine the amount of the price adjustment 
(Adjustment Amount and Adjustment Type), which are added automatically when you click Create 
Result Dimensions. 

You also enter the domains for each of these dimensions, and you select the Bounded check box in 
the Dimension records. This controls data entry in the Rules list, so only valid values can be entered 
in the columns for these dimensions. 

To enter the result dimensions and their domains

1 In the Attribute Adjustments list, click Create Result Dimensions. 

2 Click the Pricing Dimensions view tab. 

Records have already been added to the Dimensions list for the two result dimensions, 
Adjustment Amount and Adjustment Type. 

3 In the Pricing Dimensions list, select the record for adjustment type, and click Create Domain. 

Records are added to the Domain list for the five possible values of adjustment type. 

To enter the condition dimensions and their domains

1 Add a record to the Dimensions list to represent the Interior Color attribute and complete the 
necessary fields, as described in the following table. 

Class Horizon Autos

Type Multiple Dimension

Field Value

Dimension Type Condition

Name Int Color

Operator =

Variable Map Type XA

Data Type Text

Domain Type Attribute

Bounded Y

Attribute Interior Color

Field Value
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2 Click Create Domain. 

The three values for this domain (red, blue, and green) appear in the Domain list. 

3 Add a record to the Dimensions list to represent the Transmission attribute and complete the 
necessary fields, as described in the following table. 

4 Click Create Domain. 

The two values for this domain (automatic and manual) appear in the Domain list. 

Adding Pricing Conditions
After you have set up the dimensions of the attribute adjustment, you can add conditions. The 
Conditions list has a column for each of the dimensions that you created. 

Because you are creating conditions for only three price adjustments, you add the Conditions records 
manually instead of using the Generate Rules button. 

To add pricing conditions

1 Click the Conditions view tab. 

Sort Order 1

Sort Method Ascending

Field Value

Dimension Type Condition

Name Transmission

Operator =

Variable Map Type XA

Data Type Text

Domain Type Attribute

Bounded Y

Attribute Transmission

Sort Order 2

Sort Method Ascending

Field Value
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2 Add a record to the Conditions list and complete the necessary fields, as described in the 
following table. 

3 Add a second record to the Conditions list and complete the necessary fields, as described in the 
following table. 

4 Add a third record to the Conditions list and complete the necessary fields, as described in the 
following table. 

Associating the Attribute Adjustment with a Product and Price List
After you have created the attribute pricing conditions, you must associate them with a product on 
a price list to make them effective. These conditions apply to vans sold to retail customers. 

To associate the attribute adjustment with a product and price list

1 Navigate to the Administration - Pricing screen > Price Lists view. 

2 In the Price Lists list, select the record for the price list named Retail. 

Field Value

Sequence 1

Int Color Green

Transmission Automatic

Adjustment Type % Discount

Adjustment Amount 10

Field Value

Sequence 2

Int Color Red

Transmission Manual

Adjustment Type % Markup

Adjustment Amount 10

Field Value

Sequence 3

Int Color Blue

Transmission Manual

Adjustment Type Price Override

Adjustment Amount 22,000
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3 Click the Price List Line Items view tab. 

4 In the Price List Line Items list, in the record for the product named Van, in the Attribute 
Adjustment field, select Horizon Autos Retail Van Adjustments. 

Example of Creating an Attribute 
Adjustment with Nonproduct Attributes
This topic gives one example of how to create attribute-based pricing with nonproduct attributes. 
You may use this feature differently, depending on your business model. 

In this example, adjustments are applied to the price of automobiles based on three attributes in 
three different business components: 

■ Transmission. This is a product attribute that has the possible values Automatic and Manual. 

■ Account Type. This is a header field that has the possible values Customer, Commercial, and 
Partner. 

■ Quantity. This is a line item field that can have any numeric value. 

This example creates three possible adjustments based on these attributes: 

■ All vans (a product) ordered for a commercial account with manual transmission and a quantity 
greater than 20 will be priced at $18,000 (price override).

■ All vans ordered for a customer account with manual transmission and a quantity greater than 
15 will be marked up by 10% (% Markup).

■ All vans ordered for a partner account with automatic transmission and a quantity greater than 
10 will be discounted by 10% (% Discount). 

All these discounts apply to the price list named Americas Price List. 

This example assumes that you have already created the class Horizon Autos, the product Van, and 
the price list Americas Price List. For information about creating classes and products, see Product 
Administration Guide. For information about creating price lists, see Chapter 3, “Creating and 
Assigning Price Lists.” 

Modifying the Variable Map
First, you must modify the variable map Default Pricing Variable Map - Context, so Account Type is 
defined as a variable in this map. Do this only if Account Type is not already defined as a variable in 
the map. 

To modify the variable map

1 Navigate to the Administration - Order Management screen > Variable Maps view. 

2 Select and lock the variable map Default Pricing Variable Map - Context. 

3 In the Versions list, click Workspace. 

Details of the new version of the variable map appear. 
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4 In the Variable Definitions list, add a new record and complete the necessary fields. 

Some fields are shown in the following table.

5 In the Variable Sources list, specify the source of the new variable, as shown in the following 
table. 

6 Restart the client application to make sure that the variable map changes are available. 

Creating the Attribute Adjustment Record
The type of the Attribute Adjustment record must be multiple, because the price adjustments depend 
on more than one attribute. The type must be associated with the class Horizon Autos, which includes 
these attributes. 

To create the attribute adjustment record

1 Navigate to the Administration - Pricing screen > Attribute Adjustments view. 

2 In the Attribute Adjustments list, add a new record and complete the necessary fields. 

Some fields are described in the following table. 

Field Value

Variable Name Account Type

In/Out In

Type Text

On Null Ignore

Field Value

Mode Any

Path $Current/Header/Account Type

Source Type Instance

Field Value

Name Horizon Autos

Class Horizon Autos

Type Multiple Dimension
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Specifying Dimensions and Domains
Next, set up the dimensions that you want to use in the attribute adjustments. You must add three 
condition dimensions for the attributes that are the basis of price adjustments (Transmission, 
Account Type, and Quantity). 

Also, you must add two result dimensions that determine the amount of the price adjustment 
(Adjustment Amount and Adjustment Type), which are added automatically when you click Create 
Result Dimensions. 

You also enter the domains for each of these dimensions. Select the Bounded check box in the 
Dimension records to control data entry in the Rules list, so only valid values can be entered in the 
columns for these dimensions. 

To enter the result dimensions and their domains

1 In the Attribute Adjustments list, click Create Result Dimensions. 

2 Click the Pricing Dimensions view tab. 

Records have already been added to the Dimensions list for the two result dimensions, 
Adjustment Amount and Adjustment Type. 

3 Add a record to the Dimensions list to represent the Transmission attribute and complete the 
necessary fields, as described in the following table. 

4 Click Create Domain. 

The two values for this domain (automatic and manual) appear in the Domain list. 

Field Value

Dimension Type Condition

Name Transmission

Operator =

Variable Map Type XA

Data Type Text

Domain Type Attribute

Bounded Y

Attribute Transmission

Sort Order 1 

Sort Method Ascending
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5 Add a record to the Dimensions list to represent the Account Type attribute and complete the 
necessary fields, as described in the following table. 

NOTE: In this example, Business Component is used as the domain for setting up the Act Type 
dimension. However, a better way to define the domain in practice would be to use LOV with the 
value ACCOUNT_TYPE in the LOV field. 

6 Click Create Domain. 

The values for this domain appear in the Domain list. 

7 Add a record to the Dimensions list to represent the Quantity attribute and complete the 
necessary fields, as described in the following table. 

Field Value

Dimension Type Condition

Name Act Type

Operator =

Variable Map Type Context

Data Type Text

Domain Type Business Component

Bounded Y

Business Object List of Values

Sort Order 2

Sort Method Ascending

Business Component List of Values

Field Value

Search Spec [Type] = “ACCOUNT_TYPE”

Field Value

Dimension Type Condition

Name Quantity

Operator <

Variable Map Type Row

Data Type Number

Domain Type User Defined

Bounded Y
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8 Because Quantity has a user-defined domain, create its domain manually by adding records to 
the Domains list as follows:

a Add a record to the Domains list and complete the necessary fields, as described in the following 
table. 

b Add another record to the Domains list and complete the necessary fields, as described in the 
following table. 

c Add another record to the Domains list and complete the necessary fields, as described in the 
following table. 

Adding Pricing Conditions
After you have set up the dimensions of the attribute adjustment, you can add conditions. The 
Conditions list has a column for each of the dimensions that you created. 

In this example, you add the Conditions records manually instead of using the Generate Rules 
button. 

To add pricing conditions

1 Click the Conditions view tab. 

Sort Order 3

Sort Method Ascending

Field Value

Sequence 1

Domain 10

Field Value

Sequence 2

Domain 15

Field Value

Sequence 3

Domain 20

Field Value
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2 Add a record to the Conditions list and complete the necessary fields, as described in the 
following table. 

3 Add a second record to the Conditions list and complete the necessary fields, as described in the 
following table. 

4 Add a third record to the Conditions list and complete the necessary fields, as described in the 
following table. 

Associating the Attribute Adjustment with a Product and Price List
After you have completed setting up the attribute adjustments, you must associate them with a 
product on a price list to make them effective. These conditions apply to the product named Van and 
to the price list named Americas Price List. 

Field Value

Sequence 1

Transmission Manual

Act Type [=] Commercial

Quantity [<] 20

Adjustment Type Price Override

Adjustment Amount 18,000

Field Value

Sequence 2

Transmission Manual

Act Type [=] Customer

Quantity [<] 15

Adjustment Type % Markup

Adjustment Amount 10

Field Value

Sequence 3

Transmission Automatic

Act Type [=] Partner

Quantity [<] 10

Adjustment Type % Discount

Adjustment Amount 10
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To associate the attribute adjustment with a product and price list

1 Navigate to the Administration - Pricing screen > Price Lists view. 

2 In the Price Lists list, select the record for the price list named Americas Price List. 

3 Click the Price List Line Items view tab. 

4 In the Price List Line Items list, find the record for the product named Van and in the Attribute 
Adjustment field, select Horizon Autos. 

Testing the Attribute Adjustments
You can test the attribute adjustments for three different account types. This example assumes that 
you have created the following accounts: 

■ ABC. Account Type = Customer.

■ XYZ. Account Type = Commercial.

■ 123. Account Type = Partner.

To test the attribute adjustments

1 In the Quotes screen, create a new quote with price list Americas Price List and account ABC 
(Account Type = Customer).

2 Add the product Van as a line item of the quote. 

3 Set the attribute Transmission to Manual as follows: 

a Click Customize to launch Configurator. 

b In Configurator, set the attribute Transmission to Manual.

c Click Done to exit from Configurator.

4 For the quantity of the product Van, enter 16.

The net price of the product Van is marked up by 10%.

5 Click the Net Price field to display the pricing waterfall, to view this adjustment.

6 Test the second attribute adjustment as follows: 

a In the Quote, change the account to XYZ (Account Type = Commercial).

b In the line item, change the product quantity to 21. 

The net price of the product Van is $18,000.

7 Test the third attribute adjustment as follows: 

a In the Quote, change the account to 123 (Account Type = Partner). 

b Click Customize and use Configurator to change the value of the attribute Transmission to 
Automatic.

c In the line item, change the product quantity to 11. 

The net price of the product Van is discounted by 10%.
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Best Practices for Creating Attribute 
Adjustments
Use attribute adjustments in cases where:

■ The values of the variables that are used to determine the results are not known ahead of time. 

■ Integrations to external systems are secondary criteria.

■ There is a small number of total rules, in the thousands at the most.

Using Sort Order to Improve Performance
You can use the Sort Order and Sort Method fields of the Dimensions record to specify the order in 
which attributes are processed. For information about how this affects performance, see “Order of 
Conditions in Multiple-Condition Pricing Tables” on page 104. 

Using Nonequality Operators to Improve Performance
You can reduce the number of rules required by using the nonequality comparison operators to limit 
the size of the rules table, when possible. For example, if any shirt that is of length 40 or smaller 
receives a 10% discount, then you can set up a condition dimension for the Length attribute with 
operator > to set up the price adjustment rule. For more information, see “Adding Attribute 
Adjustment Conditions” on page 113.

CAUTION: Make sure that the attribute adjustment is set up so that the attribute adjustment 
returns only one record. When nonequality operators are used, the attribute adjustment may return 
more than one record. Pricing administrators are responsible for setting up the dimensions in the 
appropriate way or setting up the pricing procedure to handle multiple matches.

NOTE: Using wildcards does not improve performance, but it does decrease the number of records 
in the rules table.

Numeric Dimensions and Operators
If a condition dimension is compared with a numeric value using the equal (=) operator, you can 
improve performance by setting its data type to text. Property sets can store only text values, and 
when you use a numeric comparison, there is an overhead to convert the text to numeric values at 
run time. You must use numeric values for less than (<) or greater than (>) comparisons, but if you 
are using an = comparison, you will get the same result whether the data is numeric or text.

Using Comparison Operators 
When the rules in attribute adjustments use comparison operators such as > and <:

■ The data types of the condition dimensions must be number or date. 

■ Pay special attention to the following:

■ Whether the rule must act on all the rows of data when you enter the values that the 
conditions must match
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■ The Sort Order properties of the dimensions. Blanking out or duplicating the sort order will 
give undefined results.

■ The Sort Order and Sort Method fields of the dimensions. These fields determine the order 
in which the rules are processed, and you must select values that minimize the number of 
records that must be processed. 

How the Pricing Procedure Uses 
Attribute Adjustments 
After an attribute adjustment is set up, the pricing procedure must perform a lookup against it in the 
pricing procedure so that adjustments can be applied at run time.

The pricing procedure does this lookup using the Attribute Adjustment step, which invokes the 
Dynamic Lookup Transform. 

For more information about the pricing procedure, see “Pricing Procedures and Workflow References” 
on page 155. 

For more information about the Dynamic Lookup Transform, see Siebel Order Management 
Infrastructure Guide.

Upgrade Considerations for Attribute 
Adjustments
When you upgrade from earlier versions of Siebel applications to version 7.8, use the On First Match 
(Action) argument of the Dynamic Lookup Transform. This argument makes attribute pricing that is 
defined in the Attribute Adjustments list in version 7.8 work the same way as attribute-based pricing 
feature in earlier versions. 

Without configuration, the pricing procedure provides the same functionality as in the earlier release.

The Attribute Adjustments list can return multiple rows. The first row it returns will always be 
consistent with attribute pricing behavior in earlier versions. Using On Match arguments can return 
results that are not consistent with the behavior of versions earlier than 7.8.
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11 Setting Up Pricing for Products 
with Components
This chapter describes pricing for products with components. It instructs you on viewing a product’s 
components and setting up component-based pricing. It also covers the processing order of price 
adjustments for products with components. 

This chapter covers the following topics: 

■ “About Component-Based Pricing” on page 127

■ “Impact of Product Versioning and Price List Line Item Effectivity on Component-Based Pricing” on 
page 128

■ “Viewing a Product’s Components in the Pricing Designer” on page 129

■ “About Setting Up Component-Based Pricing” on page 130

■ “Viewing and Changing the Reference Price” on page 132

■ “Verifying Component Prices Across Time Intervals” on page 138

About Component-Based Pricing
Products with components include components that are themselves products in the product table. 
For example, if you sell computer monitors, CD-ROMs, and disk drives, you also sell several models 
of desktop computer that include these products as components. 

This chapter explains how to set up pricing for products with components, as follows: 

■ View a product in the Pricing Designer. You can use the Pricing Designer to view a product’s 
components and for the other functionality described in this chapter. 

■ Set up component-based pricing. You set up pricing so the total price of a product either 
equals a base price plus the price of optional components, or equals the total price of all 
components. 

■ Create relation-based price adjustments. You can give customers discounts if they buy 
components as part of a specific product package. These are called relation-based price 
adjustments. 

This chapter assumes that you have background knowledge about products with components. For 
more information about products with components, see Product Administration Guide. 

If you create several types of price adjustments for products with components, the order in which 
price adjustments are processed can affect the final price. For more information, see “About the 
Processing Order of Price Adjustments” on page 13. 
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Impact of Product Versioning and Price 
List Line Item Effectivity on Component-
Based Pricing
A product can have multiple released versions with future dates. In addition, price list line items can 
have effective dates. As a result, the structure of a product can be dynamic over time, because 
multiple versions of it can exist.

Component-based pricing takes the following into account:

■ Both root CP and its components can have multiple versions across a time interval. 

■ Both root CP and its components can have multiple entries on a price list for different effective 
dates. 

■ The Customizable Product Adjustments (The CP Pricing Designer) can have multiple versions for 
different effective dates. 

This section discusses some of the ways that multiple product versions and multiple effective dates 
affect component-based pricing. 

Component Product Must Exist on the Price List of a Component-Based 
Product
If a component-based product does not exist on a price list as of a particular date, then the 
adjustments to its components should not be applied as of that date. For the adjustment to apply to 
the component product, it must exist on the price list of the component-based product in the same 
time interval as the adjustment. Consider this example: 

■ A component-based product, product P, has only one component product, product P1. 

■ P and P1 have entries in the Price List Line Item list that are shown in Table 13. 

■ Adjustments have been defined for P1 when it is a component of P that are shown in Table 14. 

Table 13. Price List Line Item Entries in the Example

Product Start Date End Date List Price

P 12/31/2004 04/01/2004 1000

P1 12/31/2003 01/15/2004 100

Table 14. Adjustments for P1 in the Example

Adjustment Type Adjustment Value Start Date End Date

Price Override 104 02/05/2004 02/29/2004

Percent Discount 10 03/01/2004 03/31/2004
Pricing Administration Guide Version 7.8, Rev. B128 



Setting Up Pricing for Products with Components ■ Viewing a Product’s Components in
the Pricing Designer
■ In this case, if the product P1 is ordered in the context of the root product P on 02/15/2004, it 
will have a zero price. You might expect its price to be 104, based on the price override that is 
effective on that date, but because product P1 does not have an entry in the price list for the 
interval 02/05/2004 through 02/29/2004, no price appears on the transaction for it.

This behavior is consistent with the prior releases of C/OM.

NOTE: If a root product with components does not exist on a price list on a given date, then the 
adjustments to its components are not applied for that date. For example, the adjustments in the CP 
Pricing Designer might be effective for a specific time interval during which the root product with 
components might not have an entry in the price list itself. The CP adjustments to the components 
of the root product with components do not apply during that time interval.

Time Intervals When a Product Is Not Customizable
The price list for a product with components can include a time interval when the product is not 
customizable. This is possible because a product might not have any structure on a given date, but 
might have a structure on some other date (specified in a released version with a future date).

In this case, if the user drills down from the price list line item to display the product, the application 
displays an error message saying that the customizable product does not have versions in the date 
range, and that the user should choose an appropriate time interval to set up price adjustments for 
the product. This means that the customizable product does not have structure at that time; that is, 
that it does not have component products. 

Viewing a Product’s Components in the 
Pricing Designer
You can use the Pricing Designer to display the relationships and components of a product with 
components. You can query by relationships to look at all the component products available within a 
specific relationship.

The CP Pricing Designer displays a superset structure of the root product with components. It 
displays a consolidated view of all the versions of the root product with components that might exist 
in the price list during a given time interval. Thus, you might see products in a relationship in Pricing 
Designer that do not exist in the latest released version of the root product with components. They 
are visible in the pricing designer for the root product with components because they exist in 
released version of the product with a future date. Therefore, the structure of the root product in the 
pricing designer may not be identical to the latest released version of the root product. The Pricing 
Designer is sensitive to the start and end date of the root product with components on the price list, 
so the content of the Pricing Designer may vary for different time intervals.

To display a product’s components in the pricing designer

1 Navigate to the Administration - Pricing screen > Price Lists view.

2 In the Price Lists list, select the price list that contains the product.

3 Click the Price List Line Items view tab to display the products in the price list.
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4 In the Price List Line Items list, click the name of the root product with components. 

NOTE: The root product with components might have multiple entries on the price list for the 
different time intervals, so you must pick the root product with components with the appropriate 
time interval. 

The Pricing Designer view appears.

CAUTION: Using the New Effective Date button on the Price List Line Item applet for a product 
with components causes a deep copy that also copies any customizable product adjustments 
defined for the product. You should delete the adjustments that do not apply in the new time 
interval.

About Setting Up Component-Based 
Pricing
There are two ways of setting up component-based pricing: 

■ “Setting Up Base Pricing for Products With Components.” Use this when products with components 
share a base configuration. Customers who purchase the base product can customize it by 
selecting options that are added to the base product. 

■ “Setting Up Summation or Rollup Pricing for Products With Components.” Use this when products 
with components do not share a common base configuration. 

Setting Up Base Pricing for Products With Components
Use this pricing method when the user purchases a base product and customizes it by adding options. 
The total price is the sum of the base price plus the adjusted price of the components. For example, 
if a car has a base price of $25,000, the user can also purchase additional options such as air 
conditioning, sun roof, and so on. 

To set up base pricing, do the following:

■ Set the list price of the car to $25,000.

■ Set the price for all other options and, if necessary, specify that some are default components.

When users configure the product, the price they see is the sum of the base price plus the adjusted 
price of the default options. If the user adds other options, the price increases. For example, assume 
a car has a base price of $25,000 and includes the following options:

■ Chrome Wheels (Default) for $2000 

■ Gold Wheels for $3000

The user sees an initial price of $27,000 for the car. This is the sum of the base price of the car plus 
the price of the default chrome wheels. If the user chooses the gold wheels, the sum is recomputed 
and the price of the car becomes $28,000. 

An alternate method for setting up base pricing is to: 
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■ Include options in the base price. 

■ Create price override adjustments for all default options included in the base price that sets their 
price to zero (0). 

■ Create a price override adjustment for related nondefault options that sets their price to the 
difference between the default option and the nondefault option. 

In the example, you can use this alternative method to include chrome wheels in the list price of the 
car by doing the following:

■ Set the list price of the car to $27,000.

■ Create a price override to zero (0) for the chrome wheels. 

■ Create a price override to $1000 for the gold wheels. This is the price difference between the 
gold and chrome wheels. 

To set up base pricing product

1 Display the components of the product with components in the Pricing Designer, as described in 
“Viewing a Product’s Components in the Pricing Designer” on page 129.

2 Define relationship-based pricing adjustments, if they are needed, as described in “Viewing and 
Changing the Reference Price” on page 132.

3 In the Price List Item form, go to the List Price field and enter the base price.

4 In the Pricing Designer list, select the components. In the Adjustments list, enter price 
adjustments for each component.

5 If you are using the alternative method of setting up base pricing, enter the necessary price 
overrides for default components. 

Setting Up Summation or Rollup Pricing for Products 
With Components
Use this pricing method when all of a product’s components are configurable. Although each product 
has a default configuration, users can select nondefault components instead of the default 
components.

When you use the Pricing Designer, you must set a list price for the base product of a component-
based product and define pricing adjustments on components. The price that is displayed for the user 
is the sum of the list price and the adjusted price of the default components. This price may display 
to the user in a quote, agreement, order, the selection pages in a configuration session, or in a 
catalog. 

When you are using summation (or rollup) pricing, there is no base product, so you set the list price 
of the base product to zero (0). This means that the price the user sees is the sum of the prices of 
its default components (Quote, Agreement, Order, and configuration selection pages). In an eSales 
catalog, the user sees a price of 0.
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An example would be a desktop computer made up entirely of components that you also sell 
separately. To set up rollup pricing for quote users you would do the following:

■ Set the list price of the desktop computer to 0.

■ Set a price for each of the components, and specify which ones are default components. 

Because the list price is 0, the default price of the desktop computer is the sum of the prices of its 
default components. If the user who is configuring the product picks a nondefault component, the 
sum is recomputed to include the price of the nondefault component. For example, for a desktop 
computer, you have entered a list price of 0 and the component pricing adjustments shown in 
Table 15. 

While configuring a quote, users see an initial price of $1200 for the desktop computer (the sum of 
the prices of the default chassis and monitor). If the user chooses the large monitor, the sum is 
recomputed, and the price of the desktop computer becomes $1300. 

NOTE: The price that is displayed includes any relationship-based pricing adjustments and other 
adjustments to the price of the components. 

To set up rollup pricing for a product with components

1 Display the components of the product with components in the Pricing Designer, as described in 
“Viewing a Product’s Components in the Pricing Designer” on page 129.

2 Define relationship-based pricing adjustments, if they are needed, as described in “Viewing and 
Changing the Reference Price” on page 132.

3 Do not enter a price for the root product with components in the Price List line items view. 

4 Enter prices for all the components.

Viewing and Changing the Reference 
Price
To give customers an accurate idea of the price they might expect to pay for a component-based 
product, Siebel Pricer calculates a reference price, which is the price of the product with its default 
options. The reference price is displayed to the customer in the Starting At Price field in the product 
catalog. 

Table 15. Desktop Computer Components

Item List Price Adjustment Type Adjusted Price

1.0 Chassis (default) $1200 Price override $1000

2.0 Monitor

2.1 Small monitor (default) $300 Price override $200

2.2 Large monitor $400 Price override $300
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For the Starting At Price to function as expected, child components of the product must have a 
minimum cardinality greater than zero(0) to be reflected in the reference price. If the minimum 
cardinality is not set for a child component, then its price is not reflected in the reference price. Any 
component that is part of the default instance is used to evaluate the Starting At Price. Out of the 
box, only products with the price type one-time are included in the evaluation of the Starting At 
Price; products with price types recurring and usage are not included.

NOTE: The default instance used for evaluation is based on the most effective applicable version of 
the component pricing.

Siebel Pricer displays both the list price and the reference price for the component-based product. 
The list price is the price for the root component. If you click Check Starting At Price, Siebel Pricer 
adds the list price and the price of all the default components. This calculation does not include any 
attribute pricing adjustments that would come from default attributes. 

In the catalog, this value is displayed to customers in the Starting At field. This value is displayed 
only for component-based products. 

To change default the reference price, click the Edit button in the top applet. You can then edit the 
reference price manually. 

The value displayed to customers does not change unless the pricing administrator clicks the Check 
Starting At Price again or overwrites the reference price manually. 

NOTE: The reference price is used for products with components, including component-based 
products and bundles. It does not apply to attribute-based products. 

Out of the box, the application executes the Basic Pricing Procedure. However, the basic pricing 
procedure does not execute CP pricing. To be consistent, the Check Starting At Price button calls the 
same procedure as the run-time application (therefore, OOTB, the basic pricing procedure) to 
determine the starting price for a customizable product. This ensures that the administrative user 
sees the same price as the end user.

Customers who have the Dynamic Pricer license and want to use CP Pricing need to enable the 
dynamic pricing procedure, as detailed in the “Dynamic Pricing Procedure Workflow” section in this 
guide. In this procedure, the customer changes the CalculatePrice_Configurator signal to call the 
dynamic pricing procedure.  

This change ensures that the administrative user will see the effect of CP Price Adjustments in the 
starting price that is generated by clicking the Check Starting At Price button, and that the end user 
will see the effect of CP Price Adjustments in the starting price of the CP and its components in the 
Configurator’s running time.

Viewing the Reference Price
Use the following procedure to view the reference price.

To view the reference price

1 Navigate to the Site Map > Administration - Pricing screen > Price List view. 
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2 In the Names field, select the price list that contains the component-based products.

The Price List Line Item list appears.

3 Click on a customizable product name.

A customizable product has a check in the Customizable field.

4 In the Price List Item form, click Check Starting At Price.

The reference price is recalculated based on the default components of the product, and the 
result displays in the Reference Price field. 

Exposing the Starting Price At in the Product Catalog 
Use the following enhancements to expose the Starting Price At field in the product catalog UI.

1 Workflow. In the Basic Pricing Procedure workflow and the Dynamic Pricing Procedure workflow, 
add the following input argument to the Get List Price step.

Then, activate the workflow after the change.

For more information about using these workflows, see “Pricing Procedures and Workflow 
References.”

2 Variable Map/Variable Source. In Product Pricing Variable Map - Row Set, and Product Pricing 
Variable Map -Row Set-Basic, use the following variable definition.

With the new definition, use the following variable sources.

For more information about using variable maps, see Siebel Order Management Infrastructure 
Guide.

Input Argument Value

On First Match 15 {Row. Reference Price} = {Match. Reference Price}

Variable Name In/Out Type On Null

Reference Price Out Currency Ignore

Mode Path Source Type

Any $Current/Product/Reference Price Instance

Favorite $Current/Favorite/Reference Price Instance
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3 Business Components. Modify the following business components (buscomps).

For more information on business components, see Siebel Order Management Infrastructure 
Guide.

4 Applets. Update the following applets.

For more information on working with applets, see Using Siebel Tools.

5 Integration Objects. Update the following objects.

Business Component User Property Change This Value

Quote Catalog Internal Product 
by Price List Option

PSP: Price Fields From: List Price, Net Price, Deals

To: List Price, Net Price, Reference Price

Quote Catalog Internal Product 
by Price List Optional 2

PSP:Price Fields From: List Price, Net Price, Deals

To: List Price, Net Price, Reference Price

Quote Catalog Internal Product 
by Price List Optional - PSS

PSP:Price Fields From: List Price, Net Price, Deals

To: List Price, Net Price, Reference Price

Applet Change

Quote Catalog Product Form Change field to Reference Price for control 
PriceStartingAt

Quote Catalog Product List - Add to Cart Change field to Reference Price for list column Price 
Starting At

Sales Order Catalog Product List - Add to 
Cart

Change field to Reference Price for list column Price 
Starting At

Service Order Catalog Product List - Add to 
Cart

Change field to Reference Price for list column Price 
Starting At

Quote Catalog Product List - MultiSelect 
Checkbox

Change field to Reference Price for list column 
Reference Price

Sales Order Catalog Product List - 
MultiSelect Checkbox

Change field to Reference Price for list column 
Reference Price

Service Order Catalog Product List - 
MultiSelect Checkbox

Change field to Reference Price for list column 
Reference Price
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Integration Object: ISS Quote

Integration Component: Internal Product PSP Integration

Add Integration Component Field:

Name: Reference Price

Data Type: DTYPE_CURRENCY

External Name: Reference Price

XML Tag: ReferencePrice

Integration Component: Quote Catalog PSP Favorite Item

Add Integration Component Field:

Name: Reference Price

Data Type: DTYPE_CURRENCY

External Name: Reference Price

XML Tag: ReferencePrice

Integration Object: ISS Order

Integration Component: Internal Product PSP Integration

Add Integration Component Field:

Name: Reference Price

Data Type: DTYPE_CURRENCY

External Name: Reference Price

XML Tag: ReferencePrice

Integration Component: Quote Catalog PSP Favorite Item

Add Integration Component Field:

Name: Reference Price

Data Type: DTYPE_CURRENCY

External Name: Reference Price

XML Tag: ReferencePrice
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6 Business Components (Buscomp) Update these buscomps with the following information.

Creating a Relationship-Based Price 
Adjustment

Relationship-based price adjustments let you adjust the price of a product when it is a component 
of a product with components. For example, you may sell a model of computer monitor for $300 if 
the customer buys only the monitor. However, if the customer who is buying one of your desktop 
computers chooses this monitor model as an option, you may reduce its price 10 percent from this 
list price, or you may sell it for $250. 

To create the relationship-based price adjustment, use the Adjustment Type and Adjustment Amount 
fields for the component. 

To define a relationship-based pricing adjustment

1 Display the components of the product with components in the Pricing Designer, as described in 
“Viewing a Product’s Components in the Pricing Designer” on page 129.

Business Component Change

Quote Catalog PSP Favorite Item Add a calculated field Reference Price with no 
Calculated Value and type of 
DTYPE_CURRENCY.

Internal Product PSP Integration Add a calculated field Reference Price with no 
Calculated Value and type of 
DTYPE_CURRENCY.
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2 Select the records for any components that require a relationship-based pricing adjustment, add 
a new record to the Adjustments applet, and enter the values for the fields as described in the 
following table. 

3 Click Verify Adjustments to verify that the component’s Reference Price reflects the pricing 
adjustment. 

NOTE: You can modify the relationship-based adjustment by editing the amounts in the Adjustment 
Type and Adjustment Value fields for the records in the Adjustments applet, and you can delete the 
relationship-based adjustment by deleting the records in the Adjustments applet.

Verifying Component Prices Across Time 
Intervals
Products can have multiple versions with different effective dates. For more information, see Product 
Administration Guide. 

Field Comments

Adjustment Type Select the type of price adjustment applied to this product. 
Options are Discount Amount, % Discount, Markup Amount, % 
Markup, and Price Override. 

Adjustment Value Enter the value of the Adjustment. How this value is used 
depends on the selection in the Adjustment Type field: 

■ Discount amount. The adjustment value is subtracted from 
the price. 

■ % discount. The adjustment value is treated as a 
percentage, and that percentage of the price is subtracted 
from the price. 

■ Markup amount. The adjustment value is added to the price. 

■ % markup. The adjustment value is treated as a percentage, 
and that percentage of the price is added to the price. 

■ Price override. The adjustment value is used as the price, 
overriding the original price. 

Min Price Enter the minimum price for this product as a component of this 
customizable product. This may be different from the minimum 
price of the product when it is purchased separately. 

Max Price Enter the maximum price for this product as a component of this 
customizable product. This may be different from the maximum 
price of the product when it is purchased separately. 

Start Date Enter the date when this adjustment becomes effective. 

End Date Enter the date after which this adjustment is no longer effective. 
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Price lists can have multiple line items for the same product, with different effective dates for the 
price in each line item. For more information, see “Giving a Product Multiple Prices with Different 
Effective Dates” on page 30. 

The structure of a component-based product may change during a time interval, and the prices of 
the product and its components may change at different dates during this time interval. It may be 
necessary to apply the component price adjustments to future versions of the component-based 
product, which has a different structure. For more information, see “Impact of Product Versioning and 
Price List Line Item Effectivity on Component-Based Pricing” on page 128. 

When you create a new time interval for a product with components in the Administration - Product 
screen, the component-product price adjustments are copied to the new time interval. However, 
these adjustments will apply in run time only if the component-product and its components exist in 
the price list during that same time interval.

You can click the Verify Adjustments button to display a list of the time intervals that have been 
defined for products with component prices. Check this list to make sure that component prices have 
been defined for every time interval. 

To verify component prices across time intervals

1 Display the components of the product with components in the Pricing Designer, as described in 
“Viewing a Product’s Components in the Pricing Designer” on page 129.

2 Select a component in the Pricing Designer list. 

3 Click Verify Adjustments. 

The Reference Prices dialog box appears, listing the Start Date and End Date for all the prices 
for this product with components. For each time period, it lists the base price and price 
adjustments, if any. 

4 Check the Reference Prices list to make sure that there are no time gaps when this product does 
not have a defined price. 

Sample Output of Verifying Component Prices Across Time Intervals
As an example of verifying component prices across time intervals, consider a simple product with 
components: 

■ Product A is a product with components.

■ Product A1 is a component of product A. 

In the price list, Product A1 has the list prices shown in Table 16. 

Table 16. List Prices for Product A1 in the Price List

Start Date End Date List Price

12/31/04 6/30/05 $100

7/15/04 12/31/05 $105
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Within Product A, there are the price adjustments for Product A1 shown in Table 17. 

When you click the Verify Adjustments button, the pop-up applet contains the information shown in 
Table 18. 

This pop-up applet shows the gaps in the pricing information. During several time periods, there is 
no component price adjustment. Between 6/30/05 and 7/15/05, there is no list price, so the item 
has a price of zero. 

Table 17. Price Adjustments for Product A1 Within Product A

Start Date End Date Adjustment

1/31/05 6/25/05 10% discount

7/15/04 12/31/05 10% markup

Table 18. Verify Adjustments Output for Product A1

Start Date End Date Adjustment List Price Item Price

12/31/04 1/31/05 $100 $100

1/31/05 6/25/05 10% discount $100 $90

6/25/05 6/30/05 $100 $100

6/30/05 7/15/05 $0

7/15/05 12/31/05 10% markup $105 $115.50
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This chapter describes available pricing reports and provides procedures to run, create, and modify 
pricing reports. 

This chapter covers the following topics: 

■ “About Pricing Reports” 

■ “Descriptions of Available Reports” 

■ “Running Reports” on page 142 

■ “About Creating and Modifying Reports” on page 142 

About Pricing Reports
Siebel Pricer includes a standard set of predefined reports that supply pricing administrators with 
fundamental pricing information. You are not limited to using these basic reports. You can create 
additional reports or modify existing ones. 

Descriptions of Available Reports
This section described the available predefined pricing reports. 

Price Lists Report
Accessible from the Administration - Pricing > Price Lists view, this report provides a list of all price 
lists in the database. Because this is a summary report, it contains price list header data information, 
including the following information for each price list:

■ Price list name

■ Price list description

■ Base currency

■ Terms

■ Shipping methods

■ Effective dates

Price List-Based Price Book Report
Accessible from the Administration - Pricing > Price Lists view, this report shows line item (product-
specific) pricing information for the selected price list. 
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For each line item in the selected price list, this report includes the following:

■ Price list line item data

■ Attribute-based pricing data

■ Catalog data (product line, part number, vendor number)

■ Cost data

■ Margin percentage

■ Minimum and maximum sales price

NOTE: For products with components, only the price list line item data is included. Listing all the 
possible combinations of component product is not practical.

Running Reports
You can run all the reports described in this chapter in the same way. 

To run the Price Lists report

1 Navigate to the screen and view from which you access the report, as specified in the report’s 
description.

2 In the application-level menu, click the Reports icon and select the appropriate report. 

3 In the Reports dialog box, select the report name from the drop-down menu and click Run Now.

The selected report appears in the Siebel Report Viewer. 

4 You can print a copy of the report by clicking the printer icon.

About Creating and Modifying Reports 
You are not limited to working with these standard, predefined reports. The standard Siebel Pricer 
reports are part of a large set of Siebel application reports. You can modify these reports or add new 
reports in two locations: 

■ Siebel Tools. Use this location to define the data exported from the Siebel application to the 
Actuate report, and to attach reports to the Reports menus of specific views. 

■ Actuate e.Report Designer Professional. Use this location to define report behavior, 
appearance, and data acquisition. 

For information about defining and working with reports, see Siebel Reports Administration Guide. 
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Application
This chapter covers the ways that pricing affects the run-time application. Other chapters of this book 
covered how administrators set up pricing using the Administration - Pricing screen, the 
Administration - Promotions screen, and the Promotions view of the Administration - Product 
screen.For more information about how pricing affects quotes and orders, see Siebel Order 
Management Guide. 

This chapter includes the following topics: 

■ “Pricing Waterfalls” on page 143

■ “Contract-Based Pricing” on page 146

■ “Multiple Price Types and Totals” on page 148

■ “About Configuring Pricing Fields in Catalog, eSales, and Configurator” on page 149

■ “Multiple Currencies in a Quote, Order, or Agreement” on page 149

■ “Spread Discount Pricing” on page 150

■ “Totaling and Rollups of Pricing” on page 151

Pricing Waterfalls
The final net price that is charged to a customer is usually the result of many pricing adjustments. 
It begins with the product’s list price, and then adjusts the price because of volume discounts, 
attribute pricing, aggregate discount pricing, manual price adjustments entered by the sales 
representative, and many other possible types of price adjustments. 

The pricing waterfall lets the user see all the steps that went into calculating the net price. It is a list 
of prices that begins with the list price showing the price adjustments—in the order they were 
applied—with the price after each adjustment, ending with the final net price. 

Pricing waterfalls include any manual price adjustments that the sales representative entered at the 
time of sale, as well as price adjustments applied by the pricing engine. 
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The end user displays a pricing waterfall by clicking the net price in any line item of a quote, order, 
or agreement. A pop-up pricing waterfall applet appears that lists all the steps used to calculate the 
net price. The fields in each row of the pricing waterfall applet are described in Table 19. 

Configuring Pricing Waterfalls
To configure the pricing waterfall, you modify the pricing procedure used to display the waterfall. For 
more information about this pricing procedure and the PSP waterfall business service that it calls, 
see Appendix A, “Siebel Pricer Technical Reference.” 

For more information about working with pricing procedures and messages, see Siebel Order 
Management Infrastructure Guide. 

This section gives you general instructions about some common ways of configuring pricing 
waterfalls. 

Adding a New Pricing Waterfall 
To create a new pricing waterfall, follow these instructions: 

■ Create a new message type in the Administration - Application screen > Message Type 
Administration View as follows:

■ You must enter the name and full text of the message.

■ You can add translations for the full text if needed. 

■ Specify the payload variables that will be substituted in the full text in the Message Type Payload 
Administration view. 

Table 19. Pricing Waterfall Fields

Field Comment

Adjustment This field describes the price adjustment for this line, such as manual line 
item adjustment or volume discount. Alternatively, this field gives the list 
price or other start price and notes the price list it came from. 

Type This field displays the type of the adjustment. Examples are % Discount, 
Discount Amount, or Override. The start price is considered an override. 

Amount This field displays the value used by the adjustment, whose use depends on 
the adjustment type. For example, if the adjustment type is % Discount, 
and the Adjustment Amount is 15, the adjustment is a 15 percent discount. 
If the adjustment type is Discount Amount, and the Adjustment Amount is 
15, the adjustment is a discount of $15 (assuming the currency is dollars). 
If the adjustment type is Override, and the Adjustment Amount is 15, the 
adjustment is to replace the price with a price of $15 (assuming the 
currency is dollars). 

Price This field displays the current price in each step of the price calculation. In 
the first row, this is the start price. In the last row, it is the final net price.
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■ Add an action to a step in the pricing procedure that creates the waterfall record using the new 
message type, passing the required payload fields. 

■ Test the revised pricing procedure.

Adding a New Field to the Pricing Waterfall
You can add a new field to the information in each row of a waterfall. For example, you might want 
each row to include the approval level that was needed to give the discount in that row. 

To add a new field to the pricing waterfall, follow these instructions: 

■ Edit the pricing procedure and add the new field to actions that generate waterfall output. 

For example, to add the approval level as the last column of the waterfall, add it at the end of 
the standard actions that generate the waterfall, as follows:

{Row}.{Net Price Waterfall} += New('Waterfall', [Text] = LookUpMessage('Pricer - 

Dynamic Matrix Adjustment', [Price Book] = {Match.Price Book}), [Adjustment Type] = 

{Match.Adjustment Type}, [Adjustment Amount] = {Match.Adjustment Amount}, [Currency 

Code] = {Row.Currency Code}, [Price] = {Row.Start Price}, [Approval Level] = 

{Match.Approval Level})

■ Add the new field to the Net Price Waterfall VBC.

■ Add the new field to the Net Price Waterfall Pop-up List applet.

Saving Pricing Waterfall Output
In general, the pricing waterfall is generated on demand when the user clicks the Show Details 
button, instead of being stored in the database. When the record is repriced, the waterfall displays. 

You can save the waterfall to the database at any time by selecting a line item, and then clicking the 
Save Waterfall button in the Line Items list of a quote, order, or agreement. You can also configure 
the product to invoke the SyncToDB method of the PSP waterfall business service to save the 
waterfall for an entire document. 

However, writing the waterfall to the database can slow performance, so do it only if it is necessary. 
For example, you might save waterfalls to analyze the discounts you give customers, or to calculate 
incentive compensation. 

Configuration for Waterfalls
You must configure the Siebel application to create a user interface for viewing a stored waterfall. 

For more information about configuring Siebel applications, see Using Siebel Tools. For more 
information about configuring Siebel Pricer, see Siebel Order Management Infrastructure Guide. 
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Contract-Based Pricing 
Contract-based pricing is pricing based on an agreement with a customer to give that customer a 
special price. In Siebel applications, contracts are also called agreements and are managed in the 
Agreements screen. For general information about working with contracts, see the section about 
agreements in Siebel Field Service Guide. 

About Hierarchical Contract-Based Pricing
You can configure the product to create hierarchical contract-based pricing. 

After you have set up hierarchical contract-based pricing, if you give a pricing entitlement to a parent 
account, it will be inherited by all its children accounts. If you give a pricing entitlement to a child 
account, it will be combined with any entitlements for its parent account. 

For example, when you give a global account a 10 percent discount on all surgical products, you also 
give a local account that is a child of that global account a 10 percent discount on scalpels. When 
the child account buys scalpels, it has an entitlement for a 19 percent discount, because it inherits 
a 10 percent discount from its parent account. and also receives a 10 percent discount on the 90 
percent of the list price that it must pay after the inherited discount. 

For more information about configuring the product to create hierarchical contract-based pricing, see 
Siebel Order Management Infrastructure Guide. 

Defining Contract Pricing in the Agreements Screen
When you define contract pricing in the Agreements screen, the entitlement must be based on a 
customer account and on products. You create an agreement with an account, and you define the 
products for which that account will get special pricing.

For more information about other fields in the Agreements screen, see the section about agreements 
in Siebel Field Service Guide. 

To define contract pricing in the Agreements screen

1 Navigate to the Agreements screen. 

2 In the Agreements list, add a new record and complete the necessary fields. 

In the Account field, select the account for the customer who receives special pricing. 

3 Click the Entitlements view tab.

4 In the Entitlements list, add a new record and complete the necessary fields. 

In the Type field, select Pricing. 

5 Click the Price Details view tab, which is beneath the Entitlement list. 
Pricing Administration Guide Version 7.8, Rev. B146 



Pricing in the Run-Time Application ■ Contract-Based Pricing
6 Add one or more new records to the Price Details list and complete the necessary fields. Some 
fields are described in the following table. 

Defining Contract Pricing in the Discount Matrices View
Discount matrices allow you to manage pricing entitlements for products or groups of products in 
one view.

For more detailed information about creating a discount matrix, see Chapter 9, “Creating Discount 
Matrices.”

To define contract pricing in the Discount Matrices view

1 Navigate to the Administration - Pricing screen > Discount Matrices view. 

2 Add a new record to the Discount Matrices list and complete the necessary fields. 

In the Discount Matrix Type field, select Entitlement-Based Adjustment. 

3 In the Discount Criteria list, specify the fields that you want exposed in the discount matrix: 

a Add a field to identify the entitlement, such as Entitlement. 

b Add a field to identify the product or group of products, such as Product.

4 After all the fields are added, click Complete Definition. 

5 In the Discount Matrix list, click the name of the new discount matrix. 

Field Comments

Product Select the product for which this account gets a special price. 

Target Price Select the base price to which this special price is applied. 

Type of Calculation Select the type of special discount that this account receives. 
Options are Discount Amount, % Discount, Markup Amount, % 
Markup, and Price Override. 

Adjustment Value Select the value used by the calculation. How this value is used 
depends on the selection in the Type of Calculation field: 

■ Discount Amount. The value is subtracted from the target 
price. 

■ % Discount. The value is treated as a percentage, and that 
percentage is subtracted from the target price. 

■ Markup Amount. The value is added to the target price. 

■ % Markup. The value is treated as a percentage, and that 
percentage is added to the target price. 

■ Price Override. The value replaces the target price. 
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6 In the Discount Details list, add one or more records. 

In each record: 

a Select a value in the field that identifies the product. 

b Select a value in the field that identifies the entitlement. 

c Use the Adjustment Type and Adjustment Value to specify the adjustment that those products 
get when sold through that entitlement.

Giving the Customer the Best Entitlement Price
When a sales representative creates a quote for a customer who may have special contract-based 
pricing, the sales representative clicks the Entitle button to fill in the entitlements that apply to each 
line item. 

You must modify the pricing procedure to apply the discount based on the entitlement returned. The 
best entitlement pricing works only off of the list price. For more information, see Siebel Field Service 
Guide. 

To give the customer the best entitlement price

1 Create a quote or order, as described in Siebel Order Management Guide.

2 After adding all the line items, in the Quote Header form, click Entitle. 

In each line item where there is an entitlement that applies, the Entitlement Name field is filled 
in with the name of the entitlement. That entitlement is used to calculate pricing for that line 
item. 

Multiple Price Types and Totals
Multiple price types allow you to create simple products that have one of three price types. You can 
also create customizable products with components and assign a price type to each component and 
to the product root. Price Type is a required field when you define a product. 

The three price types are:

■ One-Time. This price is charged only once. For example, you assign this price type to a piece of 
equipment that the customer can purchase.

■ Recurring. This price is charged on a recurring basis. For example, you assign this price type to 
a service to which the customer subscribes. 

■ Usage. This price is charged based on customer consumption. For example, you assign this price 
type to an electric service that is billed by kilowatt hour of usage. The Usage price type is 
provided for information only and is not used in any price calculations.
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When a product has multiple price types, quotes and orders must also have multiple price totals—
one for charges of each price type and unit of measure. This is important because these different 
types of prices cannot be added up as one total, because they use different units of measure (each 
and per month).

About Configuring Pricing Fields in 
Catalog, eSales, and Configurator
In earlier versions, Siebel Catalog, eSales, and Configurator supported only two pricing fields. In 
version 7.8, they can be configured to add additional pricing fields. 

Without configuration, Siebel Catalog includes two pricing fields: List Price and Your Price for simple 
products, and Starting At Price and Your Price for customizable products. You can configure Siebel 
Catalog to add additional price fields. For more information about Siebel Catalog, see Siebel Order 
Management Guide. 

Without configuration, the Siebel eSales catalog and shopping cart both include the same two pricing 
fields as catalog. For more information about eSales, see Siebel eSales Administration Guide. 

Without configuration, Siebel Configurator includes two pricing fields: Starting At Price and Your 
Price. You can configure these by changing the configurator template. For more information about 
Configurator, see Product Administration Guide. 

Multiple Currencies in a Quote, Order, or 
Agreement
One quote, order, or agreement can include prices from multiple price lists that are in different 
currencies, because the sales representative can use a different price list for an individual line item, 
if necessary. 

In the header, when a user selects the price list, the currency of that price list is automatically 
entered in the Currency field. All totals for the quote, order, or agreement are in this currency. 

In the line items, the default price list is the one selected in the header. However, users can select a 
currency in the line item, and the line item will use the price list for that currency. Users work with 
currencies by using the fields described in Table 20.

For more information, see the section on creating quotes and orders in Siebel Order Management 
Guide.

Table 20. Fields Used to Work with Multiple Currencies

Field Comment

Currency Code Enter the code for the currency. 

Exchange Date Enter the date used for currency conversion. The system uses the exchange 
rate on that day to convert currencies. 
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Spread Discount Pricing
When sales representatives apply a manual discount to the total price of an order, they can spread 
that discount among the line items of the order. Because products can be defined with multiple price 
types, spread discount pricing must consider price types. Spread discount pricing spreads the 
discount to one-time charges only, not to recurring or usage charges. 

Spread discounting performs any needed currency conversions. Users can specify the amount of the 
discount in a given currency. When it is spread among line items, the discount is converted to the 
currency in each line item. 

For more information about end users and spread discounting, see the section about spreading a 
discount among line items in Siebel Order Management Guide. 

For more information useful to developers, see: 

■ “About the Spread Discount Algorithm” on page 150

■ “About Use of the Spread Discount Service with Pricing Procedures” on page 151

■ “About Configuring the Spread Discount Source Field” on page 151

About the Spread Discount Algorithm
This section contains a high-level description of the algorithm used by the spread discount service: 

■ Get the BasePrice (List Price or Net Price). 

■ Convert all prices (BasePrice, Min, Max) to BaseCurrency. (Defaults to system, but user chooses 
from dialog box.)

■ Add up all BasePrices up (multiplying each by Qty) to get TotalBasePrice. 

■ Get TargetPrice (calculated from AmtToDiscount or PercentToDiscount if necessary). 

■ Calculate total to discount: TotalToDiscount = TotalBasePrice – TargetPrice.

■ Loop through the discounts one at a time:

■ Loop through all Rows that have not reached min/max

❏ Discount each amount by (BasePrice/TotalBasePrice)*TotalToDiscount

❏ If that discount pushes price beyond min/max: (1) Set the final price of item to its min/
max (2) Remove that row from further discounts

■ After round completes, make adjustment so maxed out rows are not taken into account in 
the next round’s calculation. For each of these rows: 

❏ Its BaseValue*Qty will be subtracted from TotalBasePrice

❏ Its DiscountAmt*Qty will be subtracted from TotalToDiscount

■ Looping continues until: 

❏ TotalToDiscount can be spread evenly across all remaining line items, or

❏ All items have been discounted to their respective min/max
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■ Loop through all rows to convert each back to the line item currency and to round each to line 
item precision. 

■ Add up rounding remainders and amount discounted. 

■ The rounding remainder is added to element with highest BasePrice*Qty that has not already 
reached its min/max.

■ This continues until the rounding remainder rounds to 0 or until no items can be discounted 
further. 

About Use of the Spread Discount Service with Pricing 
Procedures
When an end user clicks the Spread button, the following occurs:

■ One signal is raised to invoke the workflow process Spread Discount Driver Workflow process, 
which uses the business service ISS Spread Discount Service in one of its steps. 

■ After this is done, another signal is raised to invoke the workflow process Dynamic Pricing 
Procedure.

To use the spread discount service with custom pricing procedures, you should raise signals to call 
the workflows in this order. 

About Configuring the Spread Discount Source Field
When an end user uses spread discount, the list of values for the source field has two values—list 
price and net price. List price is the default value.

If you configure the application to add a new value to this list of values, you must make sure the 
new field is in the row set variable map for the spread discount Spread Discount Variable Map - Row 
Set. 

For more information about variable maps, see Siebel Order Management Infrastructure Guide. 

Totaling and Rollups of Pricing
Price totals and rollups consider price types:

■ Totals and rollups include one-time and recurring prices. 

■ Totals and rollups do not include usage prices, because the price is not known until the 
customer’s usage is known. 

This information about totals is displayed in the one-time charge total and monthly charge total fields 
of quote, order, and agreement headers. 

Users can specify the currency for the total or rollup, after which the application performs the 
currency conversions to calculate the total from line items in different currencies. 
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A Siebel Pricer Technical 
Reference
This chapter is a technical reference explaining how Siebel Pricer works. It includes the following 
topics: 

■ “Siebel Pricer Architecture” on page 153

■ “Pricing Procedures and Workflow References” on page 155

■ “Miscellaneous Pricing Workflows” on page 176

Siebel Pricer Architecture
A high-level representation of the Siebel Pricing Management Architecture is shown in Figure 14. This 
diagram includes four key components:

■ Siebel UI/Calling Application. This is the point from which the end user requests pricing (for 
example, quotes and orders).

■ Pricing Data. This is the administrative business objects that store prices, costs, and 
adjustments. 

■ Pricing Procedures. This is the centralized location for pricing policies and logic. Pricing 
procedures use the PSP engine to locate and apply prices and adjustments, and you can 
customize them for your company's business model. For details about the PSP Engine, see Siebel 
Order Management Infrastructure Guide.

■ Pricing Services. This is the specialized business services for generic, complex pricing 
algorithms (such as spread discount).

Figure 14. Pricing Architecture
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When there is a request for pricing (for example, when a user adds a product to a quote or order or 
selects Reprice All), the application performs the following steps, illustrated in Figure 15:

■ The end user action raises a signal, such as the CalculatePriceAll signal. A signal is a 
parameterized call to a business service or workflow process. For more information about signals, 
see Siebel Order Management Infrastructure Guide.

■ The signal calls the controlling workflow process. To continue the previous example, the 
CalculatePriceAll signal calls the PSP Driver Workflow process. For more information about this 
workflow process, see “Pricing Procedures and Workflow References” on page 155. 

■ The controlling workflow process uses variable maps to build the Context Row Set (header 
information) and Line Item Row Set (line item information).

■ The variable maps that build the row sets needed for pricing are identified in the definition 
of the signal invoked by the end user’s action. To continue the previous example, the Default 
Pricing Variable Map - Context and Default Pricing Variable Map - Row Set are specified as 
parameters to the PSP Driver Workflow process in the CalculatePriceAll Signal.

■ Variable maps build the row sets by mapping fields in the database to the variables for the 
row set. For more information about variable maps, see Siebel Order Management 
Infrastructure Guide. 

■ The controlling workflow process invokes a pricing procedure.

■ The pricing procedure invoked is identified in the definition of the signal invoked by the end 
user’s action. To continue the previous example, the Dynamic Pricing Procedure workflow is 
specified in the SubPSPWFName parameter to the PSP Driver Workflow process in the 
CalculatePriceAll Signal.

■ The controlling workflow passes the Context Row Set and Line Item Row Set to the pricing 
procedure. For more information about controlling workflows and pricing procedures, see 
Siebel Order Management Infrastructure Guide. 

■ The pricing procedure applies pricing logic to the data in the row sets. 

■ To continue the previous example, for each line item in the line item row set, the dynamic 
pricing procedure finds a starting price, executes a series of steps that may or may not adjust 
the net price, and outputs the final price.

■ The dynamic pricing procedure passes the transformed Row Set back to the PSP Driver 
Workflow process. For detailed information about pricing procedures, see “Pricing Procedures 
and Workflow References” on page 155. 
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■ The Context Service updates the calling object (such as the quote or order) with the adjusted 
prices, and those prices appear in the end user interface. 

Pricing Procedures and Workflow 
References
To price products, Siebel Pricer uses the following workflows and pricing procedures: 

■ “PSP Driver Workflow Process Workflow” on page 155

■ “Basic Pricing Procedure Workflow” on page 156

■ “Dynamic Pricing Procedure Workflow” on page 165

■ “Pricing Procedure - Calculate Net Price Workflow” on page 171

■ “Pricing Procedure - Aggregate Discounts Workflow” on page 174

■ “Pricing Procedure - Service Workflow” on page 175

PSP Driver Workflow Process Workflow
The PSP Driver Workflow Process is the beginning of all pricing operations and other features. For 
information about this workflow, see Siebel Order Management Infrastructure Guide. 

Figure 15. Overview of How Pricing Works
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Basic Pricing Procedure Workflow
The Basic Pricing Procedure workflow provides basic pricer license functionality where the list price, 
volume discounts, and service pricing are supported. 

Workflow Description. This workflow does the following:

1 Stamps error codes by checking for various conditions on the Price list.

2 From the error codes stamped in step 2, branches out to the different actions listed in step 4.

3 Does the following:

a Raises Expired Error

b Raises Not Expired Error

c Calculates the quantity of each component in a customizable product instance, and rolls down 
the price list ID and promotion ID from the root.

4 Determines the price action code based on the item’s Action Code and Price Type.

5 Using the Simple Look-up Transform business service, searches for the correct price list and 
stamps various price fields on the line item. 

6 Gets Root Price List Item Id|Start = List|Net = Start.

7 Splits Unpriced Actions. 

NOTE: Do not price line items with Skip Pricing Flag = 'Y'. 

Figure 16. Basic Pricing Procedure Workflow
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8 Splits service and nonservice line items so they can be priced separately. 

NOTE: In this Pricing Procedure, products and service products need to be split and handled 
differently. Service procedures are really services that are tied to products, for example a 
maintenance service on a car. The pricing of a service is tied to the product it covers. Later in 
the this workflow, steps named " XXX service Pricing" will consume the Service Product Row Set. 

9 Applies the volume discount adjustment that matches the quantity on the line item.

10 Finds out the upsell discount information.

11 Applies tiered volume discounts to the net price.

12 Finds out the tiered upsell discount information.

13 Forces the net price to be within the minimum and maximum values defined in the price list item.

14 Sets the manual adjustment and applies line item and header-level manual discounts.

15 Sets the pricing adjustment. Before adjustments and discounts, the Net Price = Start Price.

16 Updates the net price for any covered products that were repriced.

17 Looks up the list price information for covered products.

18 Calculates the start price for the service product by applying the percentage in the price list item 
to the net or start price of the covered product.

19 Before adjustments and discounts, ensures that the Net Price = Start Price.

20 Applies the volume discount adjustment that matches the quantity on the line item.

21 Determines the upsell discount information.

22 Applies tiered volume discounts to the net price.

23 Determines the tiered upsell discount information.

24 Forces the net price to be within the minimum and maximum values defined in the price list item.

25 Applies line item and header-level manual discounts.

26 Before adjustments and discounts, ensures that the Net Price = Start Price.

27 Merges service and nonservice line items.

28 Merges unpriced line items.

29 Gets the MPT Prices and the NRC and MRC price components.

30 Spreads discounts from bundle product root to subcomponents.

31 Calculates the total extended price of the customizable product, including all subcomponents.

Table 21 lists the steps in the Basic Pricing Procedure with the business service and method that is 
called by each.
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Table 21. Steps of the Basic Pricing Procedure Workflow

Name Type Business Service Method
Sub 
Process Description

Check Header 
Price List 

Business 
Service

Row Set 
Transformation Toolkit 
Service

Query 
Transform

Stamps error
codes by 
checking for 
various 
conditions on
the Price list.

Price List Error From the erro
codes stampe
in step 1, 
branches out
different actio
in the next st

Raise Expired 
Error

Business 
Service

Pricing Manager Raise Price 
List Expired 
Error

Halts executi
and provides 
error messag
to the user if t
header Price 
List is expired

Raise Not 
Effective Error

Business 
Service

Pricing Manager Raise Price 
List Not 
Effective Error

Halts executi
and provides 
error messag
to the user if t
header Price 
List is not ye
effective.

Customizable 
Product Roll-
Down

Business 
Service

Row Set 
Transformation Toolkit 
Service

Hierarchical 
Transform

Calculates th
quantity of ea
component in
customizable
product 
instance. Rol
down the pric
list ID and 
promotion ID
from the root

Determine Price 
Action

Determines t
price action 
code based o
the item Acti
Code and Pric
Type.
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Get List Price Business 
Service

Row Set 
Transformation Toolkit 
Service

Hierarchical 
Transform

Gets the list 
price for each
row in the ro
set. Appends
other values 
from the pric
list item 
Buscomp to t
row.

Get Root Price 
List Item 
Id|Start = 
List|Net = Start

Split Unpriced 
Actions

Business 
Service

Row Set 
Transformation Toolkit 
Service

Split Moves servic
products from
the row set in
another row s
for use in the
service pricin
subprocedure

Split Service 
Products

Business 
Service

Row Set 
Transformation Toolkit 
Service

Splits service
and nonservi
line items so 
they can be 
priced 
separately. 
(Note: Later 
the workflow
steps named
XXX service 
Pricing" woul
consume the
Service Produ
Row Set).

Simple Volume 
Discount for 
Keep Price <> Y

Applies the 
volume discou
adjustment th
matches the 
quantity on t
line item.

Table 21. Steps of the Basic Pricing Procedure Workflow

Name Type Business Service Method
Sub 
Process Description
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Split Service 
Products

Business 
Service

Row Set 
Transformation Toolkit 
Service

Splits service
and nonservi
line items so 
they can be 
priced 
separately. 
(Note: Later 
the workflow
steps named
XXX service 
Pricing" woul
consume the
Service Produ
Row Set).

Simple Volume 
Discount for 
Keep Price <> Y

Applies the 
volume discou
adjustment th
matches the 
quantity on t
line item.

Simple Volume 
Discount Upsell 
for Keep Price 
<> Y

This is a step
find out upse
discount 
information.

Tiered Volume 
Discount for 
Keep Price <> Y

Applies tiered
volume 
discounts to t
Net Price.

Tiered Volume 
Discount Upsell 
for Keep Price 
<> Y

This is a step
find out tiere
upsell discou
information.

Check Min / Max 
Price for Keep 
Price <> Y

Forces the Ne
Price to be 
within the 
Minimum and
Maximum 
defined in the
price list item

Table 21. Steps of the Basic Pricing Procedure Workflow

Name Type Business Service Method
Sub 
Process Description
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Manual 
Adjustment

Applies line it
and header-
level manual 
discounts.

Set Pricing 
Adjustment

Business 
Service

Row Set 
Transformation Toolkit 
Service

Split 
Transform

Before 
adjustments 
and discount
Net Price = 
Start Price.

Update Covered 
Product Net 
Prices

Business 
Service

Row Set 
Transformation Toolkit 
Service

Row Set

Lookup 
Transform

Updates the n
price for any 
covered 
products that
were repriced

Get Covered 
Product List Price

Looks up list 
price 
information f
the covered 
product.

Update Covered 
Product Net 
Prices

Business 
Service

Row Set 
Transformation Toolkit 
Service

Row Set

Lookup 
Transform

Updates the n
price for any 
covered 
products that
were repriced

Get Covered 
Product List Price

Looks up list 
price 
information f
the covered 
product.

Calculate 
Covered Product 
Service Price

Calculates th
Start Price fo
service produ
by applying t
percentage in
the price list 
item to the N
or Start Price
the covered 
product.

Table 21. Steps of the Basic Pricing Procedure Workflow

Name Type Business Service Method
Sub 
Process Description
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Net = 
Start:Service 
Price

Before 
adjustments 
and discount
Net Price = 
Start Price.

Update Covered 
Product Net 
Prices

Business 
Service

Row Set 
Transformation Toolkit 
Service

Row Set

Lookup 
Transform

Updates the n
price for any 
covered 
products that
were repriced

Get Covered 
Product List Price

Looks up list 
price 
information f
the covered 
product.

Calculate 
Covered Product 
Service Price

Calculates th
Start Price fo
service produ
by applying t
percentage in
the price list 
item to the N
or Start Price
the covered 
product.

Net = 
Start:Service 
Price

Before 
adjustments 
and discount
Net Price = 
Start Price.

Simple Volume 
Discount for 
Keep Price <> 
Y:Service Price

Applies the 
volume discou
adjustment th
matches the 
quantity on t
line item.

Simple Volume 
Discount Upsell 
for Keep Price 
<> Y:Service 
Price

This is a step
find out upse
discount 
information.

Table 21. Steps of the Basic Pricing Procedure Workflow

Name Type Business Service Method
Sub 
Process Description
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Tiered Volume 
Discount for 
Keep Price <> 
Y:Service Price

Applies tiered
volume 
discounts to t
Net Price.

Tiered Volume 
Discount Upsell 
for Keep Price 
<> Y:Service 
Price

Tiered Volum
Discount Ups
for Keep Pric
<> Y:Service
Price.

Check Min / Max 
Price for Keep 
Price <> 
Y:Service Price

Forces the Ne
Price to be 
within the 
Minimum and
Maximum 
defined in the
price list item

Simple Volume 
Discount for 
Keep Price <> 
Y:Service Price

Applies the 
volume discou
adjustment th
matches the 
quantity on t
line item.

Manual 
Adjustment:Serv
ice Price

Applies line it
and header-
level manual 
discounts.

Set Pricing 
Adjustment:Serv
ice Price

Before 
adjustments 
and discount
Net Price = 
Start Price.

Merge Service 
Products

Business 
Service

Row Set

TransformationToolkit 
Service

Merge 
Transform

Merges servic
and nonservi
line items.

Merge Unpriced 
Actions

Business 
Service

Row Set

TransformationToolkit 
Service

Hierarchical 
Transform

Merges the 
priced and 
unpriced row
sets into one

Table 21. Steps of the Basic Pricing Procedure Workflow

Name Type Business Service Method
Sub 
Process Description
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Get MPT Prices Business 
Service

Row Set

TransformationToolkit 
Service

Conditional 
Action 
Transform

Gets NRC and
MRC price 
components.

Roll-Down 
Bundle Prices

Business 
Service

Row Set

Transformation Toolkit 
Service

Hierarchical 
Transform

Spreads the 
discount from
the bundle 
product root 
subcomponen
.

Customizable 
Product Roll-Up

Business 
Service

Row Set

Transformation Toolkit 
Service

Hierarchical 
Transform

Calculates th
total extende
price of the 
customizable
product 
including all 
subcomponen
.

Table 21. Steps of the Basic Pricing Procedure Workflow

Name Type Business Service Method
Sub 
Process Description
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Dynamic Pricing Procedure Workflow
The Dynamic Pricing Procedure workflow provides the advanced pricing capabilities. It contains steps 
and subprocedures that populate the List Price, Start Price, and Net Price fields. It also calculates 
the monthly recurring and nonrecurring subtotals for root Customizable Products. These prices and 
subtotals are calculated based on information from price lists, customizable product adjustments, 
volume discounts, attribute adjustments, aggregate discounts, service price details, product 
promotions, and manual discounts.

NOTE: The Dynamic Pricing Procedure replaces the Pricing Procedure - Default.

Workflow Description. This workflow does the following:

1 Checks for price list effectivity. The application will throw any error if the price list is not yet 
effective or has expired. 

2 Calculates the extended quantity of all component products of a CP instance. Also, it carries over 
some useful information from the CP root to CP components for later use.

3 Gets the list price for each row in the row set, and appends other values from the Price List Item 
Buscomp to the row.

4 Puts the CP Root Price List Item Id on each component of the CP for later use.

5 Moves those rows with an action code that should not be priced to another row set that will not 
be priced throughout the procedure.

6 Gets CP Pricing Designer adjustments for components of a CP.

7 Initializes the start price value as the list price value.

Figure 17. Dynamic Pricing Procedure Workflow Process
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8 Applies attribute adjustments to the start price and throws an error when an invalid combination 
for attribute pricing occurs.

9 Moves service products from the row set into another row set for use in the service pricing 
subprocedure.

10 Calls subprocedure Pricing Procedure - Calculate Net Price for nonservice products.

11 Updates the covered product net price field on the service product rows in the row set.

12 Calls subprocedure Pricing Procedure – Service to handle the service product-specific pricing for 
service products.

13 Calls subprocedure Pricing Procedure - Calculate Net Price for service products.

14 Merges the service and nonservice row sets into one row set.

15 Establishes the NRC and MRC prices for one-time and monthly recurring price types, which will 
later be used for Customizable Product Rollup.

16 Merges the priced and unpriced row sets into one row set.

17 Spreads the discount of the root bundle products to the bundle component products.

18 Rolls up the prices of component products to the CP root.

Table 22 lists the steps in the Dynamic Pricing Procedure workflow with the business service and 
method that is called by each. 

Table 22. Steps of the Dynamic Pricing Procedure Workflow

Name Type
Business 
Service Method

Sub 
Process Description

Check Header 
Price List

Business 
Service

Row Set 
Transformation 
Toolkit Service

Query 
Transform

Determines if the 
header price list is 
expired or not yet 
effective.

Raise Expired 
Error

Business 
Service

Pricing 
Manager

Raise Price 
List Expired 
Error

Halts execution and 
provides an error 
message to the user if 
the header Price List is 
expired.

Raise Not 
Effective Error

Business 
Service

Pricing 
Manager

Raise Price 
List Not 
Effective Error

Halts execution and 
provides an error 
message to the user if 
the header Price List is 
not yet effective.

Customizable 
Product Roll-
Down

Business 
Service

Row Set 
Transformation 
Toolkit Service

Hierarchical 
Transform

Calculates the 
quantity of a 
component product of 
a CP instance.
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Get List Price Business 
Service

Row Set 
Transformation 
Toolkit Service

Simple Look-
Up Transform

Gets the list price for 
each row in the row 
set. Appends other 
values from the price 
list item Buscomp to 
the row.

Get Root Price 
List Item Id

Business 
Service

Row Set 
Transformation 
Toolkit Service

Hierarchical 
Transform

Puts the CP root price 
list item ID on each 
component of the CP 
for later use.

Split Unpriced 
Actions

Business 
Service

Row Set 
Transformation 
Toolkit Service

Split 
Transform

Moves those rows with 
an action code that 
should not be priced 
to another row set 
that will not be priced 
throughout the 
procedure.

Customizable 
Product 
Adjustment

Business 
Service

Row Set 
Transformation 
Toolkit Service

Simple Look-
Up Transform

Gets CP adjustments 
for components of a 
CP.

Start = List Business 
Service

Row Set 
Transformation 
Toolkit Service

Conditional 
Action 
Transform

Initializes the start 
price value as the list 
price value.

Matrix 
Adjustment

Business 
Service

Row Set 
Transformation 
Toolkit Service

Dynamic 
Lookup 
Transform

Applies attribute 
adjustments to the 
start price.

Invalid 
Combination?

Decision 
Point

Determines if there 
was an invalid 
combination for the 
attribute pricing 
matrix.

Display 
Invalid 
Combination 
Error

Business 
Service

Dynamic 
Matrix 
Retrieval 
Service

Throw Invalid 
Combination 
Error

Halts execution of 
procedure and throws 
an error when an 
invalid combination 
for attribute pricing 
occurs.

Table 22. Steps of the Dynamic Pricing Procedure Workflow

Name Type
Business 
Service Method

Sub 
Process Description
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Split Service 
Products

Business 
Service

Row Set 
Transformation 
Toolkit Service

Split Moves service 
products from the row 
set into another row 
set for use in the 
service pricing 
subprocedure.

Discount Non 
Service 
Products

Sub 
Process

Pricing 
Procedure 
– Calculate 
Net Price

Update 
Covered 
Product Net 
Prices

Business 
Service

Row Set 
Transformation 
Toolkit Service

Row Set 
Lookup 
Transform

Updates the covered 
product net price field 
on the service product 
rows in the row set.

Price Service 
Products

Sub 
Process

Pricing 
Procedure 
– Calculate 
Net Price

Prices the service 
product row set.

Discount 
Service 
Products

Sub 
Process

Pricing 
Procedure 
– Service

Service Pricing.

Merge Service 
Products

Business 
Service

Row Set 
Transformation 
Toolkit Service

Merge 
Transform

Merges the service 
and nonservice row 
sets into one.

Get MPT 
Prices

Business 
Service

Row Set 
Transformation 
Toolkit Service

Conditional 
Action 
Transform

Establishes the NRC 
and MRC prices for 
One-Time and 
Monthly Recurring 
price types.

Merge 
Unpriced 
Actions

Business 
Service

Row Set 
Transformation 
Toolkit Service

Merge 
Transform

Merges the priced and 
unpriced row sets into 
one.

Roll-down 
bundle prices

Business 
Service 

Row Set 
Transformation 
Toolkit Service

Hierarchical 
Transform

Spreads the discount 
of the root bundle 
products to the child 
products.

Customizable 
Product Roll-
ups

Business 
Service

Row Set 
Transformation 
Toolkit Service

Hierarchical 
Transform

Rolls up the prices of 
component products 
to the CP root.

Table 22. Steps of the Dynamic Pricing Procedure Workflow

Name Type
Business 
Service Method

Sub 
Process Description
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Switching from Basic to Dynamic Pricing Procedure 
It is possible to switch from the Basic Pricing Procedure to the Dynamic Pricing Procedure, depending 
on your requirements.

The Basic Pricing Procedure is enabled out of the box. It does the following:

■ Duplicates the 7.7 basic pricer license functionality where only the list price, volume discounts, 
and service pricing are supported.

■ Uses the variable maps that do not contain the XA child variable maps.

The Dynamic Pricing Procedure is not enabled for out of the box execution. If you have the Dynamic 
Pricer license, follow the steps in “Dynamic Pricing Procedure Workflow” in this section to enable 
Dynamic Pricing Procedure for your system.This procedure does the following:

■ Uses the variable maps that contain the XA child variable maps.

■ Provides complete pricing capabilities such as attribute pricing, promotions, aggregate discounts 
and so on.

The following workflow shows the impact to signals and variable maps when switching from the Basic 
Pricing Procedure to the Dynamic Pricing Procedure.

1 Name. Change the procedure name to Dynamic Pricing Procedure.

2 Variable Maps. Three new variable maps are created for the rowsets.

■ Default Pricing Variable Map - Row Set-Basic

■ Product Pricing Variable Map - Row Set-Basic

■ Default Pricing Eligibility Variable Map - Row Set - Basic

3 Signals - New Parameter.The signals in the following list have a new signal parameter, 
SubPSPPricingWFName, with a value Basic Pricing Procedure.

■ CalculatePriceAndCheckEligibility

(Uses the Default Pricing Eligibility Variable Map - Row Set - Basic variable map)

■ QuotesAndOrdersValidate 

(Uses Default Pricing Eligibility Variable Map - Row Set - Basic variable map)

■ VerifyItem

(Uses Default Pricing Eligibility Variable Map - Row Set - Basic variable map)

■ Product Recommendations 

■ CalculatePriceExternal

■ SpreadDiscount

■ SpreadDiscount - All

NOTE: Some of these signals have multiple actions and the appropriate actions (parameters) 
were modified.
Pricing Administration Guide Version 7.8, Rev. B 169



Siebel Pricer Technical Reference ■ Pricing Procedures and Workflow References
4 Signals - Modified. The signals in the following list have been modified so that the parameter 
SubPSWFName has the value Basic Pricing Procedure. Also, the variable map points to Default 
Pricing Variable Map - Row Set - Basic.

■ ApproveItem

■ CalculatePrice

■ CalculatePriceAll

■ CalculatePriceAll_eSales

■ CalculatePrice_Configurator

■ CalculatePrice_eSales

■ MergeIntoOnePackage

■ OrderTemplate

■ OrderTemplateCopy

■ QuoteTemplateSelectItems

■ SetFieldValue

NOTE: Some of these signals have multiple actions and the appropriate actions (parameters) 
were modified.

5 The signals in the following list have been modified so that the parameter SubPSWFName has 
the value Dynamic Pricing Procedure. 

■ CalculatePriceProdProm

■ CalculateUserPriceProm

NOTE: Promotions require the Dynamic Pricing Procedure and will not return any discounts if the 
Basic Pricing Procedure is used.

6 The signals in the following list have been modified so that the parameter SubPSWFName has 
the value Basic Pricing Procedure. Also, the variable map points to Product Pricing Variable Map 
- Row Set - Basic.

■ GetProdPrice

■ GetUserProdPrice

7 For the PDS GetPricing signal, the action service has been changed to execute the Dynamic 
Pricing Procedure.

8 For the CalculatePriceAndCheckEligibility signal, the variable map points to Default Pricing 
Eligibility Variable Map - Row Set - Basic.
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Pricing Procedure - Calculate Net Price Workflow
The Pricing Procedure - Calculate Net Price workflow is responsible for the net price calculation, which 
takes into account volume discount, aggregate discount sequence, product promotion, manual 
adjustment and minimum/maximum price bound checks.

Workflow Description. This workflow does the following:

1 Initializes the net price value as the start price value.

2 Queries in FS Product Price Item Details Buscomp for any covered asset service pricing 
adjustment. 

3 Moves those rows with the Exclude Pricing flag set to another the Keep Price Row Set row set. 
This will skip all system-generated discounts throughout the procedure.

4 Applies a manual adjustment (discount amount, discount percentage, discount price and header 
discount percentage) for the row set with Exclude Pricing flag Set. 

5 Sets the pricing adjustment that indicates the total amount of system-generated discount 
accounts for the row set with Exclude Pricing flag = Y.

6 Evaluates simple and tiered volume discount. This would also populate the next discount and 
upsell message for upsell purposes.

7 Evaluates product promotion discounts.

8 Calls the Pricing Procedure - Bundle Discount subprocedure to evaluate the aggregate discount 
sequence.

9 Checks if the current net price is within the boundary of the minimum and maximum price. 

10 Applies a manual adjustment (discount amount, discount percentage, discount price and header 
discount percentage).

11 Sets the pricing adjustment that indicates the total amount of system-generated discount 
accounts.

12 Merges the two row sets generated from the Keep Price = Y? back into one row set.

Figure 18. Pricing Procedure - Calculate Net Price Workflow Process
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Table 23 lists the steps of the Pricing Procedure - Calculate Net Price workflow with the business 
service and method that is called by each. 

Table 23. Steps of the Pricing Procedure - Calculate Net Price Workflow

Name Type
Business 
Service Method

Sub 
Process Description

Net = Start Business 
Service

Row Set 
Transformation 
Toolkit Service

Conditional 
Action 
Transform

Initializes the Net 
Price value as the 
Start Price value.

Calculate 
Covered Asset 
Service Price

Business 
Service

Row Set 
Transformation 
Toolkit

Simple Look-
Up Transform

Queries in FS 
Product Price Item 
Details Buscomp for 
any covered asset 
service pricing 
adjustment. 

Keep Price = Y? Business 
Service

Row Set 
Transformation 
Toolkit

Split 
Transform

Moves those rows 
with Exclude Pricing 
Flag set to another 
row set, the Keep 
Price Row Set row 
set. For these, all 
system-generated 
discounts will be 
skipped throughout 
the procedure.

Manual 
Adjustment for 
Keep Price = Y

Business 
Service

Row Set 
Transformation 
Toolkit Service

Conditional 
Action 
Transform

Applies Manual 
Adjustment for 
Keep Price Row Set 
row set. 

Set Pricing Adj 
for Keep Price = 
Y

Business 
Service

Row Set 
Transformation 
Toolkit Service

Conditional 
Action 
Transform

Sets the Pricing 
Adjustment that 
indicates the total 
amount of system-
generated 
discounts for the 
Keep Price Row Set 
row set. 

Simple Volume 
Discount

Business 
Service

Row Set 
Transformation 
Toolkit Service

Simple Look-
Up Transform

Evaluates Simple 
Volume Discount.

Simple Volume 
Discount Upsell

Business 
Service

Row Set 
Transformation 
Toolkit Service

Simple Look-
Up Transform

Populates Simple 
Volume Discount 
Upsell information.
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Tiered Volume 
Discount

Business 
Service

Row Set 
Transformation 
Toolkit Service

Simple Look-
Up Transform

Evaluates Tiered 
Volume Discount.

Tiered Volume 
Discount Upsell

Business 
Service

Row Set 
Transformation 
Toolkit Service

Simple Look-
Up Transform

Populates Tiered 
Volume Discount 
Upsell information. 

Look-Up 
Promotion 
Discount

Business 
Service

Row Set 
Transformation 
Toolkit Service

Simple Look-
Up Transform

Checks whether a 
promotion discount 
is defined. 

Apply 
Promotion 
Discount

Business 
Service

Row Set 
Transformation 
Toolkit

Conditional 
Action 
Transform

Applies the 
Promotion Discount 
found in the 
previous step.

Apply Bundle 
Discounts

Sub 
Process

Pricing 
Procedure - 
Aggregate 
Discounts

Invokes a 
subprocedure for 
calculating 
Aggregate 
Sequence.

Check Min/Max 
Price

Business 
Service

Row Set 
Transformation 
Toolkit Service

Conditional 
Action 
Transform

Ensures that the net 
price is within the 
minimum and 
maximum defined 
in the price list 
item.

Manual 
Adjustment

Business 
Service

Row Set 
Transformation 
Toolkit

Conditional 
Action 
Transform

Applies manual 
adjustment.

Set Pricing 
Adjustment

Business 
Service

Row Set 
Transformation 
Toolkit Service

Conditional 
Action 
Transform

Sets the pricing 
adjustment, which 
is the total amount 
of system- 
generated 
discounts.

Merge Keep 
Price = Y

Business 
Service

Row Set 
Transformation 
Toolkit

Merge 
Transform

Merges back the 
Keep Price Row Set 
row set.

Table 23. Steps of the Pricing Procedure - Calculate Net Price Workflow

Name Type
Business 
Service Method

Sub 
Process Description
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Pricing Procedure - Aggregate Discounts Workflow
The Pricing Procedure - Aggregate Discounts workflow is the subprocedure that evaluates the 
Aggregate Discount Sequence adjustment. The workflow first aggregates quantities for each product 
across line items. It then checks if there are possible aggregate discounts set up by examining the 
price list on both the header and line item level.

The workflow then compares the aggregate discount with the product quantity aggregation it has 
evaluated earlier to see if it qualifies for any discounts.

Workflow Description. This workflow does the following:

1 Groups line items by Product ID and performs a quantity aggregation. The result of this operation 
is a property set with Product ID and corresponding aggregated quantities.

2 Uses Query Transformation to check if there is an Aggregate Discount Sequence associated with 
the price list from the header, and whether that Aggregate Discount Sequence is effective. If all 
conditions are met, then the list of IDs of all the aggregate discounts under that sequence would 
be stored in a property set. 

3 This step is similar to the previous one except that it examines the Price List association of the 
line item. The IDs of all the possible aggregate discounts would be appended to the previously 
mentioned property set. 

4 Using Rule Set Lookup Transformation and the information from previous steps, it identifies 
which of the possible aggregate discounts are satisfied along with the corresponding multiplier 
for each aggregate discount. This information is used as input to the next step.

5 Using Rule Set Lookup Transformation and the information from previous steps, it applies 
adjustments defined in the applicable aggregate discounts and put that on each of the line item. 
Line items having the same product would be ordered by their net price. Line items with a higher 
net price would have priority over items with a lower net price.

Figure 19. Pricing Procedure - Bundle Discount Workflow Process
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Table 24 lists the steps in the Pricing Procedure - Aggregate Discounts workflow with the business 
service and method that is called by each.

Pricing Procedure - Service Workflow
This workflow adjusts the start prices for service products by taking account their covered products 
and primary covered assets.

Workflow Description. This workflow does the following:

1 Looks up list price information for covered products. 

2 Calculates the start price for a service product by applying the percentage in the Price List Item 
Buscomp to the net price or start price of the covered product.

Table 24. Steps of the Pricing Procedure - Aggregate Discounts Workflow

Name Type
Business 
Service Method

Sub 
Process Description

Sum Product 
Quantity

Business 
Service

Row Set 
Transformation 
Toolkit

Aggregate 
Transform

Sums up quantities of 
line items by Product ID. 

Get Possible 
Bundles 
(Price List)

Business 
Service

Row Set 
Transformation 
Toolkit Service

Query 
Transform

Checks for the Aggregate 
Discount Sequence 
associated with the Price 
List from the Header.

Get Possible 
Bundles 
(Row)

Business 
Service

Row Set 
Transformation 
Toolkit Service

Simple Look-
Up Transform

Checks for the Aggregate 
Discount Sequence 
associated with the Price 
Lists from the Line Items.

Identify 
Applicable 
Bundles

Business 
Service

Row Set 
Transformation 
Toolkit Service

Rule Set 
Look-Up 
Transform

Identifies applicable 
Aggregate Discounts and 
corresponding Multiplier.

Apply Bundle 
Adjustments

Business 
Service

Row Set 
Transformation 
Toolkit Service

Rule Set 
Look-Up 
Transform

Applies the adjustments 
defined in aggregate 
discounts.

Figure 20. Pricing Procedure - Service Workflow Process
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Table 25 lists the steps in the Pricing Procedure - Service workflow with the business service and 
method that is called by each. 

Miscellaneous Pricing Workflows
The workflows used for pricing are covered in “Pricing Procedures and Workflow References” on 
page 155. 

The following workflows are used by Siebel Pricer for other purposes: 

■ “PSP Dynamic Matrix - Refresh Matrix Cache Workflow” on page 176

■ “PSP Waterfall Synch to DB Workflow” on page 177

■ “Spread Discount Driver Workflow Process Workflow” on page 178

PSP Dynamic Matrix - Refresh Matrix Cache Workflow
This workflow clears the cache for the Attribute Adjustment Rules that is internally maintained by 
the PSP Engine.

This workflow refreshes the Attribute Adjustment cache for the currently highlighted record. 

Table 25. Steps of the Pricing Procedure - Service Workflow

Name Type
Business 
Service Method

Sub 
Process Description

Get Covered 
Product List 
Price

Business 
Service

Row Set 
Transformation 
Toolkit Service

Simple Look-
Up Transform

Looks up list price 
information for the 
covered product.

Calculate 
Covered 
Product 
Service Price

Business 
Service

Row Set 
Transformation 
Toolkit Service

Simple Look-
Up Transform

Calculates the Start 
Price for a service 
product by applying the 
percentage in the Price 
List Item to the Net Price 
or Start Price of the 
covered product.

Figure 21. PSP Dynamic Matrix - Refresh Matrix Cache Workflow Process
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Table 26 describes the step in the PSP Dynamic Matrix - Refresh Matrix Cache workflow with the 
business service and method that it calls. 

PSP Waterfall Synch to DB Workflow
This workflow writes waterfall records to the database according to input from the data map object.

Table 27 lists describes the step in the PSP Waterfall Synch to DB Workflow workflow with the 
business service and method that is called. 

Table 26. Steps of the PSP Dynamic Matrix - Refresh Matrix Cache Workflow

Name Type
Business 
Service Method

Sub 
Process Description

Refresh Matrix Business 
Service

Dynamic Matrix 
Retrieval Service

Refresh 
Matrix

Refreshes the Attribute 
Adjustment cache for the 
current highlighted record.

Figure 22. PSP Waterfall Synch to DB Workflow 

Table 27. Steps of the PSP Waterfall Synch to DB Workflow

Name Type
Business 
Service Method

Sub 
Process Description

Sync Waterfall Business 
Service

PSP Waterfall 
Service

WriteWaterfall Writes waterfall 
records to database.
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Spread Discount Driver Workflow Process Workflow
This workflow spreads a discount amount over the specified line items.

NOTE: The specialized implementation in the Quote Spread Discount Pop-up applet subsequently 
triggers Pricing Procedure – Default, which evaluates the net prices and subtotal based on the new 
discount amounts.

Workflow Description. This workflow does the following:

1 Generates a property set of the Line Item buscomp using Context Service variable maps. For 
more information, see Siebel Order Management Guide.

2 Filters out items that will not get a spread discount. By default, only nonrecurring change items 
are candidates for a spread discount. 

3 Spreads a discount amount depending on the target total or target discount amount specified by 
the user. 

4 Synchronizes the updated information back to the database.

Table 28 lists the steps in the Spread Discount Driver Workflow Process workflow with the business 
service and method that is called for each.

Figure 23. Spread Discount Driver Workflow Process Workflow Process

Table 28. Steps of the Spread Discount Driver Workflow Process Workflow

Name Type
Business 
Service Method

Sub 
Process Description

Get Row Set Business 
Service

Context 
Service

GetRowSetData Generates a property 
set from the Line Item 
business component.

Execute Type 
SearchSpec

Business 
Service

Row Set 
Transformation 
Toolkit

Split Transform Filters out items that 
will not get a spread 
discount.

Spread 
Discount

Business 
Service

ISS Spread 
Discount 
Service

SpreadDiscount Spreads a discount 
amount.

Sync Row Set Business 
Service

Context 
Service

SyncRowSetData Synchronizes the 
updated information 
back to database.
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B Siebel Pricer Deployment and 
Integration
This chapter contains information about integrating Siebel Pricer with Siebel business components 
and external applications. It covers the following topics: 

■ “Integration Methods for Siebel Pricer” on page 180

■ “Internal Integration of Siebel Pricer” on page 181

■ “External Integration of Siebel Pricer Using UAN” on page 207

■ “External Integration of Siebel Pricer Using Pricer as a Service” on page 207

■ “Siebel Pricing Manager API Reference” on page 225

■ “Workflows for External Pricing API” on page 228

About Pricing Integration
You can integrate Siebel Pricer internally or externally—that is, from other Siebel application 
modules, or from other manufacturers' applications. 

Siebel Pricer functionality is used internally for quotes, orders, and agreements, and can be used 
with popular external applications and services—for example, Enterprise Resource Planning (ERP) 
applications. 
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Figure 24 shows how the Pricing Manager business service can be integrated to provide Siebel Pricer 
functionality to both internal and external system modules. 

Integration Methods for Siebel Pricer
Siebel Pricer supports the following types of integration: 

Figure 24. Pricing Manager Business Service (the Run-Time Pricing Engine)
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■ Internal integration. This allows you to configure the Siebel application so that Siebel Pricer 
works with other Siebel business objects. Without configuration, Siebel Pricer works with quotes, 
orders, and agreements. For more information, see “Internal Integration of Siebel Pricer” on 
page 181. 

■ External integration. This allows you to integrate Siebel Pricer with other external applications, 
such as back office applications, in the following ways: 

■ External integration using Universal Application Network (UAN). You can use Siebel 
UAN to integrate Pricer with other applications. Quotes and orders that exist on the external 
system are replicated as Siebel Quote and Order records using UAN. Pricer then uses the 
same methods used for internal integration. For more information, see “External Integration 
of Siebel Pricer Using UAN” on page 207. 

■ External integration using Pricer as a service. You can use the Siebel Pricer engine 
without using the Siebel interface. Use this method when your business model does not 
require the external quotes and orders to be replicated in the Siebel application. For more 
information, see “External Integration of Siebel Pricer Using Pricer as a Service” on page 207. 

■ Integration using the Pricer API. The API is retained to support users who used the Pricer 
API in earlier versions of the Siebel application, but for whom it is no longer the best practice in 
version 7.8. For more information, see “Siebel Pricing Manager API Reference” on page 225.

Internal Integration of Siebel Pricer
Without configuration, pricing functionality is used by quotes, orders, and agreements. 

You can configure the application so that any business component can use pricing functionality. This 
section gives an example of configuring the Opportunity business component to integrate it with 
Pricer. You can use similar methods for other business components. 

This example allows the Opportunity and Opportunity Product business components to invoke the 
pricing procedure. For information about the pricing procedure, see Appendix A, “Siebel Pricer 
Technical Reference.”

CAUTION: Perform these changes on the local environment only. The change has enterprise-wide 
effect and may affect others using the same URL. You should not perform these changes unless you 
are familiar with Siebel Tools and Siebel order management infrastructure. 

To allow the Opportunity and Opportunity Product business components to invoke the pricing 
procedure, do the following. 

To change the base class of the business component to user CSSBCOrderMgmtBase

1 In Siebel Tools, in the Object Explorer, click Business Component.

2 Query for Opportunity Product and Opportunity. 

3 Lock these objects.
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4 For these objects, set Class to CSSBCOrderMgmtBase.

Setting the base class to CSSBCOrderMgmtBase enables a business component to raise a signal. 

NOTE: You can do this only if the original business component is not using a specialized buscomp 
class. Otherwise, you risk losing the functionality offered by the specialized buscomp class.

To set up Context Service Variable Map Integration Object and Mode 

1 In Siebel Tools, open the Object Explorer and under Business Component, click Business 
Component User Prop.

2 For both the Opportunity Product and Opportunity Buscomp, add the new user properties shown 
in the following table. 

a The first user property sets the Integration Object to be used for the variable map.

b The second user property set the mode of the business component. This corresponds to the 
mode in the Signal and Variable Map definition. In this case, items with mode All and Opportunity 
would be picked up.

To expose a button on UI to trigger CalculatePriceForOpportunity 

1 Alter the Opportunity Product applet as follows:

a In the Object Explorer applet, drill down on Siebel Objects + Applet.

b In Applets, input the following: 

<New Query>

Name = Opportunity Product Applet

<Execute Query>

Lock the project.

2 Add Controls <Reprice>

a In the Object Explorer applet, click Control.

Name Value

Instance Uniform Name EAI Object:Opportunity ISS Opportunity

Mode Opportunity
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b In the Controls applet, input the following: 

<New Record>

Name = Reprice

Caption = Reprice

HTML Type = MiniButton

Method Invoked = CalculatePriceForOpportunity

3 Display the Web template. 

a In the Object Explorer applet, click Applet Web Template.

b In Applet Web Templates, input the following: 

Select Name = Edit List

Menu: View > Editors > Web Applet Editor

4 Add controls to the template as follows: 

a Scroll to the Controls/Columns applet at the bottom left of the screen.

b Select Reprice, and then drag and drop to [x] next to last labeled control [Edit].

Create a button on the UI to raise a signal.

To design the CalculatePriceForOpportunity signal

1 Create a new signal with a name CalculatePriceForOpportunity.

2 Drill down on the workspace.

3 Create an Action as shown in the following table.

4 Create the parameters as shown in the following table. 

Sequence Service Name Service Type Service Method

1 PSP Driver Workflow Process Workflow RunProcess

Name Value

CPScope Whole

RowScope Selected

SubPSPWFName Pricing Procedure - Opportunity

Variable Map - Context Opportunity Pricing Variable Map - Context

Variable Map - Row Set Opportunity Pricing Variable Map - Row Set
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5 Click the Release New Version button.

Create the signal to be triggered by the button created in Step 4. 

To create an Integration Object 

1 Create a new record, ISS Opportunity Integration Object, as shown in the following table.

2 Create a new record, ISS Opportunity Integration Object, as shown in the following table.

3 Enter Integration Component Fields of Opportunity, as shown in the following table.

Name Project 
Business 
Object External Name XML Tag 

ISS 
Opportunity

ISS Order 
Management 

Opportunity ISS Object ListOfISSObject

Name

External 

Name 

Context

Parent 

Integration 

Component

External 

Name

External 

Sequence

Card-

inality

XML Container 

Elemen XML Tag

Header Opportunity Opportunity 1 One ListOfHeader Header

Line 

Item

Opportunity 

Product

Header Opportunity 

Product

2 Zero or 

More

ListOfLineItem LineItem

Name Data Type Length

External 

Name

External 

Data Type

External 

Length XML Style XML Tag

Name DTYPE_TEXT 50 Name DTYPE_TEXT 50 Element Name
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4 Enter Integration Component Fields of Opportunity Product, as shown in the following table.

Create the uniform field map used by the variable map.

To create the variable map

1 Create the Opportunity Pricing Variable Map - Context Variable Map.

2 Drill down on Workspace.

3 Create the Variable Definition as shown in the following table.

4 Create the Variable Source for the Variable Definition as shown in the following table.

5 Click the Mode tab and create the recording as shown in the following table.

6 Create the Opportunity Pricing Variable Map - Row Set Variable Map. 

7 Drill down on Workspace.

Name Data Type Length

Preci

sion

External 

Name

External 

Data Type

External 

Length

XML 

Style XML Tag

Comment DTYPE_TEXT 255 Comment DTYPE_TEXT 255 Element Comment

Cost DTYPE_NUMBER Cost DTYPE_NUMBER lement Cost

Product 

Id

DTYPE_ID Product 

Id

DTYPE_ID Element ProductId

Product 

Price

DTYPE_NUMBER Product 

Price

DTYPE_NUMBER Element ProductPrice

Product 

Quantity

DTYPE_NUMBER 16 Product 

Quantity

DTYPE_NUMBER Element Product 

Quantity

Quotable DTYPE_TEXT Quotable DTYPE_BOOL Element Quotable

Revenue DTYPE_NUMBER Revenue DTYPE_NUMBER Element Revenue

Variable Name In/Out Type On Null

Name In/Out Text Ignore

Mode Path Source Type

Opportunity $Current/Header/Name Instance

Mode Object Name

Any Header
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8 Create the Variable Definitions as shown in the following table.

9 Create the Variable Source for each of these Variable Definitions as shown in the following table.

10 Click the Mode tab and create the recording as shown in the following table.

Create the variable maps referenced by the signal.

To create the pricing procedure
■ Create a pricing procedure that drives the pricing logic. 

One example is Pricing Procedure - Opportunity.xml in “Sample Pricing Procedure for Internal 
Integration.” Make additions or modifications to this example as needed. 

Pricing procedures are a type of PSP procedure. For more information about PSP procedures, see 
Siebel Order Management Infrastructure Guide.

Variable Name In/Out Type On Null

Comment In/Out Text Ignore

Cost In/Out Number Ignore

Product Id In/Out Id Ignore

Product Price In/Out Number Ignore

Product Quantity In/Out Number Ignore

Quotable In/Out Boolean Ignore

Revenue In/Out Number Ignore

Mode Path Source Type

Opportunity $Current/Line Item/Comment Instance

Opportunity $Current/Line Item/Cost Instance

Opportunity $Current/Line Item/Product Id Instance

Opportunity $Current/Line Item/Product Price Instance

Opportunity $Current/Line Item/Product Quantity Instance

Opportunity $Current/Line Item/Quotable Instance

Opportunity $Current/Line Item/Revenue Instance

Mode Object Name

Any Line Item
Pricing Administration Guide Version 7.8, Rev. B186 



Siebel Pricer Deployment and Integration ■ Internal Integration of Siebel Pricer
Sample Pricing Procedure for Internal Integration
(Create the workflow to drive Pricing logic)

This section contains Pricing Procedure - Opportunity.xml, the XML version of a sample pricing 
procedure meant to drive the pricing logic for internally integrating pricing with the Opportunity and 
Opportunity Product business components. 

<?xml version="1.0" encoding="UTF-8" ?> 

<?Siebel-Property-Set EscapeNames="false"?> 

-<SiebelMessage MessageId="" IntObjectName="Repository Workflow Definition Export 
V.7.7.1" MessageType="Integration Object" IntObjectFormat="Siebel Hierarchical">

-<ListOfRepositoryWorkflowProcess>

-<RepositoryWorkflowProcess>

<BusinessObject /> 

<CacheLocale /> 

<Comments /> 

<Description>Support Pricer APIs GetProductListPrice and GetConfigItemPrice</
Description> 

<EffectiveEndDate /> 

<EffectiveStartDate /> 

<ErrorProcessName /> 

<Group /> 

<Inactive>N</Inactive> 

<Module /> 

<Name>Pricing Procedure - Opportunity: 3</Name> 

<PersistentFrequency>N</PersistentFrequency> 

<PersistentLevel /> 

<ProcessName>Pricing Procedure - Opportunity</ProcessName> 

<ProjectName>Pricer</ProjectName> 

<ReplicationLevel>None</ReplicationLevel> 

<Runnable>N</Runnable> 

<Status>COMPLETED</Status> 

<Version>3</Version> 

<WorkflowMode>SRVFLOW</WorkflowMode> 
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- <ListOfRepositoryWfProcessProp>

- <RepositoryWfProcessProp>

<AccessMode>RW</AccessMode> 

<BusinessComponent /> 

<Comments>Variables that are shared across all rows in Row Set.</Comments> 

<CorrelatorFlag>N</CorrelatorFlag> 

<DataType>PROPSET_CHILD</DataType> 

<DefaultDate /> 

<DefaultNumber /> 

<DefaultString /> 

<DisplayName /> 

<InOut>INOUT</InOut> 

<Inactive /> 

<IntegrationObject /> 

<Name2>Context</Name2> 

<VirtualField /> 

  </RepositoryWfProcessProp>

- <RepositoryWfProcessProp>

<AccessMode>RW</AccessMode> 

<BusinessComponent /> 

<Comments>The set of line items to reprice.</Comments> 

<CorrelatorFlag>N</CorrelatorFlag> 

<DataType>PROPSET_CHILD</DataType> 

<DefaultDate /> 

<DefaultNumber /> 

<DefaultString /> 

<DisplayName /> 

<InOut>INOUT</InOut> 

<Inactive /> 

<IntegrationObject /> 
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<Name2>Row Set</Name2> 

<VirtualField /> 

  </RepositoryWfProcessProp>

  </ListOfRepositoryWfProcessProp>

- <ListOfRepositoryWfStep>

- <RepositoryWfStep>

<AllowRetryFlag>N</AllowRetryFlag> 

<BusinessComponent /> 

<Operation /> 

<BusinessServiceMethod /> 

<BusinessServiceName /> 

<Comments /> 

<Description /> 

<ErrorCode /> 

<ErrorMessage /> 

<EvaluateAll>Y</EvaluateAll> 

<Inactive>N</Inactive> 

<Layout>@0*0*3*0*0*0*1*r13*288 12 352 529*FillBgClr8*167641088*ArrowEnd1*1</
Layout> 

<MaximumIterations /> 

<Name3>End</Name3> 

<ProcessingMode /> 

<SubprocessName /> 

<Type>END</Type> 

<UserInteractView /> 

<ListOfRepositoryWfStepBranch /> 

<ListOfRepositoryWfStepIOArgument /> 

<ListOfRepositoryWfStepRecipient /> 

  </RepositoryWfStep>

- <RepositoryWfStep>
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<AllowRetryFlag>N</AllowRetryFlag> 

<BusinessComponent /> 

<Operation /> 

<BusinessServiceMethod>Simple Look-Up Transform</BusinessServiceMethod> 

<BusinessServiceName>Row Set Transformation Toolkit</BusinessServiceName> 

<Comments /> 

<Description>Look up all values on the price list item.</Description> 

<ErrorCode /> 

<ErrorMessage /> 

<EvaluateAll>Y</EvaluateAll> 

<Inactive>N</Inactive> 

<Layout>@0*0*3*0*0*0*1*r13*180 12 244 529*FillBgClr8*134217218*ArrowEnd1*1</
Layout> 

<MaximumIterations /> 

<Name3>Get List Price</Name3> 

<ProcessingMode /> 

<SubprocessName /> 

<Type>TASK</Type> 

<UserInteractView /> 

- <ListOfRepositoryWfStepBranch>

- <RepositoryWfStepBranch>

<Comments /> 

<Count /> 

<EvaluateSequence /> 

<Event /> 

<EventCancelFlag>N</EventCancelFlag> 

<EventObject /> 

<EventObjectType /> 

<EventVisibility>ENTERPRISE</EventVisibility> 

<Expression /> 
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<Inactive>N</Inactive> 

<Name2>NewConn:1-3J9N9</Name2> 

<Subevent /> 

<TimeLimit /> 

<Type>CONNECTOR</Type> 

<UserEventName /> 

<UserEventStorage /> 

<UserEventTimeout>0</UserEventTimeout> 

<ListOfRepositoryWfBranchCriteria /> 

</RepositoryWfStepBranch>

</ListOfRepositoryWfStepBranch>

- <ListOfRepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>Business Component</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 

<ValueSearchSpecification>Price List Item</ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 
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<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>Business Component</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 

<ValueSearchSpecification>Price List Item</ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>Business Component</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 

<ValueSearchSpecification>Price List Item</ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 
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<ItemTypeName /> 

<Name2>Business Component</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 

<ValueSearchSpecification>Price List Item</ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>Business Object</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 

<ValueSearchSpecification>Admin Price List</ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>Business Object</Name2> 
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<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 

<ValueSearchSpecification>Admin Price List</ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>Business Object</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 

<ValueSearchSpecification>Admin Price List</ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>Business Object</Name2> 

<OutputArg /> 

<PropertyName /> 
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<Sequence>0</Sequence> 

<Type>LITERAL</Type> 

<ValueSearchSpecification>Admin Price List</ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>Context</Name2> 

<OutputArg /> 

<PropertyName>Context</PropertyName> 

<Sequence>0</Sequence> 

<Type>PROPERTY</Type> 

<ValueSearchSpecification /> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>On First Match 5</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 
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<ValueSearchSpecification>{Row.Product Price} = {Match.List Price}</
ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>On First Match 5</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 

<ValueSearchSpecification>{Row.Product Price} = {Match.List Price}</
ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>On First Match 5</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 
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<ValueSearchSpecification>{Row.Product Price} = {Match.List Price}</
ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>On First Match 5</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 

<ValueSearchSpecification>{Row.Product Price} = {Match.List Price}</
ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>On First Match 6</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 
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<ValueSearchSpecification>{Row.Revenue} = {Match.MSRP Price}</
ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>On First Match 6</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 

<ValueSearchSpecification>{Row.Revenue} = {Match.MSRP Price}</
ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>On First Match 6</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 
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<ValueSearchSpecification>{Row.Revenue} = {Match.MSRP Price}</
ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>On First Match 6</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 

<ValueSearchSpecification>{Row.Revenue} = {Match.MSRP Price}</
ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>On First Match 8</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 
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<ValueSearchSpecification>{Row.Cost} = {Match.Cost}</
ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>On First Match 8</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 

<ValueSearchSpecification>{Row.Cost} = {Match.Cost}</
ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>On First Match 8</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 
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<ValueSearchSpecification>{Row.Cost} = {Match.Cost}</
ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>On First Match 8</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 

<ValueSearchSpecification>{Row.Cost} = {Match.Cost}</
ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>Row Set</Name2> 

<OutputArg /> 

<PropertyName>Row Set</PropertyName> 

<Sequence>0</Sequence> 

<Type>PROPERTY</Type> 

<ValueSearchSpecification /> 
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</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>Search Specification</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 

<ValueSearchSpecification>[Price List Id] = {Context.Name} AND [Product Id] = 
{Row.Product Id}</ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>Search Specification</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 

<ValueSearchSpecification>[Price List Id] = {Context.Name} AND [Product Id] = 
{Row.Product Id}</ValueSearchSpecification> 

</RepositoryWfStepIOArgument>
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- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>Search Specification</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 

<ValueSearchSpecification>[Price List Id] = {Context.Name} AND [Product Id] = 
{Row.Product Id}</ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>I</InputFlag> 

<ItemTypeName /> 

<Name2>Search Specification</Name2> 

<OutputArg /> 

<PropertyName /> 

<Sequence>0</Sequence> 

<Type>LITERAL</Type> 

<ValueSearchSpecification>[Price List Id] = {Context.Name} AND [Product Id] = 
{Row.Product Id}</ValueSearchSpecification> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>
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<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>O</InputFlag> 

<ItemTypeName /> 

<Name2>O:Get List Price1</Name2> 

<OutputArg>Row Set</OutputArg> 

<PropertyName>Row Set</PropertyName> 

<Sequence>1</Sequence> 

<Type>ARGUMENT</Type> 

<ValueSearchSpecification /> 

</RepositoryWfStepIOArgument>

- <RepositoryWfStepIOArgument>

<BusinessComponent /> 

<BusinessComponentField /> 

<Comments /> 

<Inactive>N</Inactive> 

<InputFlag>O</InputFlag> 

<ItemTypeName /> 

<Name2>O:Get List Price20</Name2> 

<OutputArg>Context</OutputArg> 

<PropertyName>Context</PropertyName> 

<Sequence>2</Sequence> 

<Type>ARGUMENT</Type> 

<ValueSearchSpecification /> 

</RepositoryWfStepIOArgument>

</ListOfRepositoryWfStepIOArgument>

<ListOfRepositoryWfStepRecipient /> 

</RepositoryWfStep>
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- <RepositoryWfStep>

<AllowRetryFlag>N</AllowRetryFlag> 

<BusinessComponent /> 

<Operation /> 

<BusinessServiceMethod /> 

<BusinessServiceName /> 

<Comments /> 

<Description /> 

<ErrorCode /> 

<ErrorMessage /> 

<EvaluateAll>Y</EvaluateAll> 

<Inactive>N</Inactive> 

<Layout>@0*0*3*0*0*0*1*r12*96 12 160 529*FillBgClr8*167641088*ArrowEnd1*1</
Layout> 

<MaximumIterations /> 

<Name3>Start</Name3> 

<ProcessingMode /> 

<SubprocessName /> 

<Type>START</Type> 

<UserInteractView /> 

- <ListOfRepositoryWfStepBranch>

- <RepositoryWfStepBranch>

<Comments /> 

<Count /> 

<EvaluateSequence /> 

<Event /> 

<EventCancelFlag>N</EventCancelFlag> 

<EventObject /> 

<EventObjectType /> 

<EventVisibility>ENTERPRISE</EventVisibility> 
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<Expression /> 

<Inactive>N</Inactive> 

<Name2>NewConn:1-3J9N7</Name2> 

<Subevent /> 

<TimeLimit /> 

<Type>DEFAULT</Type> 

<UserEventName /> 

<UserEventStorage /> 

<UserEventTimeout>0</UserEventTimeout> 

  <ListOfRepositoryWfBranchCriteria /> 

</RepositoryWfStepBranch>

</ListOfRepositoryWfStepBranch>

<ListOfRepositoryWfStepIOArgument /> 

<ListOfRepositoryWfStepRecipient /> 

</RepositoryWfStep>

</ListOfRepositoryWfStep>

- <ListOfRepositoryWfBranchConnector>

- <RepositoryWfBranchConnector>

<Comments /> 

<FromStepName>Start</FromStepName> 

<Inactive>N</Inactive> 

<Layout>@0*0*9*0*0*0*9*LineWidth1*24*FrHS1*22*P16*180 324*NPts1*22*P06*152 
324*ToID8*04-EAATQ6*FromID8*04-EAAU84*ToHS1*08*ArrowEnd1*1</Layout> 

<Name2>NewConn:1-3J9N7</Name2> 

<ForBranchName>NewConn:1-3J9N7</ForBranchName> 

<ParentType>DEFAULT</ParentType> 

<ToStepName>Get List Price</ToStepName> 

</RepositoryWfBranchConnector>

- <RepositoryWfBranchConnector>

<Comments /> 
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<FromStepName>Get List Price</FromStepName> 

<Inactive>N</Inactive> 

<Layout>@0*0*9*0*0*0*9*LineWidth1*24*FrHS1*22*P16*288 324*NPts1*22*P06*244 
324*ToID8*04-EAATP6*FromID8*04-EAATQ4*ToHS1*08*ArrowEnd1*1</Layout> 

<Name2>NewConn:1-3J9N9</Name2> 

<ForBranchName>NewConn:1-3J9N9</ForBranchName> 

<ParentType>CONNECTOR</ParentType> 

<ToStepName>End</ToStepName> 

</RepositoryWfBranchConnector>

</ListOfRepositoryWfBranchConnector>

</RepositoryWorkflowProcess>

</ListOfRepositoryWorkflowProcess>

</SiebelMessage>

External Integration of Siebel Pricer 
Using UAN
Use Siebel Universal Applications Network for integration if you want to replicate external data in 
your Siebel application. 

To integrate Siebel Pricer with external applications using UAN 

1 Set up UAN to integrate the external application with your Siebel application, so data from the 
external application is replicated in Siebel quotes and orders. 

2 Set up pricing for Siebel quotes and orders in the usual way. 

For more information about setting up integration using UAN, see the documentation provided with 
the UAN product that you purchased. 

External Integration of Siebel Pricer 
Using Pricer as a Service
You use Pricer as an external service if you do not want to use the Siebel interface, but only the 
Siebel pricing engine. The Siebel pricing engine must receive data in a particular format, which is 
called the property set. Integration involves getting data in that format and passing it to the pricing 
procedure. 

A typical flow for this type of external integration is as follows:
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■ The property set is the standard data format for integration. It is created by a Business Service 
Script that is based on the data from the external system. However, the property set format must 
be understood by the pricing procedure. For the property set format expected by the pricing 
procedure, see “Sample Pricing Procedure for Internal Integration” on page 187 and “Sample XML 
Output Property Set for External Integration” on page 215. 

■ The desired pricing procedure is called with the property set generated in the previous step. 
Pricing information is updated on the property set.

■ The Business Service Script extracts updated information from the property set and synchronizes 
back to the external data source.

The following example illustrates this process. 

A simple product and a complex product with a component product are created. A price list is then 
created and the products are associated with it, as shown in Figure 25.

Products are added to the quote, as shown in Figure 26. As expected, prices are stamped on each of 
the products, and all the steps under Internal Integration are performed to produce the prices.

Now, instead of using the Siebel application interface to create the quote, the following script is used 
to create the quote:

function Service_PreInvokeMethod (MethodName, Inputs, Outputs)

Figure 25. Price List for External Integration Example

Figure 26. Quote for External Integration Example
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{

   var fileName = "C:\\log.txt";

   var xmlFile = "C:\\pricer_input.xml";

   var procedureName = "Dynamic Pricing Procedure";

   

   var psXMLSvcInputs = TheApplication ().NewPropertySet ();

   var psPricingProcedureInputs = TheApplication ().NewPropertySet ();

   var psPricingProcedureOutputs = TheApplication ().NewPropertySet ();

   // In this example, Read the Property Set from an XML file.

   // The Property Set contains a simple product and a complex product to be priced.

   // This can be generated from other sources as well, such as from

   // external systems, as long as the Property Set conformed to the format

   var xmlSvc = TheApplication().GetService ("EAI XML Read from File");

   psXMLSvcInputs.SetProperty ("FileName", xmlFile);   

   xmlSvc.InvokeMethod ("ReadPropSet", psXMLSvcInputs, psPricingProcedureInputs);

   // After the property set is created, the "Dynamic Pricing Procedure" WF

   // is invoked.  The output would contain the simple product and the complex

   // product with updated pricing information.   

   var wfSvc = TheApplication().GetService ("Workflow Process Manager");

   psPricingProcedureInputs.SetProperty ("ProcessName", procedureName);

wfSvc.InvokeMethod ("RunProcess", psPricingProcedureInputs, psPricingProcedureOutputs);

   return (CancelOperation);

}

The first function in this script contains three essential processes for external integration:
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■ A property set is created by a Business Service Script based on the data from the external 
system. In this example, the property set is loaded from an XML file. The property set format 
must be understood by the pricing procedure. For the required property set format, see the step 
that follows this one. 

   // In this example, Read the Property Set from an XML file.

   // The Property Set contains a simple product and a complex product to be priced.

   // This can be generated from other sources as well, such as from

   // external systems, as long as the Property Set conformed to the format

   var xmlSvc = TheApplication().GetService ("EAI XML Read from File");

   psXMLSvcInputs.SetProperty ("FileName", xmlFile);   

   xmlSvc.InvokeMethod ("ReadPropSet", psXMLSvcInputs, psPricingProcedureInputs);

■ The desired Pricing Workflow is called with the property set generated in the previous step. 
Pricing information is updated on the property set.

   var procedureName = "Dynamic Pricing Procedure";

   // ...

   var wfSvc = TheApplication().GetService ("Workflow Process Manager");

   psPricingProcedureInputs.SetProperty ("ProcessName", procedureName);

wfSvc.InvokeMethod ("RunProcess", psPricingProcedureInputs, 
psPricingProcedureOutputs);

■ The Business Service Script extracts updated information from the property set and synchronizes 
back to the external data source. Sample XML Input Property Set for External Integration

<?xml version="1.0" encoding="UTF-8"?><?Siebel-Property-Set 
EscapeNames="true"?><PropertySet

><Context

 Local_spcLanguage="ENU"

 Local_spcTime_spcZone="(GMT-08:00) Pacific Time (US &amp; Canada); Tijuana"

 CPScope="Whole"

 CPCollapseAll=""

 RowScope="Current"

 Mode="Quote"

>Default Pricing Variable Map - Context<Header

 Currency_spcCode="USD"

 Discount_spcPercent=""
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 Exchange_spcDate="02/09/2005"

 Price_spcList_spcId="2-478KT"

>2-478L2</Header

></Context

><Row_spcSet

 Local_spcLanguage="ENU"

 Local_spcTime_spcZone="(GMT-08:00) Pacific Time (US &amp; Canada); Tijuana"

 CPScope="Whole"

 CPCollapseAll=""

 RowScope="Current"

 Mode="Quote"

>Default Pricing Variable Map - Row Set<Line_spcItem

 NRC_spcCxTotal="0"

 Class_spcId=""

 Unit_spcof_spcMeasure=""

 Service_spcPrice_spcMethod=""

 Id="2-478LF"

 Current_spcDiscount_spcId=""

 Exclude_spcPricing_spcFlag="N"

 Extended_spcQuantity_spcRequested="1"

 Sales_spcService_spcFlag="N"

 Covered_spcProduct_spcNet_spcPrice=""

 Currency_spcCode="USD"

 Product_spcId="2-478K6"

 Min_spcPrice=""

 Next_spcDiscount_spcId=""

 Discount_spcPercent=""

 Prod_spcProm_spcId=""

 Rollup_spcAmount="0"

 Covered_spcProduct_spcId=""
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 Covered_spcAsset_spcProduct_spcId=""

 Parent_spcItem_spcId=""

 Product_spcPort_spcId=""

 Net_spcPrice=""

 List_spcPrice=""

 Promotion_spcItem_spcFlag="N"

 Upsell=""

 Root_spcBundle_spcFlag="N"

 Price_spcType="One-Time"

 Covered_spcLine_spcItem_spcId=""

 Product_spcLine_spcId="No Match Row Id"

 Unit_spcPrice=""

 Max_spcPrice=""

 Discount_spcAmount=""

 Exchange_spcDate="02/09/2005"

 Quantity="1"

 Action_spcCode="Add"

 Usage_spcAsset_spcProduct_spcId=""

 Price_spcList_spcId=""

 Start_spcPrice=""

 Service_spcPrice_spcPercent=""

 MRC_spcCxTotal="0"

>2-478LF<Attributes

>Default Pricing Variable Map - XA</Attributes

></Line_spcItem

><Line_spcItem

 NRC_spcCxTotal=""

 Class_spcId=""

 Unit_spcof_spcMeasure=""

 Service_spcPrice_spcMethod=""
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 Id="2-478NH"

 Current_spcDiscount_spcId=""

 Exclude_spcPricing_spcFlag="N"

 Extended_spcQuantity_spcRequested="2"

 Sales_spcService_spcFlag="N"

 Covered_spcProduct_spcNet_spcPrice=""

 Currency_spcCode="USD"

 Product_spcId="2-478JP"

 Min_spcPrice=""

 Next_spcDiscount_spcId=""

 Discount_spcPercent=""

 Prod_spcProm_spcId=""

 Rollup_spcAmount="0"

 Covered_spcProduct_spcId=""

 Covered_spcAsset_spcProduct_spcId=""

 Parent_spcItem_spcId="2-478LF"

 Product_spcPort_spcId="2-478KD"

 Net_spcPrice=""

 List_spcPrice=""

 Promotion_spcItem_spcFlag="N"

 Upsell=""

 Root_spcBundle_spcFlag="N"

 Price_spcType="One-Time"

 Covered_spcLine_spcItem_spcId=""

 Product_spcLine_spcId="No Match Row Id"

 Unit_spcPrice=""

 Max_spcPrice=""

 Discount_spcAmount=""

 Exchange_spcDate="02/09/2005"

 Quantity="2"
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 Action_spcCode="Add"

 Usage_spcAsset_spcProduct_spcId=""

 Price_spcList_spcId=""

 Start_spcPrice=""

 Service_spcPrice_spcPercent=""

 MRC_spcCxTotal=""

>2-478NH<Attributes

>Default Pricing Variable Map - XA</Attributes

></Line_spcItem

><Line_spcItem

 NRC_spcCxTotal="0"

 Class_spcId=""

 Unit_spcof_spcMeasure="Per Month"

 Service_spcPrice_spcMethod=""

 Id="2-478OD"

 Current_spcDiscount_spcId=""

 Exclude_spcPricing_spcFlag="N"

 Extended_spcQuantity_spcRequested="1"

 Sales_spcService_spcFlag="N"

 Covered_spcProduct_spcNet_spcPrice=""

 Currency_spcCode="USD"

 Product_spcId="2-478J6"

 Min_spcPrice=""

 Next_spcDiscount_spcId=""

 Discount_spcPercent=""

 Prod_spcProm_spcId=""

 Rollup_spcAmount="0"

 Covered_spcProduct_spcId=""

 Covered_spcAsset_spcProduct_spcId=""

 Parent_spcItem_spcId=""
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 Product_spcPort_spcId=""

 Net_spcPrice=""

 List_spcPrice=""

 Promotion_spcItem_spcFlag="N"

 Upsell=""

 Root_spcBundle_spcFlag="N"

 Price_spcType="Recurring"

 Covered_spcLine_spcItem_spcId=""

 Product_spcLine_spcId="No Match Row Id"

 Unit_spcPrice=""

 Max_spcPrice=""

 Discount_spcAmount=""

 Exchange_spcDate="02/09/2005"

 Quantity="1"

 Action_spcCode="Add"

 Usage_spcAsset_spcProduct_spcId=""

 Price_spcList_spcId=""

 Start_spcPrice=""

 Service_spcPrice_spcPercent=""

 MRC_spcCxTotal="0"

>2-478OD<Attributes

>Default Pricing Variable Map - XA</Attributes

></Line_spcItem

></Row_spcSet

></PropertySet

>

Sample XML Output Property Set for External Integration
<?xml version="1.0" encoding="UTF-8"?><?Siebel-Property-Set 
EscapeNames="true"?><PropertySet

><Context
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 Local_spcLanguage="ENU"

 Local_spcTime_spcZone="(GMT-08:00) Pacific Time (US &amp; Canada); Tijuana"

 CPScope="Whole"

 CPCollapseAll=""

 RowScope="Current"

 Mode="Quote"

>Default Pricing Variable Map - Context<Header

 Price_spcList_spcName="Test Price List"

 Currency_spcCode="USD"

 Discount_spcPercent=""

 Is_spcPrice_spcList_spcExpired_spcFlag="N"

 Exchange_spcDate="02/09/2005"

 Is_spcPrice_spcList_spcNot_spcEffective_spcFlag="N"

 Price_spcList_spcId="2-478KT"

>2-478L2</Header

></Context

><Row_spcSet

 Local_spcLanguage="ENU"

 Local_spcTime_spcZone="(GMT-08:00) Pacific Time (US &amp; Canada); Tijuana"

 CPScope="Whole"

 CPCollapseAll=""

 RowScope="Current"

 Mode="Quote"

>Default Pricing Variable Map - Row Set<Line_spcItem

 Extended_spcQuantity_spcRequested="1"

 Temp_spcList_spcPrice="5000"

 Discount_spcPercent=""

 Rollup_spcAmount="4000"

 Upsell=""

 Covered_spcLine_spcItem_spcId=""
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 Temp_spcMRC_spcRollup_spcItem_spcPrice="0"

 Quantity="1"

 Price_spcList_spcId="2-478KT"

 MRC_spcCxTotal="0"

 Temp_spcNRC_spcCxTotal="9000"

 Skip_spcPricing_spcFlag="N"

 Effective_spcPromotion_spcId=""

 Product_spcId="2-478K6"

 Prod_spcProm_spcId=""

 Temp_spcNRC_spcLine_spcTotal="9000"

 Covered_spcAsset_spcProduct_spcId=""

 Temp_spcMRC_spcLine_spcTotal="0"

 Max_spcPrice=""

 Root_spcPrice_spcList_spcItem_spcId="2-478KW"

 MSRP_spcPrice=""

 Temp_spcNRC_spcNet_spcPrice="5000"

 Bundle_spcSequence_spcId=""

 Net_spcPrice="5000"

 List_spcPrice="5000"

 Root_spcBundle_spcFlag="N"

 Price_spcType="One-Time"

 Product_spcLine_spcId="No Match Row Id"

 Unit_spcof_spcMeasure=""

 Temp_spcMRC_spcNet_spcPrice="0"

 Id="2-478LF"

 Purchase_spcPrice=""

 Parent_spcItem_spcId=""

 Rollup_spcItem_spcPrice="9000"

 Exchange_spcDate="02/09/2005"

 Covered_spcProduct_spcNet_spcPrice=""
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 Currency_spcCode="USD"

 Root_spcExchange_spcDate="02/09/2005"

 Cost_spcPrice=""

 Covered_spcProduct_spcId=""

 Product_spcPort_spcId=""

 Root_spcPromotion_spcId=""

 Unit_spcPrice=""

 Discount_spcAmount=""

 Dynamic_spcMatrix=""

 Root_spcPrice_spcList_spcId="2-478KT"

 Root_spcCurrency_spcCode="USD"

 Exclude_spcPricing_spcFlag="N"

 List_spcPrice_spcWaterfall_spcText="List price from &apos;Test Price List&apos; price 
list"

 Price_spcList_spcItem_spcId="2-478KW"

 Min_spcPrice=""

 Temp_spcMRC_spcCxTotal="0"

 Service_spcPrice_spcMethod=""

 Next_spcDiscount_spcId=""

 Promotion_spcItem_spcFlag="N"

 Header_spcDiscount_spcAmount="0"

 Action_spcCode="Add"

 NRC_spcCxTotal="9000"

 Class_spcId=""

 List_spcPrice_spcWaterfall="5000"

 Current_spcDiscount_spcId=""

 Sales_spcService_spcFlag="N"

 Rollup_spcAmount_spcMRC="0"

 Temp_spcParent_spcQuantity="1"

 Volume_spcDiscount_spcId=""
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 Root_spcProduct_spcId="2-478K6"

 Pricing_spcAdjustment_spcAmount="0"

 Usage_spcAsset_spcProduct_spcId=""

 Start_spcPrice="5000"

 Service_spcPrice_spcPercent=""

>2-478LF<Attributes

>Default Pricing Variable Map - XA</Attributes

><Net_spcPrice_spcWaterfall

><Waterfall

 Adjustment_spcAmount="5000"

 Price="5000"

 Currency_spcCode="USD"

 Text="List price from &apos;Test Price List&apos; price list"

 Adjustment_spcType="Price Override"

></Waterfall

></Net_spcPrice_spcWaterfall

></Line_spcItem

><Line_spcItem

 Extended_spcQuantity_spcRequested="2"

 Temp_spcList_spcPrice="2000"

 Discount_spcPercent=""

 Rollup_spcAmount="0"

 Upsell=""

 Covered_spcLine_spcItem_spcId=""

 Temp_spcMRC_spcRollup_spcItem_spcPrice="0"

 Quantity="2"

 Price_spcList_spcId="2-478KT"

 MRC_spcCxTotal=""

 Temp_spcNRC_spcCxTotal="4000"

 Skip_spcPricing_spcFlag="N"
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 Effective_spcPromotion_spcId=""

 Product_spcId="2-478JP"

 Prod_spcProm_spcId=""

 Temp_spcNRC_spcLine_spcTotal="4000"

 Covered_spcAsset_spcProduct_spcId=""

 Temp_spcMRC_spcLine_spcTotal="0"

 Max_spcPrice=""

 Root_spcPrice_spcList_spcItem_spcId="2-478KW"

 MSRP_spcPrice=""

 Temp_spcNRC_spcNet_spcPrice="2000"

 Bundle_spcSequence_spcId=""

 Net_spcPrice="2000"

 List_spcPrice="2000"

 Root_spcBundle_spcFlag="N"

 Price_spcType="One-Time"

 Product_spcLine_spcId="No Match Row Id"

 Unit_spcof_spcMeasure=""

 Temp_spcMRC_spcNet_spcPrice="0"

 Id="2-478NH"

 Purchase_spcPrice=""

 Parent_spcItem_spcId="2-478LF"

 Rollup_spcItem_spcPrice="2000"

 Exchange_spcDate="02/09/2005"

 Covered_spcProduct_spcNet_spcPrice=""

 Currency_spcCode="USD"

 Root_spcExchange_spcDate="02/09/2005"

 Cost_spcPrice=""

 Covered_spcProduct_spcId=""

 Product_spcPort_spcId="2-478KD"

 Root_spcPromotion_spcId=""
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 Unit_spcPrice=""

 Discount_spcAmount=""

 Dynamic_spcMatrix=""

 Root_spcPrice_spcList_spcId="2-478KT"

 Root_spcCurrency_spcCode="USD"

 Exclude_spcPricing_spcFlag="N"

 List_spcPrice_spcWaterfall_spcText="List price from &apos;Test Price List&apos; price 
list"

 Price_spcList_spcItem_spcId="2-478KY"

 Min_spcPrice=""

 Temp_spcMRC_spcCxTotal="0"

 Service_spcPrice_spcMethod=""

 Next_spcDiscount_spcId=""

 Promotion_spcItem_spcFlag="N"

 Header_spcDiscount_spcAmount="0"

 Action_spcCode="Add"

 NRC_spcCxTotal=""

 Class_spcId=""

 List_spcPrice_spcWaterfall="2000"

 Current_spcDiscount_spcId=""

 Sales_spcService_spcFlag="N"

 Rollup_spcAmount_spcMRC="0"

 Temp_spcParent_spcQuantity="1"

 Volume_spcDiscount_spcId=""

 Root_spcProduct_spcId="2-478K6"

 Pricing_spcAdjustment_spcAmount="0"

 Usage_spcAsset_spcProduct_spcId=""

 Start_spcPrice="2000"

 Service_spcPrice_spcPercent=""

>2-478NH<Attributes
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>Default Pricing Variable Map - XA</Attributes

><Net_spcPrice_spcWaterfall

><Waterfall

 Adjustment_spcAmount="2000"

 Price="2000"

 Currency_spcCode="USD"

 Text="List price from &apos;Test Price List&apos; price list"

 Adjustment_spcType="Price Override"

></Waterfall

></Net_spcPrice_spcWaterfall

></Line_spcItem

><Line_spcItem

 Extended_spcQuantity_spcRequested="1"

 Temp_spcList_spcPrice="1000"

 Discount_spcPercent=""

 Rollup_spcAmount="0"

 Upsell=""

 Covered_spcLine_spcItem_spcId=""

 Temp_spcMRC_spcRollup_spcItem_spcPrice="1000"

 Quantity="1"

 Price_spcList_spcId="2-478KT"

 MRC_spcCxTotal="1000"

 Temp_spcNRC_spcCxTotal="0"

 Skip_spcPricing_spcFlag="N"

 Effective_spcPromotion_spcId=""

 Product_spcId="2-478J6"

 Prod_spcProm_spcId=""

 Temp_spcNRC_spcLine_spcTotal="0"

 Covered_spcAsset_spcProduct_spcId=""

 Temp_spcMRC_spcLine_spcTotal="1000"
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 Max_spcPrice=""

 Root_spcPrice_spcList_spcItem_spcId="2-478KX"

 MSRP_spcPrice=""

 Temp_spcNRC_spcNet_spcPrice="0"

 Bundle_spcSequence_spcId=""

 Net_spcPrice="1000"

 List_spcPrice="1000"

 Root_spcBundle_spcFlag="N"

 Price_spcType="Recurring"

 Product_spcLine_spcId="No Match Row Id"

 Unit_spcof_spcMeasure="Per Month"

 Temp_spcMRC_spcNet_spcPrice="1000"

 Id="2-478OD"

 Purchase_spcPrice=""

 Parent_spcItem_spcId=""

 Rollup_spcItem_spcPrice="0"

 Exchange_spcDate="02/09/2005"

 Covered_spcProduct_spcNet_spcPrice=""

 Currency_spcCode="USD"

 Root_spcExchange_spcDate="02/09/2005"

 Cost_spcPrice=""

 Covered_spcProduct_spcId=""

 Product_spcPort_spcId=""

 Root_spcPromotion_spcId=""

 Unit_spcPrice=""

 Discount_spcAmount=""

 Dynamic_spcMatrix=""

 Root_spcPrice_spcList_spcId="2-478KT"

 Root_spcCurrency_spcCode="USD"

 Exclude_spcPricing_spcFlag="N"
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 List_spcPrice_spcWaterfall_spcText="List price from &apos;Test Price List&apos; price 
list"

 Price_spcList_spcItem_spcId="2-478KX"

 Min_spcPrice=""

 Temp_spcMRC_spcCxTotal="1000"

 Service_spcPrice_spcMethod=""

 Next_spcDiscount_spcId=""

 Promotion_spcItem_spcFlag="N"

 Header_spcDiscount_spcAmount="0"

 Action_spcCode="Add"

 NRC_spcCxTotal="0"

 Class_spcId=""

 List_spcPrice_spcWaterfall="1000"

 Current_spcDiscount_spcId=""

 Sales_spcService_spcFlag="N"

 Rollup_spcAmount_spcMRC="0"

 Temp_spcParent_spcQuantity="1"

 Volume_spcDiscount_spcId=""

 Root_spcProduct_spcId="2-478J6"

 Pricing_spcAdjustment_spcAmount="0"

 Usage_spcAsset_spcProduct_spcId=""

 Start_spcPrice="1000"

 Service_spcPrice_spcPercent=""

>2-478OD<Attributes

>Default Pricing Variable Map - XA</Attributes

><Net_spcPrice_spcWaterfall

><Waterfall

 Adjustment_spcAmount="1000"

 Price="1000"

 Currency_spcCode="USD"
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 Text="List price from &apos;Test Price List&apos; price list"

 Adjustment_spcType="Price Override"

></Waterfall

></Net_spcPrice_spcWaterfall

></Line_spcItem

></Row_spcSet

></PropertySet

Siebel Pricing Manager API Reference
Earlier versions of the Pricing Manager API reference included a user property reference and a 
business service reference. These user properties are obsolete because of the new order 
management infrastructure. If your integration needed these user properties, you must rework the 
integration using pricing procedures, signals, variable maps and other features of the new order 
management infrastructure. For more information, see Siebel Order Management Infrastructure 
Guide. 

The methods are retained for backward compatibility, even though the API is no longer the best 
practice for external integration. For preferred integration methods, see “Integration Methods for 
Siebel Pricer” on page 180. 

This section describes the following:

■ Pricing Manager methods internal to the application (Table 29 on page 226)

■ Pricing Manager methods that are published in Siebel Tools (Table 30 on page 226)
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■ Parameters for CalculatePriceExternal Method (Table 31 on page 227)

Table 29. Pricing Manager Methods Internal to the Application

Method Name
External or 
Internal Purpose

Input 
Arguments

Output 
Arguments

CalculatePrice Internal Used for calling Siebel 
Pricer from other business 
components.

None. None.

CalculatePriceAll Internal CalculatePrice for all quote 
Item discounts and 
calculate aggregate price 
for the whole quote.

None. None.

Table 30. Pricing Manager Methods Published in Siebel Tools 

Method Name
External or 
Internal Purpose Input Arguments

Output 
Arguments

CalculateFinalDisco
untExternal

External Calculates 
aggregate pricing for 
external application 
user. A multiple item 
record must be 
passed as the 
argument. Assumes 
the CalculatePrice 
function was called 
for each individual 
line.

Price list ID, current 
total (current total 
item price), Pricer 
VBC BO Name 
(current business 
component for 
pricing operations), 
list total (total list 
price of all items).

Pricing 
Comments, Final 
Discount Price, 
Pricing 
Comments and 
Discount 
Amount on the 
children 
Property set.

CalculatePrice Internal Used for calling 
Siebel Pricer from 
other business 
components.

CalculatePrice-

External

External Single Item repricing 
for external users.

See Table 31 on 
page 227.

GetFinalDiscount Obsolete - 
will be 
removed

Obsolete.
Pricing Administration Guide Version 7.8, Rev. B226 



Siebel Pricer Deployment and Integration ■ Siebel Pricing Manager API Reference
GetProductListPrice External or

Internal

Retrieve List Prices 
and other 
information from 
Price List Item for a 
product and price list 
combination.

Price List Id, 
Product Id.

Currency Code, 
Min Sale Price, 
Max Sale Price, 
Price Book Id, 
Current Price, 
List Price, List 
Price Field x 
(Auxiliary 
outputs start 
with List Price 
Field, then 
followed by List 
Price Field 1, and 
so on.)

Reload Cache External or

Internal

Obsolete None. None.

SetPriceList External or

Internal

To set the price list 
at the profile 
attribute level. This 
is currently used in 
Sales to override the 
Price list ID set by 
the session.

No input because 
this set is based on 
the global profile 
attributes in eSales.

No output 
arguments as 
described for 
input 
arguments.

Start Internal Hidden - not for use 
by external users. 
Obsolete

None. None.

Table 31. Parameters for CalculatePriceExternal Method

Name Optional Type Explanation

Currency Code N Output The currency code for the price

Current Discount N Output The current volume discount.

Current Discount ID N Output The current volume discount ID.

Current Price N Output The final price.

List Price N Output The start price.

Next Discount N Output The next available item for volume 
discount.

Next Discount ID N Output

Table 30. Pricing Manager Methods Published in Siebel Tools 

Method Name
External or 
Internal Purpose Input Arguments

Output 
Arguments
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Workflows for External Pricing API
Earlier releases expose APIs on the Pricing Manager Business Service for external integration. To 
support backward compatibility, Siebel Systems continues to provide support for these APIs in 
version 7.8.

Because of changes to the pricing engine for version 7.8, the internals of these APIs are replaced by 
the Row Set Transformation Toolkit Business Service, which is driven by workflows. External API 
support uses the following workflows:

■ CalculatePriceExternal (for Business Service method CalculatePriceExternal)

■ Get Config Item Price (for Business Service method GetConfigItemPrice)

■ Get Product List Price (for Business Service method GetProductListPrice)

CalculatePriceExternal Workflow
The CalculatePriceExternal Business Service method (Figure 27) is an external interface that takes 
in product line items in a property set and provides pricing information for each of the product line 
items.

Original List Price Y Input

Price List ID N Input

Pricing Comments N Output

Product ID N Input

Quantity N Input

Service Price % N Output Indicates the percentage used to 
determine the price of the Service 
Product, where the Service Price is set to 
a percentage of the product price.

Upsell Message N Output The volume discount upsell message.

Volume Discount ID N Output The volume discount ID (a copy of the ID 
in Quote).

Figure 27. CalculatePriceExternal Workflow Process

Table 31. Parameters for CalculatePriceExternal Method

Name Optional Type Explanation
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Workflow Description. This workflow does the following:

1 Determines if the product is a service product. Service products have different pricing 
requirements from regular sales products. For more information, see “Dynamic Pricing Procedure 
Workflow” on page 165. 

2 Calls the Dynamic Pricing Procedure workflow as a subprocess that handles all pricing operations.

3 Populates Volume Discount upsell messages.

Table 32 lists the steps in the CalculatePriceExternal workflow with the business service and method 
that is called by each. 

Get Config Item Price Workflow
The GetConfigItemPrice Business Service Method (Figure 28) is an API that fetches price adjustments 
from Customizable Product Pricing Designer for a price list, product, or product port combination.

Workflow Description. This workflow does the following:

1 Gets the List Price for the input product and price list, which provides the basis for subsequent 
Pricing Designer adjustments.

2 These steps retrieve the Customizable Product Pricing Designer adjustment.

Table 32. Steps of the CalculatePriceExternal Workflow

Name Type
Business 
Service Method

Sub 
Process Description

Get Sales 
Service Flag

Business 
Service

Row Set 
Transformation 
Toolkit Service

Simple 
Look-Up 
Transform

Determines if the product 
is a service product.

Dynamic 
Pricing 
Procedure

Sub 
Process

Dynamic 
Pricing 
Procedure

Calls the Dynamic Pricing 
Procedure workflow as a 
subprocess that handles 
all the pricing operations.

Get Next 
Discount

Business 
Service

Row Set 
Transformation 
Toolkit Service

Simple 
Look-Up 
Transform

Populates Volume 
Discount upsell messages.

Figure 28. GetConfigItemPrice Workflow Process
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Table 33 lists the steps in the GetConfigItemPrice workflow with the business service and method 
that is called by each.

Get Product List Price Workflow
The GetProductListPrice Business Service method (Figure 29) is an API that gets the price and some 
other attributes from the Price List Item Business Component for a price list and product 
combination.

This workflow gets the list price for the input product and price list. Also, it retrieves other 
information such as Min Price, Max Price, Volume Discount Id, Dynamic Matrix Id, and so on.

Table 34 lists the steps in the GetProductListPrice workflow with the business service and method 
that is called. 

Table 33. Steps of the GetConfigItemPrice Workflow

Name Type
Business 
Service Method

Sub 
Process Description

Get List Price Business 
Service

Row Set 
Transformation 
Toolkit Service

Simple Look-
Up Transform

Gets the List Price for the 
input product and price 
list.

Get Root Price 
List Item Id

Business 
Service

Row Set 
Transformation 
Toolkit Service

Simple Look-
Up Transform

Retrieves the Root Price 
List Item Id for each item 
for use in the next step. 

Customizable 
Product 
Adjustment

Business 
Service

Row Set 
Transformation 
Toolkit Service

Simple Look-
Up Transform

Queries in Price Config 
Item Buscomp for Pricing 
Designer adjustments.

Figure 29. GetProductListPrice Workflow Process

Table 34. Steps of the GetProductListPrice Workflow

Name Type
Business 
Service Method

Sub 
Process Description

Get List 
Price

Business 
Service

Row Set 
Transformation 
Toolkit Service

Simple Look-
Up Transform

Gets List Price for the input 
product and price list.
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22
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